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About This Manual

About This Manual
Thank you for purchasing a Teledyne LeCroy WavePulser 40iX. We're certain you'll be pleased with the
detailed features unique to our instruments.

This manual takes a combined approach to documenting the WavePulser hardware and software, with
sections covering:

l System set up, including WavePulser application set up

l S-parameter measurement

l Standard tools for Result trace analysis

l Signal Integrity Studio applications: Signal Generator, Eye Doctor II and SDA III

l WavePulser Reference

Detailed specifications are listed on the product datasheet. Our website maintains the most current
product specifications and should be checked for updates.

Note: Specifications are subject to change without notice.
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Technical Support

Live Support
Registered users can contact their local Teledyne LeCroy service center at the number listed on our
website.

You can also submit Technical Support requests via the website at:

teledynelecroy.com/support/techhelp

Resources
Teledyne LeCroy publishes a free Technical Library on its website. Manuals, tutorials, application notes,
white papers, and videos are available to help you get the most out of your Teledyne LeCroy products.
Visit:

teledynelecroy.com/support/techlib

The Datasheet published on the product page contains the detailed product specifications.

Service Centers
For a complete list of offices by country, including our sales & distribution partners, visit:

teledynelecroy.com/support/contact

Teledyne LeCroy
700 Chestnut Ridge Road
Chestnut Ridge, NY, 10977, USA
teledynelecroy.com

Sales and Service:
Ph: 800-553-2769 / 845-425-2000
FAX: 845-578-5985
contact.corp@teledynelecroy.com

Support:
Ph: 800-553-2769
customersupport@teledynelecroy.com
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Introducing WavePulser

Introducing WavePulser
WavePulser 40iX is the ideal single measurement tool for high-speed hardware designers and test
engineers. The combination of S-parameters (frequency domain) and Impedance Profiles (time domain)
in a single acquisition, with a deep toolbox for simulation, emulation, de-embedding and time-gating,
provides unmatched characterization insight.

Designed for High Speed Interconnect Analysis
WavePulser is designed specifically for high-speed interconnect analysis. It validates, debugs and
troubleshoots interconnectivity issues in serial data cables, channels, connectors, vias, backplanes,
printed-circuit boards, chip and SoC packages. It is simple to set up and use.

Internal, Automatic Calibration
WavePulser calibration standards are built-in (included in the standard unit) and calibration is always
automated, simple and fast—make one connection to the DUT and press Go. WavePulser does not require
the purchase of additional, external calibration standards. Furthermore, WavePulser's TDR/TDTbased
approach is independent of setup, making calibration less likely.

Full-range DC to 40 GHz
WavePulser provides results from DC extending to 40 GHz of bandwidth, so you can avoid extrapolating
to low-frequency and DC response when viewing TDR step response and time-gated and/or emulated
physical layer signal responses—ideal for interconnect systems.

Integration with SI Studio
Signal Integrity Studio (SI Studio) adds three, fully integrated applications to the WavePulser: a Signal
Generator, Eye Doctor II channel emulator/equalizer, and SDA eye and jitter analysis toolkit. S-parameters
and result traces acquired with the WavePulser (or with other devices) can be input to SI Studio for
complete analysis of the signal integrity of a channel.
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WavePulser Approach
WavePulser uses time domain reflectometry to characterize a DUT’s electrical behavior by stimulating the
DUT with impulses and measuring reflection and transmission. Once a measurement is configured, all
phases proceed without any user intervention whatsoever. This is accomplished using an internal switch
matrix assembly that routes pulses to internally connected standards and to the front panel ports. After
acquiring calibrated measurements of the DUT, post-processing calculations are performed such as de-
embedding, time-gating, etc. The post-processing calculations can even be reconfigured and new results
calculated without the need for new measurement acquisitions.

SOLT Calibration Phase
In the calibration phase, a baseline measurement
is taken, then pulses are routed to internal short,
open, load, and thru standards while
measurements are made of these standards. The
measurements are processed along with
measurements made at the factory to provide an
internal self-calibration at the instrument ports.

TDR/TDT Measurement Phase
In the DUT measurement phase, pulses are routed
out to the DUT through the front panel bulkhead
connector and cables. Multiple acquisitions are
taken with the DUT pulsed at each port.

S-parameter Calculation Phase
On the host PC, the WavePulser application uses
algorithms to apply the calibration to the DUT
measurements and to de-embed the instrument
cables to provide calibrated DUT measurements
at the DUT ports. In this phase, any further
processing is performed such as fixture and
adapter de-embedding, time-gating, and

physicality enforcements.
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Hardware Overview

Front of Unit

A. Power On/Standby Power Button

B. Port 1 - Port 4 Connectors

C. Ground Terminal

Back of Unit

D. USBTMC Port

E. AC Power Inlet

3
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Cables
The WavePulser ships with high-phase stability cables that are calibrated and serialized to the
WavePulser unit, along with the S-parameter files for de-embedding each cable.

The cables utilize 2.92 mm K connectors. The connector head on the end of the cable to be connected to
the WavePulser has a colored band matching the color of the port to which it is calibrated. Always be sure
to connect the cable to the matching port so that the proper S-parameter file is used to de-embed the
cable.

We recommend leaving the cables attached once connected to the WavePulser; there is no need to
remove them when not in use.

SI Kit
The SI Kit is delivered with the WavePulser 40iX or may be purchased as an additional accessory. This kit
enables the Signal Integrity Studio (SI Studio) tools within the WavePulser application. The SI Kit also
includes:

l USB license key for activating SI Studio when disconnected from WavePulser (standalone mode)

l Multi wrench

l 4 female-female cable adapters

l SOLT Cal Kit for performing Manual or User Second-tier Calibration

l Torque wrench

4
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Safety
Observe generally accepted safety procedures in addition to the precautions listed here. The overall safety
of any system incorporating this product is the responsibility of the assembler of the system.

Symbols
These symbols appear on the instrument or in documentation to alert you to important safety concerns:

Caution of potential for damage to instrument or Warning of potential for bodily injury or death. Refer
to manual. Do not proceed until the information is fully understood and conditions are met.

Caution due to high voltage; risk of electric shock or burn.

Caution, parts/assemblies are susceptible to damage by Electrostatic Discharge (ESD).

Frame or Chassis Terminal (ground connection).

Alternating Current.

Standby Power (front of instrument).

Operating Environment
Temperature: 5 °C to 40 °C.

Humidity: Maximum relative humidity 80% up to 30 °C,
decreasing linearly to 50% relative humidity at 40 °C.

Altitude: Up to 10,000 ft (3,048 m) at or below 30 °C.

Use indoors only.

Use only within the operational environment listed. Do not use in wet or explosive environments.
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Power and Ground
AC Power Source: 100-240 VAC (± 10%) power source at 50/60 Hz (± 5%)

The instrument automatically adapts to the line voltage; manual voltage
selection is not required.

Maximum Consumption: 40 W (40 VA)

Standby Consumption: 2 W

Use only the Power button to power down. Do not power down by switching off the battery/power strip or
pulling the AC line cord from the outlet while the instrument is turned on.

Caution: In Standby Power mode, the instrument is still connected to the AC supply. The only way
to fully power down the instrument is to physically disconnect the power cord from the AC outlet.

Use only the power cord shipped with the instrument and certified for the country of use.

The WavePulser is provided with a 10A/250V 18AWG rated grounded cord set containing a molded three-
terminal polarized plug and a specific IEC-60320 (Type C13) connector for making line voltage and safety
ground connections.

Maintain ground. The AC inlet ground terminal is connected directly to the frame of the instrument. For
adequate protection against electrical shock hazard, insert the power cord into a mating AC outlet
containing a safety ground contact.

Caution: Interrupting the protective conductor inside or outside the instrument, or disconnecting
the safety ground terminal, creates a hazardous situation. Intentional interruption is prohibited.

6
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ESD Precautions

Caution: The WavePulser is sensitive to damage by Electrostatic Discharge. Always wear the
supplied grounding wrist strap and take standard ESD precautions when using the WavePulser.

Connect the strap to the ground terminal on the front of the WavePulser.

Caution: Cables are capacitors. Always park the relays and discharge the center conductor of the
WavePulser cables to ground before connecting them to the WavePulser unit or the DUT. Failure
to do so may result in electrical damage to the pulser/samplers that is not warrantable. Do not
connect or disconnect cables during measurements or TDR/TDT acquisitions when the relays are
engaged.
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General Precautions
Connect and disconnect cables properly. Turn only the nut on the cable connector to tighten/loosen
cables, do not rotate the pins.

Do not remove the covers or inside parts. Refer all maintenance to qualified service personnel.

Use only as intended by manufacturer.

Do not operate with suspected failures. Check the unit and cables regularly. If any part is damaged, or you
suspect the protections haved been impaired, cease operation immediately and secure the instrument
from inadvertent use.

Cleaning
Keep product surfaces clean and dry.

Clean the outside of the WavePulser using a soft cloth moistened with water or isopropyl alcohol solution.
Do not use harsh or abrasive cleansers. Dry thoroughly before using. Do not submerge the instrument or
allow moisture to penetrate it.

Caution: To avoid electric shock, unplug the WavePulser before cleaning it. Do not attempt to
clean internal parts.

Regularly remove the cables and clean the connector heads with an alcohol solution to remove any dirt
from handling. Dry them thoroughly before reconnecting. Keep exposed cable connectors and the
WavePulser ports covered with the supplied end caps when not in use. Any dirt that accumulates in the
connector heads will impair measurements.

Caution: Do not clean cable connectors while attached to the WavePulser.

Cooling
The instrument relies on forced air cooling with an internal fan and ventilation openings. An internal fan
control circuit regulates the fan speed based on the ambient temperature. This is performed
automatically after start-up with no manual intervention required.

Caution: Do not block the cooling vents or restrict the airflow around the side and rear of the
instrument. Leave a minimum four-inch gap (10 cm) between the instrument and the nearest
object. Do not allow foreign matter to enter through the vents.

Calibration
The recommended factory calibration interval is one year. See instructions for returning the instrument to
Teledyne LeCroy Service.
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System Set Up
This manual makes reference to your complete WavePulser system, which is comprised of the following
components:

l The WavePulser unit

l The host PC with the WavePulser application correctly installed

l The USB cable connecting the WavePulser unit to the PC

Host System Requirements
The WavePulser application host PC must meet the following requirements:

l x64 Windows® 10 Pro operating system

l 2.4 GHz or higher processor

l 4 GB or more RAM

l 2 GB or more free HDD space for the installed application

l Minimum 1280x780 pixel display, 1920x1080 recommended

l Minimum USB 2.0 high-speed port , USB 3.0 recommended

9
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Installing WavePulser Software
To install the WavePulser application software on the host PC:

1. Visit teledynelecroy.com/support/softwaredownload and click the link to WavePulser Downloads >
WavePulser Software.

Tip: You may alternatively download and install MAUI Studio software for PCs, choosing
WavePulser from the installer options.

2. Enter the required model information and account login to download the installer for your operating
system. If you don’t yet have an account, create one now.

3. On the host PC, unzip the installer and double-click mauiinstaller64_x.x.x.x.exe to launch the setup
wizard.

4. Follow the wizard prompts. At minimum, you will need to select the WavePulser component.

You can optionally also update MAUI Studio and MAUI Automation Browsers at this time, but this
is not required for WavePulser operation.

Note: MAUI Studio requires a separate license key.

5. When installation is complete, reboot.

Caution: The installation may take several minutes and appear to stop at points. Do not power
down the host at any point during the installation process. Do not connect the WavePulser to the
host prior to software installation.
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Initializing the System
1. Connect the WavePulser to a grounded AC power outlet.

2. Close the WavePulser application (do not power down).

3. With the host PC on, connect the WavePulser to the host using the provided USB cable.

4. Press the WavePulser Power On button.

5. Wait approximately 10 seconds for Windows to detect the new hardware and load the necessary
device drivers.

6. On the host PC, double-click the Start WavePulser desktop icon or use the Windows Start menu to
launch the WavePulser application.

If you see "No Hardware Detected," the drivers may not have finished loading. Repeat initialization.

Leave the USB cord connected during use, and exit the application before shutting down the unit. If you do
disconnect or power down the WavePulser with the application still open, close the application and repeat
initialization. The application will not automatically reconnect if the connection is lost.

Caution: Turn off Sleep or Hibernate power settings while using the WavePulser. Interrupting the
connection from the WavePulser to the host PC during operation may cause system failure.
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SelfTest
After initializing, run the SelfTest to ensure there are no missing calibration files or other errors.

1. Press the Setup button on the WavePulser menu bar.

2. Open the Instrument Setup dialog and click Run SelfTest.

3. If you are alerted to any errors, click SelfTest Log and review the findings. If necessary, contact
Teledyne LeCroy Customer Support to resolve errors.

WavePulser Folder Structure
The WavePulser installer creates the following folders:

Path Contents

C:\LeCroy\WavePulser\Adapters S-parameter files used to de-embed adaptors.

C:\LeCroy\WavePulser\Applications Files generated by SI Studio Eye Doctor and SDA.

C:\LeCroy\WavePulser\Cables S-parameter files used to de-embed cables. Files for the supplied
cables are copied during initialization.

C:\LeCroy\WavePulser\CableCompensation Files used by SI Studio application.

C:\LeCroy\WavePulser\CustomDSO Scripts defining custommath or measurements. The installed files are
examples.

C:\LeCroy\WavePulser\Documentation WavePulser User Manual

C:\LeCroy\WavePulser\Fixtures S-parameter files used to de-embed fixtures.

C:\LeCroy\WavePulser\Gating 2-port Gating Elements that are saved when applying Gating to move
the reference plane inside the DUT via the impedance peeling
algorithm or via port extension.

C:\LeCroy\WavePulser\HardCopy Screen image files saved using Print.

C:\LeCroy\WavePulser\Masks Mask files for use with SI Studio applications.

C:\LeCroy\WavePulser\Measurements .ZIP files containing setups, calibration data, TDR/TDT waveforms, S-
parameters and screen image.

C:\LeCroy\WavePulser\Results S-parameter files saved by the WavePulser.

C:\LeCroy\WavePulser\Scripts VB Scripts used by the application.

C:\LeCroy\WavePulser\SecondTierCalibration Factory second tier calibration files.

C:\LeCroy\WavePulser\Setups Configuration .LSS files, both most recent state (Current*) which is
reloaded at startup, and those saved using Save Setup.

C:\LeCroy\WavePulser\Tables .TXT or .CSV files of saved table data.

C:\LeCroy\WavePulser\UserCalibration Manual and second tier calibration files created by users.

C:\LeCroy\WavePulser\Waveforms .TRC files of saved waveform data.

C:\LeCroy\WavePulser\XPort Not currently used.
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Operational Notes

WavePulser-PC Connection
The WavePulser application expects the WavePulser hardware unit to be powered up and the required
device drivers to be present on your PC prior to use. Observe the following to maintain the connection to
the WavePulser:

l Wait at least 10 seconds after connecting to launch the application. Device drivers typically load
promptly after the WavePulser is turned on, or when a running WavePulser is connected to your PC.
However, load times vary. Should the application show a "No HW detected" or "Not authorized for
this system" message, it's likely that the drivers did not finish loading before launching the
application.

l Leave the USB cable connected while operating the WavePulser application. The application does
not re-connect to the WavePulser if the cable is disconnected and reconnected.

l Leave the WavePulser unit powered up while running the WavePulser application on your PC. If the
WavePulser unit is rebooted while the PC application is running, it is recommended to exit the
application, power down the WavePulser, and repeat the initialization sequence.

l Turn off Windows Hibernate and Sleep power settings.The WavePulser application loses
communication with the WavePulser unit when the PC sleeps or hibernates. If your PC hibernates or
sleeps when using the WavePulser, restart your system by exiting the application, powering down
the WavePulser, and repeating the initialization sequence.

Controlling Multiple WavePulser Units
Only one WavePulser can be connected to and controlled by one PC at one time, although different
WavePulser-PC combinations can be made sequentially. When connecting to a different WavePulser, the
calibration data from the new unit is copied to the PC. The calibration data file names include the
WavePulser serial number in order to avoid any issue of overwriting files or using incorrect data from a
different unit. Likewise, the cable S2P files are serialized to the cables delivered with each unit.
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Connecting Cables

Proper Handling of Cables

Caution: Always use the supplied anti-static strap when handling cables to avoid electric shock or
ESD damage to the instrument.

l Discharge cables before connecting them to the WavePulser or the DUT.

l Use the proper adapter when connecting cables to DUTs, or when connecting other than the
supplied cables to the WavePulser.

l Do not excessively bend or apply force to the sides of the cables.

l Do not step on, kink or deform cables in any way, as they are integral to good measurement results.

l Keep cable connector heads clean. Cover the connectors with the provided end caps when not in
use, as any accumulated dirt will impair measurements.

Relay Parking
The WavePulser switch matrix relays are “parked” by default, meaning the internal pulser/sampers are
disconnected from the output, and the output presents a 50 ohm load that can deal with any ESD event.
The relays re-engage when you initiate an acquisition.

Before connecting/disconnecting cables, always go to WavePulser Setup > Instrument Setup and click
Park Relays to ensure the relays are parked. This will protect the pulser/samplers from ESD damage.
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Connecting to WavePulser
1. Attach the color-coded connector head to the matching color port on the WavePulser. Press the

cable straight into the port, then turn the silver nut on the connector until it is finger tight.

2. Use a torque wrench to secure the connection. Apply 12 in•lb of torque.

Caution: Do not rotate the connector itself to secure the connection. Doing so can damage
the pin in the head.

Use best practices when connecting and disconnecting cables. Even slight changes in cable arrangement
can produce different results. We recommend that you leave the cables attached once connected to the unit;
there is no need to remove them when not in use. Cover the DUT-end of the cables with the provided end
caps.

Cable De-embedding 
During installation, S2P files for de-embedding the cables are transferred from the WavePulser SD card to
the host application. To confirm that the correct files have been copied to the correct fields:

1. Be sure De-embed Cables is checked on the Instrument Setup dialog.

2. Confirm that the .S2P file in Port1 - Port4 matches the serial number of the cable connected to that
port, which appears on the DUT-end of the cable. If not, Browse to and select the correct file.
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Note: Cable de-embedding is disabled when a manual calibration or a user second tier
calibration is applied.

Connecting to DUT
Attach the free ends of the cables to the DUT, using adapters if required. Take care to not rotate the
connector head, only turn the nut to tighten.

To simplify the software configuration and standardize the resulting S-parameter files:

l Connect single-ended cables to the same number port on the WavePulser as on the DUT.

l Follow the convention of attaching differential output to 1 and 2, and common mode to 3 and 4.

If you must change the port ordering due to physical limitations, or have done so accidentally when
connecting cables, the port assignments can be corrected in the software.

Using Other Cables
Additional steps must be taken to use cables other than those supplied with the WavePulser. You must:

l Provide the .S2P files to de-embed the cables. Copy the files to C:\LeCroy\WavePulser\Cables and
select the file corresponding to the cable connected to each port on the Instrument Setup dialog.

l Perform the User second tier calibration procedure using the new set of cables connected exactly as
they will be used for testing. The use of the correct second tier calibration files will remove any skew
or drift in the signal paths when acquiring. On the WavePulser Setup Calibration dialog, check User
second tier Calibration and select the correct .L12T file to apply.

Caution: Never connect male SMA cables directly to the 2.92 mm K inputs on the front of the
WavePulser. Use the appropriate adapter.
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WavePulser Application Set Up

A. Menu Bar
The top of the window contains a drop-down menu bar for accessing setup dialogs and executing
actions.

If an action can be "undone" (such as zooming a trace), a small Undo button appears to the far right
of the menu bar. Also to the right of the menu bar are a series of Action buttons used to control the
measurement sequencer:

Setup is a shortcut to the WavePulser setup dialogs.

Go initiates the sequencer at the next required phase of the measurement process (e.g., calibration if no
valid calibration data; DUT waveform acquisition if no valid waveforms, etc.)

Continuous initiates the sequencer in Continuous mode, starting next measurement immediately after the
last is complete.

Abort stops the sequencer and returns the WavePulser to an idle state.

Recalculate recalculates S-parameters following reconfiguration of certain measurement settings,
without first recalibrating or re-acquiring TDR/TDT waveforms, unless that phase is required.
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B. Display Grids
The display area can be divided into multiple grids, each 10 horizontal by 8 vertical divisions. The number
and appearance of grids can be modified. See Display Settings for instructions.

The graticule scale is shown by grid axis labels. These will match the color of the last trace on that grid to
be activated. Various grid indicators also match the color of the traces on the grid and can be dragged to
new positions on the x- and y-axis to reposition the trace (which also changes the trace Center settings).

Trace Zero Level (name label)

Trace Zero Time/Frequency (triangle, initially at start of x-axis, beginning of acquisition)

More Points (arrow, appears when part of the acquisition is off grid)

C. Traces
Traces are the visible representations of waveforms. Different Result traces (and other traces) may be
displayed on the grid following an S-parameter measurement. While it is not required to display Result
traces to measure and save S-parameters, viewing and analyzing them can yield useful information.

The trace line, the grid axis labels (when the trace is active), its grid indicators, its descriptor box and its
rescale dialog are all color-coded, so you can easily tell which trace you are working with.

Traces can be adjusted in various ways, see the topics in Display Settings and Result Trace Analysis.

Waveform data itself can be saved in different formats. See Save Measurement, Save Waveform and
Print.

D. Descriptor Boxes
Each trace has a descriptor box. These colored boxes between the grids and the dialogs show (clockwise
from top left) the trace Name, Description (for Results, the S-parameter and Result type), Vertical Scale,
Horizontal Scale, and Cursor Value (if cursors have been applied).

Clicking on a descriptor box activates the corresponding trace and opens the trace setup and rescale
dialog. When a trace is activated, its descriptor box is highlighted in blue.

To turn on a new trace, click the Add New (+) box , or drag a similar trace descriptor onto it. See OneTouch
for other actions you can perform just by dragging and dropping descriptors.

E. Dialogs
Dialogs appear at the bottom of the screen for configuring the application and saving results. All dialogs
can be accessed via the menu bar.

Once opened, dialogs appear in sets of related dialogs (e.g., WavePulser Setup). Click the name tabs to
move between dialogs. If More... appears, click it to see hidden dialogs in that set.

Many dialogs will have subdialogs to the right with a set of controls for rescaling traces. Some have
additional settings that are required for the primary action (e.g., Measure and Eye Diagram settings).
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Display Settings
The appearance of the display and the waveform traces can be customized. To access the Display dialog,
choose Display > Display Setup.

Grid Mode
The Grid Mode setting determines the number and layout of display grids, each of which represents the
full number of vertical levels. The selection icon shows the number and arrangement of grids.

Grid
Mode Number Orientation Notes

Auto
(default)

variable landscape Automatically adds or deletes grids as traces turned on/off, up to the maximum
supported

Single 1 landscape All traces share one grid

Dual 2 landscape One top, one bottom

Tandem 2 portrait One left, one right

Triplex 3 landscape Stacked top to bottom

Triple 3 variable Two landscape grids left, one portrait grid right

Triad 3 portrait Left, center, right

Quad 4 landscape Stacked top to bottom

Quattro 4 landscape One in each quarter of screen

Hex 6 landscape Two columns of three stacked top to bottom

Octal 8 landscape Two columns of four stacked top to bottom

Note: Additional grid modes may become available with the installation of software options.
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Grid Intensity
To dim or brighten the background grid lines, click Grid Intensity and enter a value from 0 to 100.

Grid on top superimposes the grid over the waveform.

Note: Some waveforms may be hidden from view with the grid on top.

Axis labels display the values represented by the extrema of the grid. Deselect the checkbox to remove
them from the display.

Trace Intensity
Choose a line style for traces: solid Line or disconnected sample Points.

When more data is available than can actually be displayed, Trace Intensity helps to visualize significant
events by applying an algorithm that dims less frequently occurring samples. click Intensity and enter a
value from 0 to 100.

Intensity 40% (left) dims samples that occur ≤ 40% of the time to highlight the more frequent samples,
vs. intensity 100% (right) which shows all samples the same.
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Utilities and Preferences Settings
This group of settings allows you to configure the customizable features of the WavePulser application.

On the main Utilities dialog, Hardcopy Setup, Date/Time Setup and System Status buttons open their
corresponding dialogs.

Show Windows Desktop minimizes the WavePulser application window. Maximize the application by
clicking the display icon located at the lower-right of the desktop.

The Service button to the far right of the dialog launches a section of the application reserved for qualified
Teledyne LeCroy service personnel. An access code is required to enter this section.

System Status Dialog
The Status dialog displays information about your instrument including model number, serial number,
firmware version, and installed hardware and software options.

Choose Utilities > Utilities Setup from the menu bar, then click the Status tab.
Or
Choose Support > About from the menu bar.
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Remote Dialog
The Remote dialog contains settings to configure remote control access to the WavePulser application. It
also displays the current IP address of the WavePulser host computer.

Only the default setting TCPIP (VICP) is currently supported. This enables either "remote" access by other
applications running on the WavePulser host PC, or over a LAN via an Ethernet connection to the host.
You can limit remote access to only specific nodes on your network.

A remote connection is generally only useful for executing Automation scripts to configure the
WavePulser. The software itself can automatically save S-parameters following each measurement, you
do not need to retrieve them. See WavePulser Automation.

Note: You cannot bypass the WavePulser software to control the instrument directly.

Remote Control Assistant Event Log
The Remote Control Assistant monitors communication between the controller and WavePulser. The log
can be output to an ASCII file and is valuable for creating and debugging remote control programs.

Under Remote Control Assistant, click Log Mode and choose Off, Errors Only, or Full Dialog.

To always clear the log at startup, check Reset to Errors Only and clear at startup.

To export the contents of the Event Log:

1. click the Show Remote Control Log button. The Event Logs pop-up is shown.

2. Enter a log file name in DestFilename, or click Browse and navigate to an existing file.

Note: New contents will overwrite the existing content; it is not appended.

3. click Export to Text File.
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Hardcopy (Print) Dialog
Hardcopy dialog settings control how the Print function behaves. Print captures an image of the display,
but there are several options as to what it does next with the image:

l Send it to a "printer" (including PDF generators)

l Copy it to the clipboard for pasting into other applications

l "Print" to an image file that can be saved to an internal or external drive

l Send the image file via e-mail

You can further set up a default print color scheme and capture area. To print immediately, click the
Printer icon at the far right of the dialog, or choose File > Print from the menu bar.

Send to Printer
Follow these steps to configure output to a printer. The page icon on the dialog shows the print out that
would result.

1. On the Hardcopy dialog, choose Printer.

2. Select the destination Printer. If the printer is not in the list, click Add Printer and use the Windows
dialogs to configure the printer.

3. Choose a page Orientation: portrait or landscape.

4. Optionally, choose a new color scheme and hardcopy (print) area.

Print to File

1. On the Hardcopy dialog, choose File.

2. Choose the output File Format.

3. Enter a default File Name. This will form the basis of all image file names, until you change it.

Note: Numbers you add to the end of the filename will be truncated, as the application
appends numbers to this name with each new file. To add your own identifying numbers,
place them at the front of the name.

4. Optionally, enter the path to a new Directory in which to save the file (the default folder is
[application path]\Hardcopy).

5. Optionally, choose a new color scheme and hardcopy (print) area.
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Send to E-Mail
Follow this procedure to e-mail capture files to a preset address.

1. On the Hardcopy dialog, choose E-Mail.

2. Choose the output File Format.

3. If you wish to be able to include messages with the files as they are sent, check Prompt for
message to send with mail.

4. Optionally, choose a new color scheme and hardcopy (print) area.

5. To go on and set up the e-mail connection, click Configure E-Mail Server and recipient. This will
take you to the E-Mail dialog.

Choose Print Color Scheme
To change the color of your print output, click Color on the Hardcopy dialog and choose a palette.

l Standardprints objects on a black background, as they appear on the display.

l Print uses your Print color palette on a white background. This option saves ink.

l Black & White prints in greyscale.

Set Print Area
In Hardcopy Area, select the portion of the display you want captured in the image:

l Grid Area Only captures only the waveform grid contents and indicators.

l Window captures the entire WavePulser application window.

l Full Screen captures the entire display, including areas surrounding the application window if it is
minimized.
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Date/Time
Date/Time settings control the instrument's timestamp. These numbers appear in the message bar and
on tables/records internal to the oscilloscope application, such as History Mode and WaveScan.

To access the Date/Time dialog, choose Utilities > Utilities Setup from the menu bar, then touch the
Date/Time tab.

Note: You must be logged on as an Administrative User, or supply the administrative password, to
change the Date/Time settings in Windows 10.

Manual Method
Enter the Hour, Minute, Second, Day, Month, and Year, then touch the Validate Changes button.

Internet Method
This method uses the Simple Network Time Protocol (SNTP) to read the time from time-a.nist.gov. The
instrument must be connected to an internet access device through a LAN (Ethernet) port.

If your connection is active, touch the Set from Internet button.

Windows Method

To set date and time using the internal Windows system clock, touch the Windows Date/Time
button. This displays the standard Windows Date and Time Properties pop-up dialog, where you can
further configure these settings. If you are satisfied with the setup, just touch OK.

25



WavePulser 40iX High-speed Interconnect Analyzer User Manual

Options Dialog
Many optional software packages are available to extend the Analysis functions of the instrument. When
you purchase an option, you will receive a key code by email that activates the new functionality. Use the
Options dialog to activate software options by installing the key code. This dialog also displays the
ScopeID and Serial #.

To install a key:

1. From the menu bar, choose Utillities > Utilities Setup, then open the Options tab.

2. Touch Add Key. The Virtual Keyboard appears onscreen.

3. Use the Virtual Keyboard to type the Key Code in the Enter Option Key field, then touch OK to enter
the information.

Tip: The Key Code is added to the list of Installed Option Keys. Use the Up/Down buttons to
scroll the list. The software option that each key activates is displayed below the list.

4. Choose Yes to restart the oscilloscope application.

Preferences Dialog
Go to Utilities > Preference Setup to open the main Preferences dialog.

Audible Feedback controls the application's audio output.Select this box to hear a beep each time you
activate a screen control. Also enable it if you wish to use the Beep Result Action.

The Hardcopy dialog has a selection for printing the Grid Area Only, which may not contain sufficient
information for identifying the source of the image. Check Print LeCroy logo When Printing Grid Area Only
to include a logo on all printouts.
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E-Mail Dialog
Several WavePulser functions allow you to directly e-mail saved files to a pre-named recipient. Go to
Utilities > Preference Setup > E-mail to configure e-mail handling.

1. Select to use MAPI or SMTP.

2. If you chose SMTP, click SMTP Server and enter the network address of your mail server.

3. click Originator Address (From:) and enter the instrument's e-mail address.

4. click Default Recipient Address (To:) and enter the recipient's e-mail address.

5. Optionally, select to Attach Setup & Waveforms associated with attached images.

6. Use Send Test Mail to send a confirmation message to ensure proper e-mail configuration.

Color Dialog
Color dialog settings assign the colors used to display different traces. All dialogs, tables, and trace
descriptor boxes will match the color of the trace assigned here. You can choose different colors to be
used on the instrument and in print outs.

Note: Print colors are used only when the Colors control is set to Print.

Go to Utilities > Preference Setup > Color to open the dialog.

To change any setting, just click the color swatch for either Screen (first column) or Print (second column)
next to the trace number, and make a new selection from the Color pop-up menu.

For convenience, you can Preview print colors to see how the settings will appear in print output.

Click Factory default colors to recall the original color settings for your instrument.
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Zoom Join Preferences Dialog
This dialog contains checkboxes used to set rules about how S-parameter traces (Sn and Rn) are joined
so that they rescale ("zoom") together. See Rescaling Traces.

Note: These settings do not affect the Multi-Zoom feature, which joins only Zn traces.
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Measuring S-parameters
The general process for using the WavePulser to measure S-parameters is:

1. Configure WavePulser
Configuration is handled from the main Setup dialog, which can be accessed either by clicking the Setup
button at the top right of the application window or by choosing WavePulser Setup > Main Setup from the
menu bar.

Make at least the basic configuration. Expand the Setup dialog to make optional advanced configurations
for physicality, port ordering, de-embedding, calibration, or reference plane gating.

Choose any actions to take when the sequence is complete, or preconfigure the result display.

2. Initiate Sequencer
After making at least the basic configuration, initiate the measurement process by clicking the Go button
at the top right of the application window or on the Setup dialog. This causes the WavePulser to execute a
chain of events handled by the sequencer.

If calibration is required, a calibration sub-sequence is included in the chain. During the calibration sub-
sequence, following a baseline measurement, the pulser/sampler module is switched to S, O, L, and T
calibration standards, and the TDR waveforms are acquired. You will hear the WavePulser relays clicking
as this occurs.

During the measurement phase, the TDR pulser/samplers are routed to each combination of DUT ports,
and waveforms are acquired to which the calibration is applied.

The last phase in the sequence is the calculation of the S-parameter results. The Menu Bar flashes
"Calculating" during this step. When the calculation is complete, any Result traces pre-selected for display
are shown, and the WavePulser returns to an idle state.

A rough estimated time for sequence completion is shown in the Sequence Control section of the Setup
dialog. You can stop a sequence in progress by clicking the Abort button at the top right of the application
window. The sequence is stopped at the end of the step currently being processed.

3. View and Save Results
View raw TDR/TDT waveforms, or modify the Result Display of calculated frequency and time domain
Result traces.

Save S-parameters, calibration data, or the entire set of files generated by the measurement.

Import S-parameter files, optionally converting them into different formats and viewing the results.

4. Reconfigure and Recalculate Results
Unless you change Acquisition Length, Num Ports or Accuracy settings, you do not need to make an
entirely new acquisition. You can change modifiable settings, then click Recalculate on the menu bar to
recalculate the S-parameters. The result display will update as soon as calculation is complete.

If you wish to use new calibration files or new DUT waveforms when recalculating S-parameters, expand
the Setup dialog and choose to Clear Cal(ibration files) or Clear DUT (waveforms) prior to clicking
Recalculate.
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Configuring Measurements
Click the Setup button on the menu bar to open the Setup dialog. The initial, collapsed view of the dialog
represents the minimum settings required to initiate an S-parameter measurement.

General Setup
It is important to set a sufficiently long acquisition so that
there is time enough for the response to die to zero before
the next pulse is sent. If any energy is left in the signal
path, or the impulse response is cut off, the resulting S-
parameters will be incorrect.

In End Freq, enter what is to be the last frequency point in
the output S-parameter file.

Enter the Num(ber of) Points for S-parameter files and
result traces.

Note: Num Points+1 is the total number of sample points in the result traces and number of data
points in the output S-parameter files. The first point is DC and the last the End Freq.

To allow for arbitrary selections of End Freq and Num Points:

l Click the + button to expand the dialog and show the advanced configuration options.

l Select Enable Fine Mode and enter the value.

Note: Fine Mode may result in significantly longer execution time when making the first
measurement.

As you modify the End Freq and Num Points, you'll notice the values for Delta Freq and Time Length
change. The goal is for the impulse response of the DUT to fit into the calculated Time Length. This is
especially important if you will be using the results for simulation. The general rule is:

Time Length = 1/Delta Freq x 2

The Acquisition Length is equivalent to the Pulser Rep Period, or 1/Pulser Rep Rate. The impulse response
of a system must be less than that number, or time aliasing will occur. A good rule of thumb is to select a
number at least 5X the electrical length of the channel, although 2X is acceptable if the channel is lossy.
Use the smallest number you can.
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Configure Ports
If you have connected single-ended inputs to the same numbered port on the WavePulser as on the DUT
(1 to 1, 2 to 2, etc.), and none of the ports have been skipped, you need only enter the Num Ports in use.

The Single-ended Reference Impedance is assumed to be 50 ohm. To change this number, click + to
expand the dialog and enter the new value.

To calculate mixed-mode S-parameters or change any of the port assignments, expand the dialog and
check Enable. You'll see the Num Ports field is shaded, indicating this setting is now being overridden by
the custom port mapping. Click Configure and go on to configure ports.
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Sequence Control (Accuracy)
The Accuracy determines the time of pulsing/sampling in seconds, and hence the total number of
waveforms averaged, during the Cal, DUT, and Result calculation phases of the measurement sequence.
The system performs 5000 pulses per second of acquisition. The higher the accuracy selected, the longer
the measurement takes. The estimated completion time is shown on the dialog.

Use Preview to obtain results quickly, but with less accuracy. This is useful when setting up a new
measurement in order to confirm reasonable results before going on to take a Normal measurement.
Calibration waveforms are collected for 1 s and DUT waveforms for 1 s.

Use Normal to obtain results in a reasonable amount of time with higher accuracy than Preview mode.
Calibration waveforms are collected for 10 s and DUT waveforms for 10 s.

Use Extra to obtain the highest accuracy apart from Custom mode, but with a longer acquisition time than
Preview or Normal modes. Calibration waveforms are collected for 100 s and DUT waveforms for 100 s.

For Custom accuracy, click + to display the acquisition time settings and enter the number of seconds for
the Cal(ibration) and DUT (TDR/TDT acquisition) phases.

Enter the number of results to average for the final Result. The higher the number in Result, the more
accurate the measurement.
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In order to minimize measurement time, calibration files are reused until policy dictates, which by default
is every 20 minutes. DUT waveforms are reused until a new acquisition is initiated (or they are manually
cleared). If you want a fresh set of files prior to measuring, click Clear Cal or Clear DUT. This will force the
sequencer to repeat that acquisition phase.

Clear Sweeps will clear all file sets, forcing a completely new acquisition.

Initiating the Sequencer
If you do not require any Advanced features such as custom port configuration, enforcing physicality, de-
embedding or reference plane gating, press the Go button at the right of the Setup dialog or on the menu
bar to initiate the measurement sequence.

You could also initiate in Continuous mode, starting a new measurement as soon as the previous one is
completed. If you do so, first set up a Result Action to automatically save S-Parameters, so you have the
results of the measurement before the next one is calculated.

Enforcing Physicality
To enforce any of the following in S-parameter calculations,
click + to expand the Setup dialog, then check the selection
boxes below the General Setup section:

Enforce Passivity requires that the S-parameter matrix be
passive. Select this when planning to use the output S-
parameter file in a model that requires passivity to be
obeyed.

Enforce Reciprocity requires that the S-parameter matrix
follow the rule Sij = Sjj. Select this when planning to use the
output S-parameter file in a model that requires reciprocity
to be obeyed.

Enforce Causality requires that impulse responses cannot
occur prior to the applied impulse. 

Limit Impulse Response enforces a maximum time within
which the impulse response must occur. This has the effect
of smoothing the Result traces by reducing the amount of
noise in the S-parameter calculation.

If you select this option, also enter an impulse response time
limit in the field next to the checkbox. Setting a limit for

impulse response time may be best done following acquisition, when you can examine the Result traces
for unnecessary effects that would reduce noise if removed. Use the same rule as for determining
acquisition Time Length to choose a good impulse response time limit.
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Configuring Ports
While the basic port setting is typically sufficient for single-ended S-parameters, manual port
configuration is used when you wish to:

l Measure mixed-mode S-parameters (i.e., differential inputs)

l Modify the WavePulser-port-to-DUT-port mapping

l Modify the port order of the output Touchstone file

Single-ended Arbitrary Port Configuration
Use this method to configure single-ended inputs where you wish to use non-adjacent ports, either to
correct physical cabling or because ports were skipped in the setup. The example below maps
WavePulser Port 4 to DUT Port 2.

1. On the Setup dialog, click the + button to expand the Configure Ports section, then check Enable
and click Configure to open the configuration window.

2. Click the Config DUT button and specify how many ports are on either side of the DUT.

3. Using the blue blocks, select the WavePulser Port to which this DUT/User port is connected.

4. In the green User/DUT Port blocks, select the DUT/User Port number. These selections correspond
to the subscripts of the S-parameters when displayed in WavePulser.

5. In the yellow Touchstone File Port blocks, enter the line of the file on which the S-parameters for
this port will appear. This determines where it appears in the S-parameter matrix shown on the
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window, and the ordering of the S-parameters in the output SNP file. Choose "X" to exclude the port
from the output Touchstone file and remove it from the selection on the Result Display dialog.

The matrix in the bottom left of the window shows the results. If port numbers are duplicated in the
configuration, the matrix will display "???????" where there are conflicts.

6. When you are satisfied with the mapping on the display and the results in the matrix, click the Apply
button on the Port Config window.

Mixed-Mode Port Configuration
Use this method to configure mixed-mode S-parameters in which ports are paired to correspond to the +
and - sides of a differential pair. In the example below, while differential pairs are connected to physical
ports (1,2) and (3,4), the lines are organized differently in the output file matrix.

1. On the Setup dialog, click the + button to expand the Configure Ports section, then check Enable
and click Configure to open the Port Config window.

2. Click the Config DUT button and specify how many ports are on either side of the DUT. There must
be at least two on the same side for a differential pair.
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Note: The actual physical location of ports on the DUT does not matter, the purpose is only
to be able to group two of them into a differential pair. The example shows a 4-port DUT,
with two ports on each side.

3. Click the Config button, and choose differential. This will "merge" the green User/DUT port blocks
into a single differential pair.

4. Using the blue blocks, select the WavePulser Port to which each side of the differential pair is
connected. Both sides of the same pair must be on the same side of the DUT.

5. In the green User/DUT Port blocks, select the number used to refer to this differential pair. It will
appear in the software and the S-parameter file as D1, D2, etc.

6. In the yellow Touchstone File Port blocks, enter the line of the file on which the S-parameters for
this port will appear. To exclude either side of the differential pair from the output, select X.

The matrix in the bottom left of the window shows the results. If port numbers are duplicated in the
configuration, the matrix will display "???????" where there are conflicts.

7. When you are satisfied with the mapping on the display and the results in the matrix, click the Apply
button on the Port Config window.

Cabling Guidelines
Given the large degree of flexibility in mapping WavePulser inputs to S-parameter outputs, it is possible to
order the S-parameter matrix in a non-standard, confusing manner. We recommend the following:

l For single-ended measurements, connect DUT Port 1 to WavePulser Port 1 and so forth.

l For differential signals, follow the practice of Ports 1 and 2 being differential, and Ports 3 and 4 being
common mode.
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De-embedding
The WavePulser calculates DUT S-parameters using an algorithm that includes S-parameter descriptions
of system components, both internal and external. Use the de-embedding features of the WavePulser
whenever possible to ensure the most accurate results.

Tip: Always confirm the correct S-parameter files are loaded when de-embedding is enabled.

Order of De-embedding
The default measurement reference plane is at the WavePulser ports. De-embedding establishes a new
measurement reference plane. Several de-embedding steps occur in the measurement sequence, each of
which moves the measurement reference plane to a different point on the signal path.

Cable de-embedding is on by default. Because factory second tier calibration puts the reference plane at
the instrument ports, this de-embedding moves the reference plane to the end of the cables. When
manual or user second tier calibration is applied, the reference plane is already at the point that the
standards have been applied, so cable de-embedding is disabled. See Connecting Cables and Calibration.

Adapter de-embedding places the measurement reference plane at the DUT-side of the adapter.

Fixture de-embedding places the measurement reference plane at the output of the fixture.

Time-domain gating places the measurement reference plane at the specified electrical length (time) and
is applied to the logical ports that result from your Port Configuration settings, rather than the WavePulser
physical ports. Thus, time-domain gating can be performed using mixed-mode S-parameters. It is applied
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following any other cable, adapter or fixture de-embedding you have configured. See Reference Plane
Gating for more information.

Adapter De-embedding
The Adapter de-embedding control on the Setup dialog is used to enable de-embedding of any adapters in
use. Adapter de-embedding is always performed single-ended.

In the S-parameter files describing the adapters, adapter port 1 is the WavePulser side, and adapter port 2
is the DUT-side. The Port1 - Port4 shown on the Setup dialog refer to the WavePulser physical port to
which the adapter is connected.

Note: The optional WavePulser SI-Kit includes 2.92 female-to-female adapters for connecting to
devices with male connectors. A generic S-parameter file for these adapters is installed in
C:\LeCroy\WavePulser\Adapters. The same file may be used for each WavePulser port. If you are
using other adapters, you must provide the S-parameter files for de-embedding them. Place them
in \Adapters for ease of selection.

1. On the Setup dialog, click + to expand Adapter de-embedding.

2. Check the box for each Port where the cable utilizes an adapter.

3. Browse to and select the .S2P file for the adapter used on that port.

If adapters are not in use, clear the Port1-Port4 checkboxes prior to measurement.

Fixture De-embedding
The Fixture de-embedding control is used to de-embed fixtures using a customer-supplied S-parameter
file. Fixture de-embedding is performed following any adapter de-embedding, or else following cable de-
embedding or Manual/User second tier calibration. Like adapter de-embedding, it is always performed
single-ended.

Fixture de-embedding may be performed several ways:

l Using one S-parameter file that contains all the port assignments for one or more fixtures

l Using two, 4-port files: one for a fixture connected to ports 1 and 2, the second for a fixture
connected to ports 3 and 4. This can only be done for 4-port configurations.

l Using two, 2- or 4- port files split from a 2X Thru structure measurement of two fixtures.

Place all S-parameter files in C:\LeCroy\WavePulser\Fixtures for ease of selection.

If fixtures are not in use, clear the Fixture de-embedding checkboxes prior to measurement.
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Single File De-embedding
The S-parameter file describing the fixture(s) must always have twice the number of DUT ports as are
being measured, since half will connect to the WavePulser and the other half to the DUT. The topology of
the S-parameter files must be as follows.

If Measuring... Provide an S-parameter file of the fixture with this port order...

1 Port

2 Ports

3 Ports

4 Ports

As only one S-parameter file can be selected using this method, if you are connecting to the DUT through
multiple fixtures, the S-parameters for each fixture must still be in a single file. Follow the ordering above
to determine how to connect the fixtures to the WavePulser and the DUT, as the physical cabling should
match the S-parameter port ordering.

1. On the Setup dialog, click + to expand Fixture de-embedding.

2. Check DeEmbed.

3. Browse to and select the S-parameter file.
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Two File De-embedding
If de-embedding two fixtures in a 4-port configuration, a simpler method is to use two .s4p files. The
topology of the files should be as follows:

To configure de-embedding:

1. On the Setup dialog, click + to expand Fixture de-embedding.

2. Check DeEmbed Two Fixtures.

3. Browse to and select the S-parameter file for each fixture.

2X Thru De-embedding
There are times when the Device Under Test (DUT) requires fixtures on both sides, such as a USB cable
with mating connectors on each end or a device embedded in a PCB trace. In such cases, both fixtures
must be de-embedded from the signal path using a 2X Thru structure.

A 2X Thru structure consists of a left and right fixture connected to each other without any DUT in
between—for example, the reference trace on a PCB. The WavePulser measures this 2X Thru structure
and splits the S-parameters to obtain individual S-parameters for each half of the structure, enabling you
to simultaneously de-embed two fixtures that are part of a continuous signal path.
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Certain assumptions are inherent in 2X Thru de-embedding:

l The characteristics of the 2X Thru structure are the same as the regular signal path minus the DUT.

l Each fixture is reciprocal, with the same loss characteristics and length (i.e., S21 is the same as S12,
and that is equally true for both fixtures).

l If the fixtures involve differential traces, there is no mode conversion.

Before measuring the 2X Thru structure, connect each fixture to each other and to the WavePulser.

Using New Measurement

1. Open the 2X Thru dialog and for Source, select Measured S-parameters. Confirm the port
configuration matches the fixtures you are de-embedding.

2. If you have already measured the 2X Thru structure and there is a valid measurement in memory,
skip to Step 4.

If not, click the Change Setup button and set up the WavePulser for either a 2-port or 4-port
measurement. You do not need to make a Fixture De-embedding setup at this time.

Note: A "valid" measurement is one that matches the port settings and S-parameter format
currently configured on the 2X Thru dialog. The 2X Thru dialog will tell you if the
measurement is invalid.

3. Connect the WavePulser to each end of the 2X Thru structure to be measured and acquire ("Go") so
that there is a valid measurement in memory.

4. If splitting a single-ended, 4-port measurement, the Port N fields on the 2X Thru dialog will become
active. Map the measured S-parameter ports to the port numbers on the dialog such that Port 1
and Port 3 have a through response and Port 2 and Port 4 have a through response. After splitting,
the port ordering of the S-parameter files will be as shown on the diagram.
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5. If desired, under Results, click the Browse buttons and enter new names for the S-parameter files.

Note: By default, the software will split the measurement into SL and SR, which are either
.s2p or .s4p files, depending on your setup. These default files are overwritten each time
you choose to Split Fixture, unless you first change the names.

6. Click Split Fixture and wait while the software re-calculates.

7. Click Apply to De-embedding Settings.

The Fixture De-embedding section of the Setup dialog will now be set to Two Fixtures using the
two S-parameter files you just created.

8. Reconnect the WavePulser to the circuit including the DUT and measure.

Using Imported S-parameter File
If you have a saved S-parameter file of your 2X Thru structure, you can use the WavePulser software to
split that and apply it to your de-embedding configuration.

1. Go to the SParam Import dialog and click the folder button to select the file. Click Open to import it.

2. Open the 2X Thru dialog and for Source, select Imported S-parameters.

3. Select the S-parameter file Format, Single-Ended or Mixed-Mode.

4. If splitting a single-ended, 4-port file, the Port N fields on the 2X Thru dialog will become active.
Map the imported S-parameter ports to the port numbers on the dialog such that Port 1 and Port 3
have a through response and Port 2 and Port 4 have a through response. After splitting, the port
ordering of the S-parameter files will be as shown on the diagram.

5. If desired, under Results, click the Browse buttons and enter new names for the S-parameter files.
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Note: By default, the software will split the measurement into SL and SR, which are either
.s2p or .s4p files, depending on your setup. These default files are overwritten each time
you choose to Split Fixture, unless you first change the names.

6. Click Split Fixture and wait while the software re-calculates.

7. Click Apply to De-embedding Settings to use the new de-embedding files for your next acquisition
or re-calculation.
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Calibration
The first step in the measurement process is to "remove" any drift or skew that can impair the frequency
response of the system from the internal and external signal paths. The internal signal path is calibrated
through an auto or manual calibration, while the external signal path is calibrated through a second tier
calibration.

With a second tier calibration, error terms from a manual calibration performed using an SOLT Cal Kit are
applied “on top” of the automatic calibration. This is why it is called a second tier calibration, as it acts to
refine the primary calibration.

There are two principal types of second tier calibration that can be applied: factory and user. Both are
essentially manual calibrations that are converted to .L12T files at the end of the procedure, which readies
them to be applied whenever that particular second tier calibration is selected.

Automatic Calibration
The WavePulser is set to run using Calibration Type Auto, which performs the SOLT calibration step of the
measurement process without any user intervention via the internal switch matrix and calibration
standards. It is best to leave this setting as is, as it will guarantee the ongoing calibration of the system
with the least amount of effort from the user.

It is not necessary to rerun the auto calibration phase every acquisition. The default policy of Recalibrate
Periodically every 20 min. is sufficient for warranted performance, but you can change the frequency of
calibration or the policy used. To change the policy, either click + on the Setup dialog to show the
Calibration policy fields, or open the Calibration dialog. Choose to:

l Recalibrate Always to calibrate with every new acquisition or recalculation (only the DUT TDR/TDT
waveform files would be reused).

l Only Recalibrate When Necessary, meaning either the existing calibration waveforms have expired or
were manually cleared.

Auto calibration can be combined with either a factory or user second tier calibration. If the user second
tier calibration is selected, the factory second tier calibration is automatically disabled.
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Manual Calibration
If Calibration Type Manual is selected, the system will continue to calibrate using any saved calibration
files in the Path to Calibration Measurements folder. A new Manual Calibration dialog will appear for you
to perform the SOLT manual calibration.

SOLT Measurement for Manual Calibration
To perform a SOLT manual calibration, you will measure the Short, Open, Load and Thru structures on the
fixture in a manner similar to how the WavePulser measures when using the internal calibration
standards.

1. On the Calibration dialog, choose Calibration Type Manual.

2. On the Manual Calibration dialog, enter the Num(ber of) Ports you are measuring.

3. Enter the number of Averages for Cal.

4.
Note: Averages for Cal is the seconds of pulsing-sampling for the calibration phase, each
second representing 5000 averages, not the total number of calibration waveforms
averaged. 100 (seconds) is a recommended number.

5. In Acq Length, enter an acquisition length commensurate with the DUT electrical length, following
the same rule as when configuring a measurement.

6. Browse to and select the Path to Calibration Measurements folder.

Note: Create separate subfolders in C:\LeCroy\WavePulser\UserCalibration for each
physical setup. Multiple calibration files will be created during the procedure. Calibration
files stored in the folder will be overwritten each time the procedure is performed.

7. Choose to use either a Cal Kit File (.CSTD) or individual S-parameter files (.SNP) to model the SOLT
structures, then Browse to and select each file to be used.

Note: When using the Rosenberger Cal Kit included with the WavePulser SI Kit option,
choose Cal Kit File and C:\LeCroy\WavePulser\UserCalibration\Standards.cstd. If using
your own .CSTD file, confirm that it matches the calibration constants of your Cal Kit
device. When using S-parameters, see S-parameters for Second Tier Calibration in the
Reference section for file requirements.

8. For each WavePulser port, connect in turn to the Short, Open and Load structures of the Cal Kit,
then to each combination of Thru.

Tip: Connections can be made in whatever order desired, provided all ports make all
connections. We recommend connecting as many cables as possible to the Cal Kit
simultaneously to reduce measurement time. For example, you can simultaneously
connect a Short on port 1, Open on port 3, and Thru between ports 2 and 4 , as shown here.
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9. Click the Connect button for each combination of ports being measured that turn (e.g., Short on
Port 1). Be careful to select the correct connection for the ports.

10. When all ports have been connected, click Measure. Wait while the measurement is processed.
When finished, the completed measurements are checked on the Manual Calibration dialog.

11. Continue until all the required ports have been tested in all ways and are checked on the Manual
Calibration dialog. Once a particular measurement is done, it will be saved in the calibration
subfolder unless you Clear All Cal. This enables you to build the Manual Calibration dialog matrix
over multiple sessions, if necessary.
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User Second Tier Calibration
The WavePulser software includes capabilities for users to create second tier calibration files. This is
recommended when:

l You are using other than the supplied cables

l You method of connecting to the DUT involves fixtures or other external effects with calibration
structures built into them

l The accuracy of your measurements is in question

The user second tier calibration has several benefits for fixture de-embedding and for other applications,
such as probe de-embedding. The biggest benefit is that, when performing the manual calibration, the
WavePulser is operating in a calibrated mode: it has already calibrated out all the internal and active
components that require calibrating whenever the instrument is powered up using the auto internal
calibration capability. The second tier calibration determines error terms for what is external to the
WavePulser, which typically will be purely passive components. Thus, the second tier calibration results
for a cable test fixture only need measuring once, and can be re-used from day-to-day.

Note: The user calibration is applied instead of the factory calibration, not in addition to it. Any
cable de-embedding will be disabled when a user second tier calibration is in effect.

SOLT Measurement for Second Tier Calibration
Performing a second tier calibration is essentially the same as performing a manual calibration, only you
will create a different set of calibration files at the end.

Choose SecondTier Calibration Type on the Calibration dialog.

This opens a Second Tier Calibration dialog nearly identical to the Manual Calibration dialog for
performing the SOLT calibration.
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On the Second Tier Calibration dialog, follow the same steps as for Manual Calibration above to perform
the SOLT measurements, with the goal of filling all the boxes on the Second Tier Calibration dialog with a
check mark:

l Select the number of ports, averages, acquisition length, and calibration standard file or S-parameter
files.

Note: When the measurement crosses ports 2 and 3, enter as many ports as the highest
numbered WavePulser port you are connected to. For example, if connected to ports 2, 3 and
4, you must configure a 4-port measurement. If connected to only ports 1 and 2 or 3 and 4,
you can make a 2-port measurement.

l Attach the Cal Kit to the ports at the ends of the cables in whatever order desired and press Connect
next to each connection being tested.

l Finally, take measurements by pressing the Measure button.

Creating the User Second Tier Calibration File
After performing the SOLT measurement, create the .L12T file (LeCroy 12-term error model). The creation
process uses the SOLT measurements along with S-parameters that describe the SOLT calibration
structures to form an error model that is applied after the primary calibration.

1. When the Second Tier Calibration dialog matrix has been "filled," click the Perform Internal Cal
button, which is now enabled. This step also performs the baseline calibration by connecting the
internal load with no pulsers pulsing.

2. Click OK to proceed following the notification. The Baseline box is checked when complete.

3. Click Create Second Tier Calibration File.

4. If necessary, change the Num Ports, End Frequency, Num Points, Conversion Type (to SOLR) or
Output File name on the pop-up window that appears. The defaults have been set to accommodate
most S-parameter measurements.

Note: Be careful to enter a unique file name if you are creating a new .L12T file from
existing cal files.
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Confirming the Results
Open a Windows Explorer window and navigate to the subfolder containing your calibration. A successful
calibration generates numerous files, including:

l <filename>.L12T

l ConversionLog.txt: log file containing the actions performed by the conversion.

Open the ConversionLog.txt file and quickly confirm that it includes no errors.

l Errors are denoted by an exclamation point (“!”) at the beginning of a line, and indicate that the
conversion was not successful.

l Warnings are denoted by a “w” at the beginning of a line, and are typically informative

Applying the User Second Tier Calibration
Once you have completed the manual calibration procedure and generated the .L12T file, the User Second
Tier Calibration checkbox is selected on the Calibration dialog, pointing to the new file. If this checkbox is
deselected, the software will revert to using the factory second tier calibration files.

Calibration Type is also reset to Auto, so that the system always uses the most current calibration of the
WavePulser internal structures along with the second tier calibration specific to your external structures.

As you acquire new user second tier calibration files, be sure to select the .L12T file representing the
correct physical setup on the Calibration dialog prior to measuring S-parameters.

Portability of User Second Tier Calibration Files
Manual calibration files in a given calibration folder can be reused to calculate additional .L12T files with
different parameters (e.g., End Frequency, Conversion Type). With the correct folder selected, simply
select Calibration Type Manual to activate the Manual Calibration dialog and repeat the conversion
procedure, adjusting parameters as necessary.

The .L12T file can be used with a different WavePulser than the one used to perform the manual
calibration, provided the external structures and the de-embedding configuration are the same. Copy the
file to the Path to Calibration Measurements folder and be sure to select it on the Calibration dialog.
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Factory Second Tier Calibration
A manual calibration using the supplied cables connected to an SOLT Cal Kit is done at the factory prior to
shipment and whenever the instrument is returned for service. The calibration files are stored on the
WavePulser SD card and transferred to the WavePulser application folders when the instrument is
initialized. Factory second tier calibration is selected by default, and as long as you are using just the
supplied cables to connect to the DUT, it is best it remain selected.

You can now perform a factory second tier calibration on your own and convert the results to use in place
of the existing factory second tier calibration files. This is a way to keep the WavePulser and cables
calibrated when it is not feasible to return the unit for factory calibration.

1. Ensure the provided cables with the correct serial numbers are attached to the unit. The serial
numbers can be found on the Instrument Setup tab. The color on the cable connector should
match the color band at the instrument port.

2. Ensure the correct cable s-parameter files are loaded on the Instrument Setup dialog.

3. On the Calibration dialog, choose Calibration Type SecondTier. You will see the same Second Tier
Calibration dialog as when performing a user second tier calibration.

4. Set up the acquisition for Num Ports 4. This is required for factory calibrations.

5. Follow the SOLT measurement procedure as described above for Manual Calibration, with the goal
of filling in all the boxes on the Second Tier Calibration dialog with a check mark.

Tip: By using the Thru standard between two ports with two reflect standards on the other
ports, the calibration can be accomplished in exactly six measurements.

6. Click Perform Internal Cal.

7. When complete and the Baseline box is checked, click Create Second Tier Calibration File.

8. Finally, click Convert To Factory Cal.

At the conclusion of this procedure, the second tier calibration file is created and written to the memory
card internal to the instrument with the name X_FactorySecondTierCalibration.l12t, where X stands for the
instrument serial number.

When performing the factory second tier calibration procedure for the first time, the factory calibration
data provided by Teledyne LeCroy will be renamed with the suffix _Original. Otherwise, earlier factory
calibrations will be renamed with a suffix indicating its creation date. This allows older factory second tier
calibrations to be recovered in the event that problems are found with the new calibration.
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Reference Plane Gating
Reference Plane Gating enables you to de-embed structures such as connectors, launches, traces,
adapter cables, etc. from the calculated S-parameter measurements. Gating is applied to intermediate S-
parameter files before the final measurement calculation phase, rather than the WavePulser physical
ports, so it can be done following acquisition and the results recalculated.

Access the Gating dialog by choosing WavePulser Setup > Gating. On the Gating dialog, check the master
Enable box to apply the gating.

Understanding Ports in the Gating Configuration
A key point to understand is that Gating is implemented on a per-port basis to the logical ports, rather than
the WavePulser front-panel ports. The ports shown on the Gating dialog refer to the User/DUT port
configuration (green boxes) on the Port Config window.

l Single-ended ports are labeled Port 1, Port 2, etc.

l Mixed-mode ports are labeled D and C to denote differential and common mode inputs.

Port Extension
When the User Port Enable box is checked and the Peeling checkbox is left unchecked, WavePulser
applies Port Extension gating. Port Extension actually de-embeds the portion of the channel
corresponding to a structure, such as an adapter.

In this mode of operation, the 2-port S-parameters to be gated out are simply the S-parameters of a
transmission line with characteristic:

l Z impedance, in ohms.

l Delay time (electrical length) to use for the location of the new reference plane. This time delineates
the region to be de-embedded (< Delay) from the region to be retained (≥ Delay).

l Loss in dB/GHz/ns. The value should represent the linear loss characteristic of the region to be
gated.

2-port S-parameter matrices are determined for the electrical length entered into the Delay field. These 2-
port S-parameters are then de-embedded from the previously determined S-parameters by employing the
same algorithm used to de-embed cables, adapters and fixtures.
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When using Port Extension, it is useful to have pre-measured the time (electrical length) represented by
the structure to be de-embedded. An approach we recommend is:

1. Perform the S-parameter measurement with gating turned off.

2. On the Result Display dialog, view the impedance profiles (Result Type Z) for each port. Zoom in as
necessary to clearly see unwanted effects.

3. Using cursors on the impedance profiles, determine the time where you would like a new reference
plane to be established for each port, and the time to be "gated out."

Impedance Peeling
When the both the User Port Enable and Peeling checkboxes are selected, WavePulser applies Impedance
Peeling. Impedance Peeling is best used to de-embed very short structures, such as short connectors, up
to about 200 ps electrical length.

The 2-port S-parameters to be gated out are determined from the impedance profile for each enabled
port. The impedance profiles are calculated from intermediate S-parameters that are determined prior to
the gating step of the overall S-parameter measurement process. The Impedance Peeling algorithm then
determines which portions of the channel represent structures to be de-embedded, based on the
impedance shown and the Delay time entered, which marks the new measurement reference plane.

The Z setting does not apply to Peeling and will be disabled. Loss may optionally be entered in dB per ns
per GHz, but is perhaps best left zero.

Applying the Gating Configuration
If gating has been enabled when initiating a measurement sequence, the WavePulser will automatically
apply the gating configuration in the determination of the S-parameters returned to the user.

You can also change the gating configuration after making a measurement, then click Recalculate to
apply gating to the new S-parameter results. Make sure the master Enable is checked, and that you've
selected all the User Ports to be gated.

Using the De-embedded Structures
The S-parameters that are gated out are saved as .S2P files in C:\LeCroy\WavePulser\Gating.

These files can be renamed and re-used to de-embed structures via the adapter de-embedding feature in
the extended view of the main Setup dialog.
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Calculating Loss (Delta-L)
The Delta-L feature, as the name implies, applies the Intel® Delta-L loss characterization method to
calculate loss (in dB) per unit length of a PCB trace without calibrating at the end of probe tips.

As described in the algorithm, the calculation is performed by using measurements of traces of two
different lengths. The loss numbers are displayed for three chosen frequencies, and the loss curve as a
function of frequency can be viewed, as well.

When making a new measurement, the WavePulser takes a fully calibrated measurement of the DUT to
generated the S-parameters used in the Delta-L calculation.

Port Configuration
The Delta-L feature supports 2- or 4-port differential measurements. For 2-port measurements, you may
use any port configuration you like. For 4-port measurements:

l On the Setup dialog, check Enable under Configure Ports, then click Config.

l Set the port configuration to match the following:

continued...
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Calculating Delta-L

Note: It is recommended that there be a difference in electrical length of at least 4 inches between
DUT A and DUT B. The DUTs are measured sequentially, but can be done in any order.

1. If making a new measurement:

l Connect the DUT to the WavePulser.

l Make any port configuration necessary (see above).

l Enter the DUT electrical Length.

l Click Measure.

If using imported S-parameters:

l Enter the DUT electrical Length.

l Click the Import button beneath the DUT, then navigate to and select the S-parameter file.

2. Repeat Step 1 for the other DUT.

3. Click Frequency1 and enter the first frequency to calculate. Repeat for Frequency2 and
Frequency3.

4. If you wish to display the S-parameter plot of the delta, check View.

5. Click Calculate. When complete, the WavePulser will display loss in dB/inch next to each
Frequency.
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Result Actions
Various actions may be carried out automatically upon the completion of a measurement sequence. Open
the Result Actions dialog, select Enable Actions, then choose all the actions you would like.

Beep will cause the application to sound an alert, which can be useful if you are using a higher Accuracy
setting and wish to know when results are ready.

Save will save the S-parameters to a Touchstone file in the default Magnitude/Frequency format, using
the default SParam Filename.

l To change the file name, click in the field and enter the new name.

l To also change the output file path, click Browse and navigate to the desired location.

l To change the format, click Preferences and make selections on the on the SParam Export dialog.

The same file will be overwritten with each new set of results, unless you check Append Timestamp. In
that case, each new set of results (following either a new measurement or a recalculation) is saved to a
separate Touchstone file named [SParam Filename root][timestamp].SNP (where N is the number of
ports).

You can force just this action by clicking Save SParameters. You can also choose File > Save Touchstone
File from the menu bar.

Email will send the Touchstone file to the named Email Recipient. Optionally, enter a new Email Subject
line and Email Body.

All the selected actions can be performed on demand by clicking Force Actions One Time.
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SParam Export Preferences
The SParam Export setup dialog is used to configure output Touchstone file (.SNP) preferences:

Choose a Magnitude Format of Magnitude/Angle, dB/Angle or Real/Imaginary.

Choose a default Frequency Formatof Hz, kHz, MHzor GHz

Click Save (floppy disk icon) to manually save the last calculated set of S-parameters. The file name and
path is set on the Result Actions dialog.

Exporting/Importing Instrument Information
If you plan to share S-parameter files with other WavePulser instruments, be sure to also export/import
the calibration files used to create them.

From the menu bar, choose File > Export Instrument Information. This will create a .zip file with the same
name as the WavePulser serial number in the /Calibration folder.

This file should be placed in the /Calibration folder on the target WavePulser. Then, on the target
instrument, choose File > Import Instrument Information, and select the .zip file corresponding to the
source instrument. This need only be done once for each WavePulser unit from which an instrument will
receive files.
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Viewing Results
Using the S-parameters calculated during the measurement sequence, the WavePulser application
generates Result traces (Sn), which plot the selected properties of a single S-parameter as a function of
frequency or time. Result traces can be analyzed using standard tools such as Cursors, Measure and
Math, or used as inputs to SI Studio for jitter and eye analysis. Up-to-16 results can be selected from the
Result Display dialog for viewing.

Tip: Results can be pre-selected prior to initiating the measurement and will display as soon as
calculation is complete.

Viewing Frequency Domain Results
1. Open the Result Display dialog.

2. Select the checkbox next to each numbered Sn trace you wish to display.

3. Optionally, to change the trace color, click the color swatch and select a new color.

4. Click in the S-parameter field and select the S-parameter to plot.

5. Click in the Result type field and choose from:

l dB—S-parameter magnitude as decibel units (10log(Mag)

l Mag—S-parameter magnitude as fractional amplitude/attentuation

l Real—Real component of S-parameter

l Imag—Imaginary component of S-parameter

l Deg—S-parameter phase, in degrees

l Rad—S-parameter phase, in radians
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Viewing Time Domain Results
Follow the same steps as to view frequency results, choosing to display:

l Step—Step response of the selected S-parameter

l Impulse—Impulse response of the selected S-parameter

l Rho—Reflection coefficient; rho = (Zt-Z) /(Zt+Z)

l Z—Impedance profile of the selected S-parameter

Optionally, to modify time trace properties, click the Config button.

To smooth the trace, enter a new 10-90% Rise time value, following the rule:

Rise Time x Bandwidth = .45

You can also UpSample traces by applying factor 10 SinX / X interpolation.

To change the trace X-axis Configuration, select either:

l Time (electrical length), which can be RoundTripTime, similar to what a TDR would measure

l Distance (physical length), entered using the Propagation Velocity (Vprop/c) or the Dielectrical
Constant (Er).
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Frequency domain Result traces Magnitude in Decibels, Magnitude as Amplitude/Attentuation, Real Component,
Imaginary Component, Phase in Degrees, Phase in Radians

Time domain Result traces Impedance Profile, Step Response, Impulse Response, and Rho
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SParam Import Dialog
Use the SParam Import dialog to import Touchstone files saved by the WavePulser or by other
instruments such as VNAs and display them as Result traces.

Note: First, import instrument information from other WavePulsers with which you will share
Touchstone files.

In order for the importation to work, the .SNP file formatting must meet the requirements described in
Touchstone File Format.

Displaying S-Parameters
1. Click Clear to remove existing S-parameter mappings.

2. Go to WavePulser Setup > SParam Import, then click the Folder icon and select the Touchstone file
to import.

3. Follow the same procedure as for displaying internal Result traces. In this case, traces will be
labeled Rn instead of Sn on the display.
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Copying S-Parameter Setups
The S-parameter, plot type and scale associated with the measured result traces can be copied to the
corresponding imported traces (S1 to R1, S2 to R2, etc.) to make the display consistent. This helps when
comparing a saved set of S-parameters with a newly acquired set from the same DUT.

1. Import the saved S-parameter file.

2. Select all the R traces you wish to view.

3. Click the Copy Setup from S button.

Converting S-Parameters
Once imported, Touchstone files can be converted from single-ended to mixed-mode (or vice versa) or
given a new port ordering using the same port configuration tools as for internally generated S-
parameters. See Configuring Ports.

After applying the mapping to the S-parameters, click Convert on the SParam Import dialog to apply the
conversion to the Result traces.

Click Save (disk icon) to save the conversion to a new Touchstone file.

Rescaling Result Traces
The subdialogs to the right side of the Result Display and SParam Import dialogs contain controls for
adjusting the scale factors of the corresponding result traces (Sn or Rn).

Result traces are set to initially display at a default scale that optimizes their horizontal position on the
grid, showing as much of the acquisition as possible. For example, if the measurement was made to 40
GHz, the default horizontal axis will display out to 40 GHz. You can "zoom in" or "zoom out" on different
areas of the trace by specifying the frequency or time range you wish to view.

Note: Although we use the term "zoom" to describe this behavior, it is not the same as the Zoom
function that enables you to display new, Zn traces with a modified scale. The controls described
here will rescale the corresponding result traces (Sn or Rn) on the WavePulser display.

As you rescale one result trace, other traces that are in the same join group will also adjust in scale. The
default join groups have been set so that those S-parameters that would normally be compared (e.g., all
measured/imported Reflects, all measured/imported Reciprocals) will adjust in unison, maintaining the
points of comparison, but you can modify the groups as you wish to fully customize the display.
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Rescaling Traces

1. Enter the Horizontal Start and Stop position to display.

2. Enter the Vertical Start and Stop position to display.

Note: The units will reflect the type of input and trace. S-parameter plot range is set in
decibels and frequency, while a Step response may be set in voltage and time.

Tip: Dragging the trace right/left or up/down will also quickly change the display span.

3. To further "zoom in" or "zoom out:" on either axis, click the horizontal or vertical In and Out buttons.
The scale will adjust by a factor of 2 with each click.

4. To return to the default scale, click Reset Zoom.

Changing Join Groups
1. To access the join preferences dialog, either:

l Click View Join Preferences on the WavePulser Seutp dialog.

l From the menu bar, choose Utilities > Preferences and open the Zoom Join Preferences
dialog.

2. Enable All is selected by default, enacting all the join selections on the dialog. If you wish to scale all
result traces independently, deselect Enable All.

Tip: You can quickly re-enable the join rules simply by reselecting Enable All.

3. Select/deselect the items you wish to rescale together from within the Vertical, Time and
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Frequency groups. See the table below for a description of the settings.

Join Group Settings

Vertical Time Frequency

Join Within Joins the time axis within a
given S-parameter group (e.g.,
all S11, all S22).

Joins the frequency axis within a
given S-parameter group (e.g.,
all S11, all S22).

Join With Other Joins the vertical axis with other
S-parameters within a given
view (all magnitude response,
all phase response, all
impedance profiles, etc.).

Joins S-parameters with other
S-parameters horizontally in
time plots.

Use the following checkboxes to
select S-parameters to join.

Joins S-parameters with other
S-parameters horizontally in
frequency plots.

Use the following checkboxes to
select S-parameters to join.

Join All Joins all S-parameters
vertically.

This forces all other selections.
Deselect it to join specific S-
parameters.

Joins all S-parameters.

This forces all other selections.
Deselect it to join specific S-
parameters.

Joins all S-parameters.

This forces all other selections.
Deselect it to join specific S-
parameters.

Join Off-Diagonals Joins off-diagonals vertically. Joins off-diagonals and
reciprocals.

Joins off-diagonals and
reciprocals.

Join Reciprocals Joins reciprocals vertically. Joins reciprocals.

This is forced by Join All and
Join Off-Diagonals. To remove
it, first deselect the other, then
clear the checkbox.

Joins reciprocals.

This is forced by Join All and
Join Off-Diagonals. To remove
it, first deselect the other, then
clear the checkbox.

Join Reflects Joins reflects vertically. Joins reflects. Joins reflects.

63



WavePulser 40iX High-speed Interconnect Analyzer User Manual

Viewing the Smith Chart
Use the Smith Chart dialog to configure the WavePulser application to display an Admittance Smith Chart.
The chart can be generated from internal or imported S-parameters.

1. Choose the type of Smith Chart Display: Smith Chart Only or Smith Chart and Traces.

2. Check the boxes to turn on CX1 and CX2, then choose the S-parameter to plot in each.

If you wish to use imported S-parameters for either node of the chart, click the ... button to select
the Touchstone file from the SParam Import dialog, then turn on ICX1 or ICX2 and select the S-
parameter to plot there.

3. Optionally, change the frequency range plotted for each node by changing the Start Freq and/or
End Freq on the corresponding trace sub dialog at the right.

The default view plots the entire range of the S-parameter measurement.
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Viewing TDR/TDT Waveforms
Raw, uncalibrated TDR/TDT waveforms can be acquired and displayed for a crude impedance profile. You
can choose to view these waveforms either as a:

l TDT impulse response to the impulse coming from the pulser channel

l Step response, calculated as the integral of the impulse response and shown in webers (V•s)

Because they respond quickly to manipulation of the DUT, TDR/TDT traces are useful for checking signal
integrity at different points on the circuit, as the Thru from each Port will immediately show peaks from
excess capacitance or troughs from excess inductance.

Caution: The pulser/samplers are extremely sensitive to ESD damage. Park relays and do not
begin acquisition until cables are fully connected. Do not leave TDR/TDT acquisitions running
when connecting/disconnecting devices from the ports.

Tip: To see the fully calibrated response, configure a measurement on the Setup dialog and use
the Result Display to view Impulse Response and Step Response.
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Displaying TDR/TDT Waveforms
1. Access the TDR/TDT dialog by choosing WavePulser Setup > TDR/TDT from the menu bar.

2. Turn the Pulse On for each port to which you want to route the pulse.

3. Turn the Trace On for as many ports as you wish to view the response.

4. Check Enable Step View to see the response as a step. Otherwise, to see an impulse response,
leave this box unchecked.

5. Optionally, increase the averages or apply interpolation to smooth the traces. See "Smoothing
Controls" below.

6. Click Acquire to begin pulsing and acquisition. The waveforms should immediately appear on the
display.

7. Click Stop to stop pulsing.

Smoothing Controls
If Averaging is left disabled, 200 waveforms will be averaged in the displayed TDR/TDT traces. To
increase the number of waveforms acquired and averaged, check Enable under Averaging and in Number
of Averages, enter acquisition time in seconds.

Note: Each second represents 5000 averages, not the total number of waveforms averaged.

Click Clear to erase the TDT/TDT traces and restart the average.

To apply interpolation, check Enable under SinX/X.

Zoom Factor Controls
Each TDR/TDT trace has an independent set of zoom factor controls on the trace subdialog at the right.
Use these to rescale the trace on the display, the same as for Result traces.
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Saving and Recalling Data (File Menu)
Besides Touchstone files and measurements, the WavePulser File menu holds a series of options for
saving and recalling other application data such as setups (configurations), waveforms, tables, and
screen images.

Save/Recall Touchstone File
The File menu offers shortcuts to the WavePulser setup dialogs for saving and importing S-parameters.

Choose File > Save Touchstone to open the SParam Export dialog.

Choose File > Recall Touchstone to open the SParam Import dialog.

Save/Recall Measurement
All configurations, calibration files, TDR/TDT waveforms, calculated S-parameters, Result traces, plus a
screen capture of the display can be saved to a single .ZIP file by choosing File > Save Measurement from
the menu bar.

Choosing File > Recall Measurement will restore the measurement in the state it was saved. You can then
modify settings and recalculate S-parameters, or continue viewing and analyzing Result traces.

Measurement files are saved in C:\LeCroy\WavePulser\Measurements.

Note: In order to recall a measurement, your computer must have been connected at least once to
the WavePulser from which the measurement was made.

Save Waveforms
The Save Waveform function saves trace data to either an internal memory location or to a trace file. The
source waveform can be any type of trace; a Result, math function, zoom, or even another memory. Use
Recall Waveform to restore these previously saved waveforms to the display.

Note: Only files saved in binary format (.TRC) can be recalled.

By default, trace files are saved to C:\LeCroy\WavePulser\Waveforms, although you can choose another
location, such as a USB drive. The file name is autogenerated from [source trace name][sequence number]
(e.g., S1000001).

To open the Save Waveform dialog, choose File > Save Waveform from the menu bar.
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Save Waveform To Memory

1. On the Save Waveform dialog, click Memory.

2. Choose the Source trace to save.

3. Choose the Destination memory slot to use.

4. Optionally, check Show on Save to immediately display the memory.

5. Click Save Now!

Also see Storing Traces to Memory.

Save Waveform To File

1. On the Save Wavform dialog, click File.

2. Choose the Source trace to save.

3. Optionally, click Trace Title to change the root file name of your waveforms.

Caution: Numbers placed at the end of this name are truncated because the software
appends a sequence number to each file. Place numbers at the beginning, or place an
alpha character after the number (e.g., XYZ32a).

4. Click Data Format and select a file format:

l Binary, Teledyne LeCroy's binary file format (.trc). Binary results in the smallest possible file
size, and is necessary for recalling waveforms to Teledyne LeCroy instruments.

Note: Binary files can be converted to ASCII using Teledye LeCroy utilities such as
ScopeExplorer or WaveStudio.

l ASCII text file (.txt extension).

l MATLAB text file (.dat extension).
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l Excel text file (.csv extension).

l MathCad text file (.prn extension).

l Audio .wav file.

l WaveML, Teledyne LeCroy's proprietary .xml format used to save persistence maps, eye
diagrams, histograms, and digital traces. This option will only be activated if the source
waveform/plot is of a type to require it.

5. Depending on your file format selection, you may also need to specify a SubFormat:

l Word (Binary) represents samples in the output file with 16 bits. Always use this options
unless Byte mode is "pre."

l Byte (Binary) represents samples in the output file with 8 bits. This option can result in a loss
of output file resolution.

l Auto (Binary) looks at the data and automatically selects either Word or Byte subformat.

l Amplitude only (Text) includes amplitude data for each sample, but not time data.

l Time and Amplitude (Text) includes both types of data for each sample.

l With Header (Text) includes a file header with scaling information.

6. If you selected ASCII format, also select a Delimiter character from the pop-up menu.

7. In Save Files in Directory, click Browse and navigate to the desired location.

8. On the Save Waveform dialog, click Save Now!
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Recall Waveforms
Use Recall Waveform to restore previously saved trace files to the display.

Note: Only files saved in binary format (.TRC) can be recalled to the click screen.

Choose File > Recall Waveform from the menu bar.

Recall Waveform FromMemory

1. Click Memory.

2. Click Source and choose a memory location from the Select Source pop-up.

3. Click Destination and select an Mn into which to open the recalled memory.

4. Mark Show on Recall to display the trace on the grid.

5. Click Recall Now!

Recall Waveform From File

1. Click File.

2. In Recall files from directory, enter the path to the waveform folder, or Browse to the folder.

3. Use the Up /Down Arrows to cycle through the available files until the desired file is selected.

Optionally, select Show only files to apply a search filter to the list of available files. 

Note: The filter only applies to the files that will appear in the "Next File Will Be Recalled
From..." list. It does not impact the Browse function.

4. Mark Show on Recall to display the trace on the grid.

5. Click Recall Now!
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Save Setups
Save Setups allows you to quickly save up-to-six configuration panel settings to internal storage, while
Recall Setups restores them with a click.

If desired, you can also save panel settings as an .LSS file at a different location, such as a USB drive. You
can recall them from the same.

To open the Save Setup dialog, choose File > Save Setup... from the menu bar.

Save Setup to Memory

1. Click the corresponding Save button directly to the left of the Setup field.

The save date/time is displayed above the Paneln field.

2. Optionally, at the left side of the Save Setup dialog, enter a name for the memory in one of the
Paneln data entry controls.

Save Setup to File

1. At the right side of the Save Setup dialog, in Save Panel to File, click Browse.

2. Enter a new setup File name, or choose a existing file to overwrite.

3. On the Save Setups dialog, click Save Now!
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Recall Setups
Recall Setups restores setups saved to one of the internal memory locations, or enables you to import a
setup file.

To open the Recall Setup dialog, choose File > Recall Setup... from the menu bar.

Recall Setup fromMemory
Click one of the six Recall buttons under Recall From Internal Setup....

Note: If a setup has been stored to a location, it is labeled with the save date/time. Otherwise, the
slot is labeled Empty.

Recall Setup from File

1. In Recall panel from file, click Browse and navigate to the desired setup file.

2. On the Recall Setups dialog, click Recall Now!

Recall Default Setup
To restore the factory default settings:

1. Click the Recall Default button.

2. Choose to either recall the complete factory setup, or retain your de-embedding setup but take all
other default settings.

3. If you never want to see this choice again, check Remember this setting.

4. Continue.
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Save Table Data
The WavePulser trace Measure feature and the SI Studio applications present measurement results in
tables. The Save Table function saves tabular data displayed on the screen to an Excel or ASCII file. By
default, files are saved in C:\LeCroy\WavePulser\Tables.

1. With the table(s) you wish to save displayed on the screen, choose File > Save Setup from the
menu bar, then open the Save Table tab.

2. Leave the default Source selection All Displayed.

3. Optionally, enter a new root file name in Table Title.

Caution: Numbers you place at the end of this name are truncated because the instrument
appends a sequence number to each file. Place numbers at the beginning, or place an
alpha character after the number (e.g., XYZ32a).

4. Choose a Data Format of ASCII (.txt) or Excel (.csv) format.

5. If you selected ASCII format, also choose a Delimiter character.

6. Optionally, change the Save Files in Directory path.

7. Click Save Now!
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Disk Utilities
You can use the Disk Utilities dialog to manage files and folders on your hard drive. Disk Space
information is shown at the far right of the dialog for convenience.

Access the Disk Utilities dialog by selecting Utilities > Disk Utilities from the menu bar.

Delete a Single File

1. click the Delete button.

2. Browse to the current folder containing the file.

3. Browse to the file to be deleted, or use the Up and Down arrow buttons to scroll through the files in
the folder.

4. With the desired file selected, click Delete File.

Delete All Files in a Folder

1. click the Delete button.

2. Browse to the current folder containing the file.

3. With the desired folder selected, click Empty Folder.

Create a New Folder

1. click Create.

2. click Current folder and provide the full path to the new folder, including the folder name.

3. click Create Folder.

Copy Folder/File

1. click Copy.

2. Browse to and select the folder or File To Be Copied.

3. Browse to and select the Destination Folder for the copy.

4. click Copy Folder or Copy File.
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Print
Print captures an image of the display, but there are several options as to what it does next with the
image:

l Send it to a Printer
l Copy it to the Windows Clipboard
l Save it to an image File
l Email the image file using your current Email Preferences

The Hardcopy dialog settings control how the Print function behaves. Choose File > Print Setup to make
the selection.
Choose File > Print from the menu bar to execute the Print selection. The Printer button on the Hardcopy
dialog can also be used to execute your Print selection.
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Result Trace Analysis
Traces are the visible representations of waveforms that appear on the display grid. When working with
WavePulser, you will commonly display traces of these waveforms:

Waveform Name Main Dialog

Calculated S-parameters Sn Result Display

Imported S-parameters Rn SParam Import

Raw TDR and TDT waveforms TDRTDTn TDR/TDT

Zoom of another waveform Zn Zoom

Memory of any waveform Mn Memory

Math applied to other waveforms Fn Math

Every trace can be independently scaled both horizontally and vertically. It is also an application object
that can be manipulated: it can be panned, moved, labeled, zoomed and captured in different visual
formats.

Trace Descriptor and Rescale Dialog
Each open (visible) trace will have a descriptor box summarizing its name and properties. The header bar
on the box matches the trace color. Descriptor boxes show (clockwise from top left): trace Name,
Description (for Results, the S-parameter and Result type), Vertical Scale, Horizontal Scale, and Cursor
Value (if any).

Double-click the descriptor box to open the trace rescale dialog, which will appear to the right of or behind
the main function dialog. This dialog can be used to modify the trace scale settings. See Rescaling
Traces. Whenever you activate a trace, the corresponding trace rescale dialog moves to the top of the
stack.

Buttons along the bottom of the subdialog let you to quickly take other actions on that trace:

l Store to internal memory for later recalling to display

l Move to Next grid on display

l Label with a custom annotation
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Active and Foreground Trace
Although several traces may be open, only one trace is active. A highlighted descriptor box indicates
which trace is active. click the trace or trace descriptor box to make it the active trace and bring it to the
foreground in that grid.

Since multiple traces can be opened on the same grid, the trace shown on top of the others is the
foreground trace. Grid indicators (matched to the input channel color) represent values for the foreground
trace. Click on the trace or in its descriptor box to bring it to the foreground. This also makes it the active
trace.

Active descriptor box matches green graticule scale, and trace is "foregrounded" for better visibility.

Note: The foreground trace may not be the same as the active trace. A trace in a separate grid may
subsequently become the active trace, but the indicators on a given grid will still represent the
foreground trace in that group.

OneTouch Navigation
Drag-and-drop can be used to navigate the interface, move traces and change setups with one touch. Just
as you change the display by using the setup dialogs, you can change the setups by moving different
display objects. Use the setup dialogs to refine OneTouch actions to precise values.

As you drag and drop objects, valid targets are outlined with a white box. When you're moving over invalid
targets, you'll see the "Null" symbol ( Ø ) under your finger tip or cursor.

Tip: If your display is touchscreen enabled, OneTouch navigation can be performed using your
fingers (as shown here) or a pointing device.
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Turn On
To turn on an S-parameter (Sn or Rn), math, memory, or zoom trace, drag any descriptor box of the same
type to the Add New ("+") box. The next trace in the series will be added to the display at the default
settings. It is now the active trace.

If there is no descriptor box of the desired type on the screen to drag, touch the Add New box and choose
the trace type from the pop-up menu.

To turn on the Measure table when it is closed, touch the Add New box and choose Measurement.

Copy Setups
To copy the setup of one trace to another (e.g., an imported Rn to an Sn, or one math Fn to another), drag-
and-drop the source descriptor box onto the target descriptor box.

Note: Although you can copy setups between measured (Sn) and imported (Rn) S-parameter
traces, you cannot copy to the same type of trace (e.g., S1 to S2).
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To copy the setup of a measurement (Pn), drag-and-drop the source column onto the target column of the
Measure table. You can do the same to a query (Qn) on the Pass/Fail readout table.

Change Source
To change the source of a math, memory or zoom trace, drag-and-drop the descriptor box of the desired
source onto the target descriptor box. You can also drop it on the Source field of the target setup dialog.

To change the source of a measurement, drag-and-drop the descriptor box of the desired source onto the
parameter (Pn) column of the Measure table. You can do the same to a query (Qn) on the Pass/Fail
readout table.

80



Result Trace Analysis

Position Cursors
To change cursor measurement time/level, drag cursor markers to new positions on the grid. The cursor
readout on the trace descriptor, or below the grid, will update immediately.

To place horizontal cursors on zooms or other calculated traces where the source Horizontal Scale has
forced cursors off the grid, drag the cursor readout from below the Timebase descriptor to the grid where
you wish to place the cursors. The cursors are set at either the 5 (center) or the 2.5 and 7.5 divisions of the
grid. Cursors on the source traces adjust position accordingly.

Store to Memory
To store a trace to internal memory, drag-and-drop its trace descriptor box onto the target memory (Mn)
descriptor box. You can also drag it to the Source field on the Mn dialog.
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Move Trace
To move a trace to a different grid, drag-and-drop the trace descriptor box onto the target grid.

Pan/Swipe Trace
To pan a trace, activate it to bring it to the forefront, then drag the waveform trace right/left or up/down. If
it is the source of any other trace, that trace will move, as well.

Tip: If you are using join groups or the multi-zoom feature, all grouped traces will pan together.

If you are using a touchscreen device, swipe the trace right/left or up/down to pan at an accelerated rate.

Swipe from the far left of the screen to switch "tabs" and show the Windows desktop. Swipe from left
again to return to the oscilloscope application.
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Labeling Traces
The Label function gives you the ability to add custom annotations to the trace display. Once placed,
labels can be moved to new positions or hidden while remaining associated with the trace.

Create Label
1. click the Label Action button on the trace rescale dialog.

2. On the Trace Annotation pop-up, click Add Label.

3. Enter the Label Text.

4. Optionally, enter the Horizontal Pos. and Vertical Pos. (in same units as the trace) at which to place
the label. The default position is 0 ns horizontal. Use Trace Vertical Position places the label
immediately above the trace.

Reposition Label
Drag-and-drop labels to reposition them, or change the position settings on the Trace Annotation pop-up.

Edit/Remove Label
On the Trace Annotation pop-up, select the Label from the list. Change the settings as desired, or click
Remove Label to delete it.

Clear View labels to hide all labels. They will remain in the list.
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Zooming
Zooming allows you to "zoom in" on waveform details, or "zoom out" to see a greater span of acquisition.

Rectangle Zoom
Perhaps the easiest way to zoom a Result trace is to click-and-drag diagonally across the part of the trace
you'd like to zoom in on, then select the same trace as the zoom destination. The horizontal region within
the box is expanded to fit the width of the grid, and the vertical region is scaled proportionally.

Bottom image shows the region inside the white rectangle zoomed to width of grid.

You can create a new zoom trace in the same way by choosing one of the Zn slots as the destination.

Double-click the trace descriptor box to open the rescale dialog and adjust scale exactly.

Using Zoom Factor Controls
Zoom factor controls appear throughout the software wherever it is likely you may wish to change the
scale of a trace. They appear on the trace rescale dialogs for adjusting Result traces:

l In and Out buttons increase/decrease magnification and consequently change the Horizontal
and Vertical Scale settings. click either button until you've achieved the desired level.

l Var.checkbox sets In/Out to single increments, as opposed to steps of 1, 2, 5, 10.

l Horizontal Scale/div sets the time/frequency (or other unit) represented by each horizontal division
of the grid.

l Vertical Scale/div sets the level represented by each vertical division of the grid.

l Horizontal/Vertical Center sets the value represented by the center line of the grid. Changing it shifts
the trace left/right or up/down. Parts of the acquisition may now be off the grid.

l Reset Zoom returns the source trace to x1 magnification and original center.
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Creating Zoom Traces
Zoom traces (Zn) magnify a selected region of a another trace by creating a new trace that alters the
horizontal and/or vertical scale relative to the source trace.

The current settings for each zoom trace can be seen on the Zn dialogs, while the Zoom dialog is a
convenient panel for turning on/off zooms or changing the zoom source.

The MultiZoom feature locks the Horizontal Scale and Center of those traces that you choose to include
in the MultiZoom group. As you change the scale or position of any trace in the group, all traces change in
unison. For more information, see MultiZoom.

Zoom Dialog
The main Zoom dialog contains selection boxes for turning on/off and changing the source of a zoom
trace (Zn). There are also options to:

l Reset All, return all zooms to x1 magnification.

l Quick Zoom, create a corresponding zoom trace for each open trace.

l Turn on MultiZoom for all active zooms.

To display the Zoom dialog, choose Math > Zoom Setup from the menu bar or click any zoom descriptor
box. Use the Zn dialogs behind the Zoom dialog to reposition and rescale individual zoom traces that have
been created.

Zn Dialog
Behind the main Zoom dialog is a separate tab for each potential zoom trace (Z1-Zn). Each Zn dialog
reflects the center and scale for that zoom. Use it to adjust the zoom magnification.

Trace On shows/hides the zoom trace. It is selected by default when the zoom is created.

Source lets you change the source for this zoom to a different trace while maintaining all other settings.

The same zoom factor controls that appear on trace rescale dialogs appear on the Zn dialog for
modifying the scale and center of a zoom trace.
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MultiZoom
The MultiZoom feature unifies the Horizontal Scale setting of those traces that you choose to include in
the MultiZoom group. The traces can be zooms or other types of calculated (as opposed to acquired)
time traces, such as memories or math functions. This allows you to zoom in/out on several traces in
unison, even if they represent different sources, and move the entire group together as one trace is
repositioned by dragging or using the Auto Scroll controls.

Note: Traces that cannot be in the same MultiZoom group because they are not in the same units
or are different record lengths are excluded from selection.

The default MultiZoom also sets traces to the Same Zoom Position (Horizontal Center). You may
optionally choose an Independent Zoom Position in order to simultaneously view different parts of the
acquisition in different traces, while continuing to zoom and scroll in unison.

When MultiZoom is enabled manually from the Zoom or MultiZoom dialogs, active zooms are
automatically added to the MultiZoom group, although other types of calculated traces must be added
manually. As you add traces to the group by checking the selection box on the MultiZoom dialog, they are
set to the same Horizontal Scale as the first trace that was added to the group since MultiZoom was last
enabled. Once the group is set, modifying any member of the group will change the entire group.

Note: Since zooms are added first, the lowest numbered zoom in the group is usually the "master"
trace to which all others are rescaled, even though it may not appear at the top of the list of
eligible traces on the MultiZoom dialog.

MultiZoom does not affect the Vertical Scale and Offset of any traces in the MultiZoom group. These
continue to be controlled independently on the trace rescale dialog.
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Set Up MultiZoom

1. Choose Math > Zoom Setup... to open the Zoom dialog.

2. Check the MultiZoom box. All active zooms are added to the group and rescaled to match the first
active zoom in the list.

3. To modify the group further by adding or removing other types of traces, open the MultiZoom
dialog and select all the traces that are In the MultiZoom group.

4. To change the Zoom Position of any trace in the group, select Independent, then open the trace
dialog and change the Horizontal Center.

Note: Scrolling or dragging any of the MultiZoom group traces will shift the Horizontal
Center of this trace by the same amount of Delay as the others, however, it will remain
proximate to the center you set, which can be useful when wanting to step through two
different sections of a longer acquisition.

Scroll Waveforms
The Auto-Scroll controls appear at the right of the MultiZoom dialog. They work similarly to A/V controls
to allow you to continuously scroll all the selected traces in time-locked steps from the beginning to the
end of the acquisition.
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Storing Traces to Memory
The WavePulser application has twelve internal memory slots (Mn) to which you can copy any waveform
that is active on the grid. This is a convenient way to store a trace for later viewing and analysis, allowing
you to compare results from different measurements.

Memory traces can be used as source inputs for most math and measurements.

Note: Only a single waveform trace can be saved to one memory slot. If you wish to save all
acquired and calculated traces from a single S-parameter measurement for later analysis, use the
Save Measurement feature.

Memory (M1) of Result trace S3 looks exactly like S3, as it duplicates the waveform data. The trace is in a lighter shade
of yellow to show it is a different object and can be scaled /processed independent of S3.
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Saving Memories
Memories are created at the same scale as the source trace, but they can be adjusted independently by
using the zoom factor controls that appear next to the Mn dialogs.

1. Choose Math > Memory Setup to open the Memories dialog, or click the Store button at the bottom
of the trace rescale dialog.

2. click the Mn tab corresponding to the memory slot you wish to use.

Try to choose an empty slot, as anything currently stored in that location will be overwritten. All
memories will state if they are empty or an acquisition is stored there.

3. In Copy from Waveform, choose the source trace to copy to memory.

4. click Copy Now.

5. Optionally, check Trace On to immediately display the memory.

Restoring Memories
The Memories dialog is a convenient panel for restoring saved memories to the display. Access the
Memories dialog by choosing Math > Memory Setup.

Check On next to the memory trace you wish to display. A description of the memory showing the source
channel and creation time appears next to each Mn on the dialog.

click Clear All Memories to empty the memory banks.

Caution: Memories cannot be restored once they have been erased.
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Cursors
Cursors are markers (lines, cross-hairs, and arrows) that identify horizontal and vertical values where they
intersect the X or Y axis. Use cursors to make fast, accurate measurements of positions on a trace.

Cursor Types

Horizontal Cursors
Horizontal cursors are positioned at points on the x-axis and will measure the source trace horizontal and
vertical values at that point.

Horizontal Relative Cursors placed on the time domain traces.

The Horizontal Abs(olute) cursor displays a single line, Position 1. The readout to the far right of the
screen shows the horizontal value where the cursor intersects the x-axis, or X1. The readout on the source
trace descriptor box shows the vertical value where the cursor intersects the source trace in whatever is
the y-axis unit of the source trace.

The Horizontal Rel(ative) cursor displays two lines: Position 1 with the down-pointing arrow, and Position
2 with the up-pointing arrow. The readout to the far right of the screen always shows:

l The horizontal value where each cursor intersects the x-axis (X1 and X2)

l The horizontal delta X2 – X1 (∆x)

l 1/(∆x )
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The readout on the source trace descriptor box depends on which Show option is selected:

l Absolute shows the vertical values where X1 and X2 intersect the source trace.

l Delta shows the difference in vertical value where each cursor intersects the source trace (marked
by the arrows), or: y@X2 – y@X1 = ∆y

Note: This is not an absolute distance. When X1 is higher than X2, ∆y will be a negative
number, as it represents a fall, even when X2 is positioned above the zero level. When X1 is
lower than X2, ∆y will be positive, as it represents a rise.

l Abs + Delta shows both absolute and delta readouts.

l Slope calculates ∆y/∆x. The value will be intelligently converted to whatever unit is appropriate for
the source trace. Like the Delta readout, it may be positive or negative depending on the vertical
position of X2 relative to X1, regardless of its horizontal position.

When horizontal cursors are not tracking, they can be moved to any position along the x-axis individually.
The ∆x will be a positive number so long as X2 remains to the right of X1. If X2 is moved to the left of X1,
this will now be a negative number.

Horizontal cursors can be placed on traces whose x-axis has a dimension other than time, such as the
frequency domain Result traces. When there is at least one non-time-domain trace open, the Standard
Cursors dialog contains an X-Axis control where you can choose which traces are to be measured by the
horizontal cursors. The options will be appropriate to the types of traces open; for example, an option for
Hz. The cursors are placed on those traces that display x-axis values in the selected units, rather than
those with an x-axis of time.

Vertical Cursors
Vertical cursors intersect the y-axis and show the vertical value at that point (e.g., decibels). These cursors
can go "off trace" to show vertical scale values that are not represented in the measurement. Vertical
cursors have no readout to the right of the screen, as they do not have an x-axis element.

The Vertical Abs(olute) cursor displays a single line, Position 1. The readout on the source trace descriptor
box shows the vertical value at the point where the cursor intersects the y-axis.

The Vertical Rel(ative) cursor displays two lines: the dashed-dotted line is Position 1, and the dashed line
is Position 2. As with the Horizontal Relative cursor, the readout on the source trace descriptor box
depends on the Show selection:

l Absolute shows the vertical values where Position 1 and Position 2 intersect the y-axis.

l Delta shows the difference between the two values (∆y).

l Abs + Delta shows both vertical readouts.
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Apply and Position Cursors
To turn on cursors, from the menu bar, choose Cursors and select the desired cursor type from the drop-
down list.

Note: There must be a trace on the grid for cursors to execute.

To turn off cursors, from the menu bar, choose Cursors > Off.

To reposition a cursor, either:

l Drag-and-drop the cursor marker to a new position.

l Use the Position controls on the Standard Cursors dialog to place cursors precisely.

If there are both time and frequency grids on the display, choose to measure either Hz or S. Only those
grids will show the cursor markers.

To track cursors, moving both lines together at a consistent distance, check Track on the Standard
Cursors dialog, then drag the Position 1 cursor marker.

Note: The delta readouts should show little or no change when tracking, although absolute
readouts will change depending on the new position of the cursors. Moving the Position 2 cursor
will reset the relative distance and the delta, after which you can again track by moving the
Position 1 cursor.
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Measure
The Measure feature gives you access to a wide range of trace properties, such as Rise Time, RMS
voltage and Peak-Peak voltage. The instrument offers a quick selection of standard parameters, or you
can create a user-defined set of parameters (My Measure) drawn from all available measurements.

For all parameters, you may optionally calculate and display the statistical mean, min, max and sdev of
that parameter. Statistics are calculated once per acquisition and accumulate over multiple acquisitions,
up to the two billion value limit of the measurement buffer. The history of a parameter can also be
graphed as a histogram, track or trend for statistical analysis.

Parameter readouts are shown in a dynamic Measure table that appears below the waveform grids. All
active measurements can be used as inputs to other processes, such as Pass/Fail tests or math
functions, even when the Measure table is hidden from view. Measurements are calculated and can be
applied to other processes even when they are not displayed in the table.

Measurement Status Indicators
Symbols in the status row of the Measure table indicate the following:

OK: valid value returned.

Warning: there is a problem with the signal or the setup that prevents measuring. click the
parameter cell to see an explanation in the message bar.

No Pulse/Insufficient Data: The software is unable to determine Top and Base. In the case of
Vertical measurements, this may indicate that there is insufficient difference between the

Maximum and Minimum for the software to detect a pulse. Or, there may be an insufficient number of
points in the visible top or base of a pulse, such as when closely examining a step response.

Underflow Condition: The bottom most (negative) sample point of the waveform falls below the
ADC range. Probably, the bottom of the pulses appear to be cut off.

Overflow Condition: The top most (positive) sample point of the waveform is above the ADC
range. Probably, the top of the pulses appear to be cut off.

Simultaneous Underflow and Overflow Condition: Both conditions are present at once.
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Measure Dialog
The Measure Dialog gives quick access to measurement features. Use it to turn on/off parameters,
statistics, histicons and help markers for standard and user-defined parameter sets.

Selecting Measurements

1. To open the Measure dialog, Choose Measure > Measure Setup from the menu bar.

2. Check Show Table to display the readout. This is not required to take the measurement.

3. Choose the Std. Vertical or Std. Horizontal parameters.

Or, to create your own set drawn from all available parameters, choose My Measure, then open the
Pn dialogs to define new parameters.

4. Optionally:

l Show Help Markers.

l Add Statistics and Histicons to the Measure Table.

click Clear Sweeps to reset all measurement counters and restart all statistics.

click Clear All Definitions to reset all parameters to "None".

Caution: Definitions cannot be restored after clearing, you must repeat parameter set up.

Standard Parameter Sets
The pre-configured standard parameter sets available on the Measure dialog are:

l Std Vertical: Pk-Pk, Ampl, Max, Min, Sdev, Mean, Base, Top

l Std Horizontal: Rise, Fall, Period, Frequency, Width, Duty Cycle, Delay, N Points

To quickly begin a new set of user-defined parameters based on the standard vertical or horizontal sets,
click Quick Setups and choose the set to copy. Refine the settings on the Pn dialogs.

Statistics and Histicons
Checking Statistics On on the Measure dialog adds the mean, min, max and sdev of each parameter to the
measured value shown on the Measure table.
Statistics for each parameter are calculated once per acquisition and accumulate until you either Clear
Sweeps or the measurement buffer is full. The Num row of the Measure table shows the total number of
measurements included in the Statistics calculation. If the measurement is gated, the statistics are
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calculated for only the data points between the gates, just as the parameter value itself will reflect the
limits imposed by the gate.
Mean shows the weighted mean of the parameter calculated over the number of times shown.

Min shows the minimum value of the parameter measured over the number of times shown.

Max shows the maximum value of the parameter measured over the number of times shown.

Sdev shows the population standard deviation of the parameter calculated over the number of times
shown.

For any parameter that computes once on an entire acquisition, Num represents the number of sweeps
over which the statistics are computed.

For any parameter that computes on every event within an acquisition, such as a full period, Num
represents the number of events per sweep times the number of sweeps computed. Thus, for a Single
acquisition of five periods, the Num shown for any per period measurements will be 5, as five
measurements were made and the statistics reflect those five measurements. After another Single
acquisition, Num will be 10, or five measurements times two sweeps. The statistics now reflect all 10
measurements.

Histicons are miniature histograms of parameters that may be added to
the Measure table readout by selecting them on the Measure dialog.

These thumbnail histograms let you see at a glance the statistical distribution of each parameter.

Tip: You can quickly display a full histogram by clicking the histicon you want to enlarge.

Help Markers
Help Markers clarify measurements by displaying lines, labels and hysteresis bands to mark the points
being measured on the trace. For "@Level" parameters, markers make it easier to see where your
waveform intersects the chosen level. If you change the set of parameters displayed, the markers will
change, as well.

You can choose to use Simple markers, which are only the lines, or Detailed markers, which include the
measurement point labels.

You also have the option, by means of the Always On checkbox, to leave the markers displayed over
traces after you have closed the Measure dialogs or readout table.

Note: Unlike regular cursors, which are white and can be moved, help markers are blue and only
augment the display; they cannot be moved, and they do not reset the measurement points. Some
optional analysis software packages include markers designed specially for that domain of
reference, which are documented in the option manual.
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Pn (Parameter) Dialog
Use the Pn dialogs to define a new set of measurement parameters ("My Measure").

1. On the main Measure dialog, choose Measure Mode My Measure.

2. Open a Pn dialog and check On to activate the parameter.

3. Select the Type Measure On Waveforms.

4. click the Measure field and select the measurement from the pop-up menus.

5. Select the Source trace(s) to be measured. Some measurements require two sources.

6. Make any further selections on the subdialogs that appear after your Measure selection. These are
explained on the dialog and are necessary to fully define the measurement.

7. Optionally, turn on help markers, or use the remaining parameter subdialogs to:

l Gate measurements (limit the horizontal scope of the measurement)

l Accept only measurements that meet additional conditions

l Change the output units of measure.

Slope, Level and Hysteresis
Several time-based measurements enable you to select on which edge of the waveform the
measurement begins, or at what level the measurement is taken (e.g., *@level parameters). These
measurements usually also offer options for determining how the level is defined, and for setting up a
hysteresis band to prevent unwanted waveform effects from altering the measurement.

Slope
The Slope determines the edge of a pulse (the X axis point) at which measurements are made, or from
which edge to which edge a single period/cycle is counted. Slope can impact per period and cyclic
measurements, as the number of complete periods may be different depending on which edge is used.
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For two-input parameters, such as Dtime@level, you can specify the Slope used for each input separately
to determine the points on each waveform to be compared.

There are three possible settings for Slope:

l Positive, use the rising edge of a pulse

l Negative, use the falling edge of a pulse

l Both, use either edge, whichever next occurs that meets the other criteria

Here, the P1 Half Period parameter uses a Slope of Both, resulting in 10 measurements in this five period
acquisition, one every time the signal crosses the 50% Level, rising or falling.

If Slope were set to Positive, there would be only five measurements in this acquisition, one every time the
rising edge crossed the 50% Level, but not the falling edge (the Num row shows the difference).

Level
Level is the point on the Vertical (Y) axis used to take a measurement. The default Level for
measurements is 0 V or 50% amplitude, the center grid line when there is no Vertical Offset . When Level
can be specified, it can usually be set as either:

l An Absolute number of Volts, or whatever is the vertical unit of the source waveform

l A Percent of waveform amplitude, as determined by the Top-Base calculation
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Measurements that may be calculated per period usually have a Levels setting to specify the Level on the
rising edge from which full periods are counted.

Hysteresis
The Hysteresis setting defines an amplitude “band” which the input signal must exceed before a crossing
can be determined. Some non-zero Hysteresis value is required to prevent false crossing determinations.
The default value is 500 millidivisions (mdiv), with the unit “divisions” being equal to vertical grid divisions.

l Lower hysteresis values improve the ability to detect crossings on a smaller amplitude signal, but
with risk that false crossings will be detected. This also means that the signal must meet a minimum
amplitude requirement, and be relatively noise free at lower amplitudes.

l Higher hysteresis values improve the ability to reject the impact of signal distortion or noise in
determination of the crossing, but with risk that accuracy of crossing detection will be reduced.

For example: a non-monotonic signal crosses the 50% measurement threshold on the rising edge nine
times within the observation window, although there are actually only four waveform cycles. Without
Hysteresis, the non-monotonicity period is incorrectly detected as crossing and therefore a measurement
interval, which will result in incorrect calculation of periodic measurements.

A Hysteresis level that is greater than the amplitude of the non-monotonicity results in only four
measurement intervals, avoiding false measurement calculations.
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Periodic and Cyclic Measurements
Some measurement set up dialogs display a checkbox for Show one value per period or Cyclic.

Per period measurements compute one measurement per full waveform period in the acquisition. The
value returned is the mean of all the per period measurements. Usually, per period is an option for Vertical
parameters, like Amplitude, that would normally compute only one measurement per acquisition. The
example below shows how the P1 Amplitude parameter Num statistic changes from 1 to 5 when set to
measure per period. A hysteresis band Help Marker also appears, showing the level at which the periods
are counted.

Similarly, cyclic measurements are computed over the span of full periods in the acquisition, ignoring any
partial periods at the beginning or end of the acquisition. For example, if the Area parameter is set to
Cyclic, and the acquisition has five full cycles, then only the Area of those five cycles is calculated, as
shown below. The blue Help Markers show the five full periods, while the partial periods at the start and
end of the acquisition are omitted. Normally, the Area of the full, visible acquisition is calculated. In both
cases, only one measurement value is returned, but the value will be different.

Per period and cyclic measurements are subject to the other measurement settings, such as the Slope
and Level from which to count the waveform periods. Always visit the subdialogs that appear when
checking Show one value per period or Cyclic to determine if there are further settings to be made.

When the measure gates are in their default positions of 0 and 10 div, the periods/cycles are counted
across the full width of the grid. If the gates are set elsewhere, then the measurements are computed on
only as many full periods/cycles are within the gate.
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Gating Measurements
All measurements are calculated on only that portion of the waveform trace that is visible on the grid and
within the measurement gates. Any setting that moves the trace outside the observation window or
makes it appear "clipped" will affect measurements.

The default starting positions of the measurement gate posts are 0 div and 10 div, which coincide with the
left and right edges of the grid, and the First and Last points. Therefore, the measurement gates initially
enclose the entire visible acquisition. By moving the measurement gates, you can focus the measurement
on the section of the acquisition of greatest interest. For example, if you "gate" six rising edges of a
waveform, calculations are performed only on the six pulses bounded by the gate posts.

The quickest way to set a gate is to drag the gate posts from the far left and right of the grid to the desired
positions. You can refine this setting to hundredths of a division by using the Gate Start and Stop fields on
the Measure dialog for Standard parameter sets, or on the Gate subdialog for user-defined parameters.
click Default to return the measure gates to the width of the grid.

Accepting Measurements
Some measurements can be constrained to a vertically or horizontally limited range of values, or to
samples "gated" by the state of a second waveform. Both constraints can operate together. This
capability enables you to exclude unwanted characteristics from your measurements. It is much more
restrictive than a measurement gate, which is used only to narrow the span of analysis along the
horizontal axis.

Note: Since this feature operates on only a subset of the data, possible alerts or status indicators
concerning the measurement (such as "Data range too low") are not displayed.

If the measurement supports this feature, you will see the Accept subdialog next to the Pn dialog for you
to define your constraints.

Range Limited Parameters

1. From the menu bar, choose Measure > Measure Setup..., then click the Pn tab to open the
parameter setup dialog.

2. On the Accept subdialog, select Values In Range and enter the start and stop values, or click the
Find Range button to quickly display the most recently measured range of values.

Note: The correct units for the measurement (V, s, Hz, dB, etc.) are automatically displayed.
If you select a simple ratio parameter that yields a dimensionless number (such as power
factor), units are omitted.

Waveform Gated Parameters

1. From the menu bar, choose Measure > Measure Setup, then open the Pn dialog.

2. On the Accept subdialog, select Values Based on Waveform State.
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3. Click When Wform and select the gating waveform. It can be any waveform active at the same
time as the measurement source waveform.

4. Click State Is and select High or Low from the pop-up menu. Measurements will only be taken
when the gating waveform is in the selected state.

5. Click Level Type and select Absolute (voltage) or Percent (of amplitude) from the pop-up menu.

6. Enter the crossing Level value at which you want measurements to begin.

You can also click the Find Level button to automatically set the level at 50% of the gating
waveform.

Changing Units
Use the Units subdialog to change the output unit of a measurement parameter or math function trace.
The dialog is only active when there are alternative units in the equivalent dimension as the source unit.

Unit Category is the unit type, for example, Length, Velocity, or Time.

Units reflect the Category selection, for example, a Length unit of meters (m) versus a Velocity unit of
meters per second (m/s).

You can also rescale a math function trace on its Units subdialog by applying a multiplication factor
and/or additive constant, same as formerly done using the Rescale math function (y=ax+b).

Units/V (slope) is the multiplication factor (a) to use to scale the acquisition. Enter the number of the new
unit that will equal 1 of the original unit.

Add is the amount of additive constant (b) to add to the rescaled value. This value is always given in the
new unit.

Units of Measure
Units are automatically rescaled up or down within the list of standard, SI prefixes based on the relative
size of the signal. For example a 1000 V reading is shown as 1 kV, while .1 V is shown as 100 mV. When
the multiplication factor is 1 V = 1 Pascal, a 10 millivolt (mV) reading is displayed as 10 mPa rather than
.001 Pa or 100e-3 Pa.

Following are the supported SI units of measure and the mnemonics used to represent them on the
Rescale math function dialog.
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Note: These same mnemonics can be used in remote control programs and customization
scripts. Specify only the base unit in code, do not add prefixes.

Note: Time and dimensionless units are available only for certain measurements and for use in
code where relevant.

Category Unit Mnemonic

Mass gram G

slug SLUG

Volume liter L

cubic meter M3

cubic inch IN3

cubic foot FT3

cubic yard YARD3

Angle radian RAD

arcdegree DEG

arcminute MNT

arcsecond SEC

cycle CYCLE

revolution REV

turn TURN

Force/Weight newton N

grain GR

ounce OZ

pound LB

Velocity meters/second M/S

inches/second IN/S

feet/second FT/S

yards/second YARD/S

miles/second MILE/S

Acceleration meters/second2 M/S2

inches/second2 IN/S2

feet/second2 FT/S2

standard gravity GN
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Category Unit Mnemonic

Pressure pascal PAL

bar BAR

atmosphere, technical AT

atmosphere, standard ATM

torr TORR

pounds/square inch PSI

Temperature degrees kelvin K

degrees celsius CEL

degrees fahrenheit FAR

Energy joule J

british thermal unit BTU

calorie CAL

Rotating Machine radians/second RADPS

frequency (hertz) HZ

revolutions/second RPS

revolutions/minute RPM

torque N•m NM

torque in•oz INOZ

torque in•lb INLB

torque ft•lb FTLB

power, mechanical (watt) W

horsepower HP

Magnetic weber WB

tesla T

inductance (henry) H

magnetic field strength A/M

permeability HENRYPM
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Category Unit Mnemonic

Electrical ampere A

volt V

watt W

power, apparent VA

power, reactive VAR

power factor PF

capacitance (Farad) F

coulomb C

ohm OHM

siemen SIE

electrical field strength V/M

electrical displacement field CPM2

permittivity FARADPM

conductivity SIEPM

Time second S

minute MIN

hour HOUR

day DAY

week WEEK
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Category Unit Mnemonic

Dimensionless percent PCT

percent min-max PCTMNMX

decibel DB

decibel milliwatt DBM

decibel volt DBV

decibel millivolt DBMV

decibel microvolt DBUV

decibel microampere DBUA

decibel referred to carrier DBC

decade DECADE

unit interval UI

q-scale Q

bit BIT

byte BYTE

baud BAUD

least significant bit LSB

poise POISE

parts per million PPM

pixel PIXEL

division DIV

event EVENT

sample SAMPLE

segment SEG

sweep SWEEP
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Parameter Math
In addition to measuring waveforms, you can set up a parameter that performs mathematical operations
on the results of other parameters. Parameter math differs from math functions in that the input and the
output are still numerical values that display in the Measure table. Math functions, on the other hand, input
and output waveform traces that appear on the grid.

The setup for parameter math is much like that for other parameters. Some parameters can be qualified
on the Accept subdialog using value ranges or gating waveforms, as can regular waveform
measurements. There is functionality for applying custom scripts to calculate the results.

Exclusions
The following are not supported by Parameter Math:

l Multiplication and division of parameters that return logarithmic values

l Source parameters that are the result of other parameter math operations

Setting Up Parameter Math

1. On the Measure dialog, choose Measure Mode My Measure, then open a parameter setup (Pn)
dialog.

2. Choose Math on Parameters.

3. click Math Operator and choose an operation from the Select Measurement menu.

4. click the Source fields and select the parameters that are the inputs to the measurement.

5. Check On to enable the new output parameter and add it to the measurement readout.

Using P Script (Custom Parameter Math)
You can write your own VBScript or JavaScript to apply a mathematical operation to one or two input
parameters. Choose the Math Operator P Script. Scripting can be done directly in the Script Editor
window, or you can import an existing script.

Note: Param Script is a VBScript or JavaScript that performs a measurement on one or two
waveforms to output a parameter. P Script, which is Parameter Math, is a VBScript or JavaScript
that inputs one or two parameter values and performs a math operation on them to output
another parameter.
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1. On the Measure dialog, choose My Measure.

2. On the Pn dialog, choose Math on Parameters.

3. Choose Math Operator P Script.

4. Enter the Source input parameter(s).

5. On the Script Math subdialog, click Script Language and choose either VBScript or JScript.

6. click the Edit Code button to open the Script Editor window.

7. Enter your code in the window, or Import from File an existing script. Click Apply and OK to finish.

Tip: Scripts created in this window can be exported to a new file for future use.

Using Web Editor
Whereas with Parameter Math you can apply a single math operation to measurement parameters, the
Web Editor enables you to create processes that chain many operations on multiple inputs, including
custom math and measurements, and yield multiple outputs. These processes are integral to the
operation of the instrument; there is no need to export data to other programs.

Processes are "programmed" in the WavePulser application simply by arranging a series of blocks
representing different math functions or measurements and connecting them to form a flow chart—a
"processing web." The terminal parameters and functions represent the final outputs of this process.
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Create Processing Web

1. On the Measure dialog, choose Measure Mode My Measure.

2. Open the Pn dialog and select Advanced Web Edit.

3. click the Show Processing Web button. You will see a "peg board" display with potential input
sources aligned along the left, and a terminal marked with the parameter number to the far right.

4. On the Source Filter subdialog, deselect any types (e.g., zooms) that you do not want to use in the
process. This simplifes the display and reduces the need to scroll.

5. On the Web Editor dialog, choose the type of process to add to the flow. You can Add Math, Add
Measure, or Add Param Math.

6. From the pop-up, choose the operation or measurement that will occur at that node. A new block
appears on the display. Drag the block to a location in the flow.

Tip: Click on the location to place a green plus sign before adding the node. Then, the new
block will be created at this spot. Otherwise, blocks may cover one another until moved.
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7. The process block will have a input "pin" on the left. If a waveform is required, the pin is blue; if a
number is required, the pin is purple. click and drag a matching colored pin from the sources on the
left of the screen to the block. Choose as many sources as there are input pins on the block.

Tip: You may need to use the scrollbar to see all the available sources. For convenience, the
Math and Measure dialogs behind the Web Editor dialog summarize what is currently
configured for those sources.

When you drop the pin, a line is drawn from the source to the process. If a source is incompatible
with a process, you will not be able to pin it.

8. If the process requires additional configuration, a subdialog appears next to the Web Editor dialog.
Use it to enter the values to apply to that processing node.

9. Continue to add processes as needed, pinning the output of each block to the input of the next
block in the flow. The final process should be the same type as the terminal.

Tip: The color of the input/output arrows indicates which connections are compatible.The
flow does not need to be strictly sequential, as many processes can accept inputs that
have undergone other processes. The only requirement is that the outputs are pinned to
acceptable inputs.

10. Drag the output pin from the final process block to the input pin on the terminal.
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Preview Outputs
You can add preview "windows" to see the output of a process at any stage in the flow. These previews
apply only to the Web Editor.

Select the output pin of the processing block you wish to preview. It will turn bright green. Then, on the
Web Editor dialog choose Add Preview.

Delete Process/Connection
To delete any process from the web, select the block then click Delete. All the connections to/from it are
automatically deleted.

To remove a connection between process blocks, click the line. A scissor icon appears above it. Confirm
whether or not to "cut" the connection.

Add Other Terminals to Processing Web
Other measurements or math functions can share the same processing web. For example, you may wish
to create a math function of the waveform that would result from a sub-processing node, while the final
output of the full process is a measurement parameter.

To add a terminal:

1. Open the Math or Measure dialog behind the Web Editor dialog.

2. click the Web Edit icon following the location (Pn or Fn). The summary changes to Web Edit, and a
new terminal block appears on the Web Editor peg board.

3. Connect the output pin of the desired process to the input pin of the terminal. You can select
outputs that are already pinned to other blocks.

Exit Web Editor
When your processing web is complete, choose Display > Main Display from the menu bar. The screen will
resume the regular WavePulser window.
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Using Histograms
Histograms display the statistical distribution of parameter values using bars of varying heights to
represent measurement frequency. The Histogram math function plots the number of parameter
measurements that fall within a small range, known as a bin, as a function of the parameter value. Each
bin is represented by a bar on the chart. The histogram can use from 20 to 5000 bins, each representing a
consecutive sub-range of measured values, and it can hold up to two billion measured values.

The Histogram function descriptor box shows: the number of values represented by
each vertical grid division of the histogram bars (#/div), the bin width represented by
each bar of the histogram (vertical or horizontal units/div), and the total number of
values computed in the histogram (#).

Thumbnail versions of parameter histograms are called Histicons. They are available as a checkbox
option on the Measure dialog. Histicons appear on the Measure table, rather than as a new math trace,
although they can be converted to a regular histogram function simply by clicking on them.

Uses of Histograms
Histograms show the distribution and probability density of waveform parameter values over multiple
acquisitions. They are especially useful for visualizing and quantifying random processes, such as jitter.
The shape of the histogram yields immediate information about the parameter being measured:

Gaussian/Unimodal histograms have one peak near the center of the distribution with roughly equilateral
roll off on each side. The Gaussian distribution is a good indication that a random process is shaping
variations in the measurement, such as the effect of random jitter on a pulse measurement.

Bimodal histograms have two, distinct peaks in the distribution at the outer edges, indicative of steady-
state high and low values.

Uniform/Symmetric histograms look rectangular, indicating a wide distribution of values.

Skewed histograms show a peak at either the negative or positive edge of the measurement range, with a
steady roll off toward the other side.

Because the shape of histogram distributions is particularly interesting, additional histogram
measurements are available for analyzing these distributions. They are generally centered on one of
several peak value bins. You will find the histogram measurements in the Statistics sub-menu of the
Measure Selector.

Comparing the total populations of each bin of the histogram can help quantify rarely occurring events
that might otherwise be overlooked, one advantage of the statistical study of measured data.

Histogram Calculation
Histograms are calculated on the portion of the waveform within the acquisition window and the
measurement gates, just as are the parameters. Likewise, histogram measurements are limited to the
bars of the histogram that are visible on the grid and that fall within the measurement gates.

Measurements that yield only one value per acquisition will not produce characteristic histogram
distributions, unless you allow sweeps to accumulate.

111



WavePulser 40iX High-speed Interconnect Analyzer User Manual

Plotting Histograms

1. Open the parameter setup dialog (Pn) for the parameter you wish to histogram.

Tip: A quick way to do this is to click the Measure table Pn cell.

2. Select the Histogram action button at the bottom of the Pn dialog and choose the function (Fn) in
which to draw the histogram.

3. Select the new hist descriptor box to display the Fn dialog, then open the Histogram subdialog and
define the histogram Buffer and Scaling (see below).

Clicking Clear Sweeps at any time resets the measurement counter and restarts the histogram.

Histogram Buffer
Enter the maximum #Values in one bin of the histogram. This determines the total number of
measurements that are represented by a bar at full height. Once this number is reached, the histogram
will be rescaled according to the Vertical Scale method selected, as it continues to accumulate data.

Histograms are dynamically computed using the last N measurements in the parameter buffer, up to two
billion. If #Values is modified, the histogram is redrawn using the last N events required.

If the parameter source is a memory, storing new data to memory effectively acts as an acquisition
trigger/sweep and updates the parameter buffer and the histogram.

Histogram Scaling

Bins
First, enter the total #Bins that comprise the histogram. This determines how many bars appear in the
histogram.

Determining peak value bins, or histogram peaks, is very useful because they indicate the dominant
values of a parameter. However, the use of a high number of bins relative to the number of parameter
values acquired can yield a spiky histogram, making meaningful peaks hard to distinguish.

l The default value of 100 is a good number for Vertical (amplitude) parameters.

l For Horizontal (timing) parameters, it is safe to use up to the maximum number of bins.
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Histogram bins represent a sub-range of waveform parameter measurements. The measurements that
fall within a bin may have a value anywhere within its sub-range. However, measurements of the
histogram itself assume that all measurements in a bin have a single value. The software uses the center
value of each bin’s sub-range in all its histogram measurements. The greater the number of bins used to
subdivide a histogram’s range, the less the potential deviation between actual measured values and those
values assumed in histogram measurements. Nevertheless, using more bins may require a greater
number of sweeps to populate the bins sufficiently for the identification of a characteristic histogram
distribution.

Center and Width
How parameter values are distributed into the bins is determined by the Center and Width values.

The Center is the center value of the measurement range represented by the histogram. This will generally
be a value near the expected peak value, or a center bar in a symmetric histogram. It is a good idea to
examine the mean value of the parameter you wish to histogram to determine the value to place at center.

The Width is the measurement interval represented by each bin of the histogram, which is counted in
vertical units/div for Vertical parameters, or horizontal units/div for Horizontal parameters. If Width is 500
ns, a Horizontal measurement that is less than or equal to 500 ns from center falls into the first positive
bin, and one that is less than or equal to -500 ns from center falls into the first negative bin, and so forth
for each increment of 500 ns and successive bins. The more bins that are in the histogram, the smaller
the Width should be to ensure that values will distribute across the histogram, showing a meaningful
deviation from center.

When the ideal range required to form a good distribution is not apparent, the software's range finding
function, Find Center and Width, can be used to calculate an optimal range and redraw the histogram
using it. The software gives a running count of where values fall relative to the range on the Histogram
function subdialog, and if any fall above or below it, the range finder can recalculate the histogram using
those values while still in the buffer. First, check Enable Auto Find to use this feature.

Vertical Scale
Histograms build vertically as data accumulates over multiple acquisitions. It is possible that, after a
sufficient number of sweeps, the peak bars of a histogram will reach the grid maximum, causing an
overflow condition, and the histogram must be rescaled to accurately reflect the distribution. Choose a
Vertical Scale method by which to handle situations where the histogram buffer is full:

l Linear rescales the number of values represented by each vertical division as the histogram reaches
the top of the grid. The histogram will appear to shrink then grow again as more data is
accumulated, until another rescaling of the values/div is required.

l LinConstMax keeps the histogram at near full scale when it reaches the top of the grid, but changes
the numbers on the vertical axis as more data is accumulated.
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Using Trends
The Trend math function plots a waveform composed of parameter measurements arranged in the order
the measurements were made. The vertical units are the source parameter values, and the horizontal unit
is the measurement number. The Trend contains a single value for each unique measurement, and
therefore may not be time synchronous with the source waveform, where the same measured value may
occur successively over time.

Uses of Trends
Trends are especially useful for visualizing the history of a parameter over an extended period of time or
over multiple acquisitions. Think of Trend as a strip chart recorder for your instrument.

Plotting Trends
Although a Trend plots parameter values, it is created as a Math function on the Function (Fn) dialogs.

1. Open the parameter setup (Pn) dialog for the measurement you wish to trend. A quick way to do
this is to click the Measure table cell.

2. Select the Trend button at the bottom of the Pn dialog, then choose the function (Fn) in which to
draw the plot. The Trend opens in a new grid along with its function descriptor box.

3. Select the new Trend descriptor box to display the Fn dialog, then open the Trend subdialog.

4. Choose a computation Mode of All (measurements per acquisition) or Average (one measurement
per acquisition).

5. Enter the number of measured Values to Trend.
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Using Tracks
A Track is a waveform composed of parameter measurements that are time synchronous with the source
waveform. The vertical units are those of the source parameter and the horizontal units are seconds. Due
to the time synchronization, the number of points in the Track function is identical to the number of
samples in the source waveform, and a Track is limited to the samples in a single acquisition. The Track
may contain many redundant values.

Uses of Tracks
In general, Track is the tool to use if you want to capture a continuous stream of data spaced closely
together. It is also useful in applications that require time synchronization, or for locating anomalous
parameter values in a long acquisition.

Plotting Tracks
Although a Track plots parameter values, it is created as a Math function and controlled on the Function
(Fn) dialogs.

1. Open the parameter setup (Pn) dialog for the measurement you wish to track. A quick way to do
this is to click the Measure table cell.

2. Click the Track toolbar button at the bottom of the Pn dialog and choose the function (Fn) in which
to draw the plot.

3. Click the new Track descriptor box to display the Fn dialog, then open the Track subdialog.

4. On the Track subdialog, choose a method to Connect the points in the track into a waveform:
Interpolate points between samples, or Extend the line directly point to point.
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Track vs. Trend
The table below summarizes the differences between Track and Trend.

Track
(Parameter value vs. time)

Trend
(Parameter value vs. event)

Cumulative? No, resets after every acquisition Cumulative over unlimited number of
acquisitions, up to two billion events

Time correlates to other data? Yes No

Monitors Frequency domain? Yes No, points are not evenly spaced in time and
therefore cannot be used for an FFT or other
type of frequency trace

Monitors parameters over
multiple acquisitions?

No, resets after every acquisition Yes

Preserves all measurement
data?

Yes, although maximum time period that
can be captured is limited by acquisition
memory and sampling rate

No, data can be missed during time
oscilloscope takes to re-arm between
acquisitions
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Math
Math Function traces (Fn) display the result of applying a mathematical operation to a source trace. The
output of a math function is always another trace, whereas the output of a measurement parameter is a
tabular readout of the measurement.

Math can be applied to any type of trace. It can even be applied to another math trace, allowing you to
chain operations (for example, trace F1 can show the average of S1, while trace F2 provides the integral of
F1).

Custom scripts may be used to define a math function. Several scripting "languages" are supported,
depending on the application. You can find these options in the Custom submenu of the Math Selector.
Scripts may be imported or written in the Script Editor window and saved for future use. See Using P
Script for a description of the process.

Function (Fn) Dialog
Use the Function (Fn) dialog to set up math function traces. Math functions take as input one or more
other source traces and output a new math trace. Any additional settings required for the operator will
appear on a subdialog at the right of the screen.

Single functions perform one operation on one or two input sources.

Dual functions chain two operations to arrive at a single result. This saves you the effort of having to chain
two separate math functions. As with single functions, the number of sources required will vary based on
the operation. You may need only one source for Operator1, but two for Operator2 (the result of the first
operation counts as one source).

1. From the menu bar choose Math > Math Setup, then open one of the Fn tabs.

2. Choose a single f(x) or dual g(f(x) operator function.

Tip: You can also choose Web Edit, in which case this function is added as a terminal to the
processing web. See the instructions for Using Wed Edit to set up the function.

3. In Operator1, choose the math operation to perform.
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Note: The Operator can be a custom script written in one of several scripting "languages."
Choose from the Custom submenu and import or write the script in the Script Editor. See
Using PScript for a description of the process.

4. The choice of operator drives the number of Source fields you will see displayed. Make a selection
in each field.

Tip: A Summary of the function appears on the dialog. Refer to this to be sure your sources
are in the proper order to yield the function you want (e.g., S1-S2 vs. S2-S1).

5. If the operator you've selected has any other configurable settings, you'll see a subdialog of the
same name as the operator. Open the tab and make any further settings. These are explained on
the dialog.

6. If you're creating a dual function, repeat the procedure for the second operator.

Graphing
The Graph button on the Function (Fn) dialogs allows you to choose a parameter to plot as a histogram,
track, or trend.

Tip: The plots are the same as those created using the toolbar on the Parameter (Pn) dialog.

As with other math functions, configurable settings will appear on subdialogs after the plot is selected.

Adjusting Memory or Math Traces
The scale of memory (Mn) or math function (Fn) traces can be adjusted directly without having to create a
separate zoom trace. The same set of zoom factor controls used for zoom traces appear on the Zoom
subdialog, but in this context they only rescale the active math or memory trace rather than create a new
zoom. This applies to any trace that is created as a math function (Fn) trace, including traces generated
through analysis options and graphs.

You can, if you wish, create a separate zoom trace from a memory or function trace the same as you
would normally create a zoom (draw a rectangle, etc.). In this case, you choose one of the zoom locations
(Zn) in which to draw the trace, but the source trace remains at the original scale.
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Math Dialog
Once a math function has been created and saved on the Function (Fn) dialog, use the main Math dialog
to quickly enable/disable it. You can also use this dialog to quickly turn on/off zoom traces.

To open the Math dialogs, click the front panel Math button, or from the menu bar choose Math > Math
Setup. Select the On checkbox next to each function you wish to display.

To modify a function, click the Fn button.

To erase all functions from their locations, click Reset All.

To restart the counter on cumulative functions (like Average), click Clear Sweeps.
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PASS/FAIL Testing
PASS/FAIL testing allows you to define a set of queries that an acquisition may "PASS" or "FAIL" when
tested against, then take actions depending on the result.

l Mask testing compares sampled values to a pre-defined area of the grid (the "mask") to see if they
fall within or without.

l Parameter comparison compares a measurement result to an arbitrary limit (Param compare) or to
another measurement (Dual param compare).

The preconfigured queries are then enabled by selecting them on the Pass/Fail dialog and defining what
results constitute a "PASS" on the Actions dialog.

Mask Testing
A mask defines an area of the grid against which a source trace is compared. Test conditions are
associated with the mask, defining how the waveform is to be compared to the masked area (e.g.,
some/all values fall within, some/all values fall outside), and a pass or fail result is returned indicating the
condition was found to be true or false.

Mask testing can be done using a pre-defined mask or a mask created from a waveform with user-defined
vertical and horizontal tolerances. Some industry standard masks used for compliance testing are
included with the WavePulser software. The mask test can be confined to just a portion of the trace by the
use of a measurement gate.

Access Mask Test Dialogs

1. Choose Analysis > Pass/Fail Setup to display the Pass/Fail dialog.

2. Click the Qn button where you want to set up the query.

3. Select Mask test.

The Qn dialog opens with the Mask test condition selected. To the right are the Test, Load Mask, Make
Mask, and Gate subdialogs where you manage all mask settings.
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Make Mask
Use this procedure to create a new mask based on a live waveform. The mask covers the area of the
waveform plus the boundaries you enter.

1. Open the Make Mask subdialog.

2. If desired, enter a new Destination File Name and path, or click Browse and select a previous file to
overwrite. The file name should end with the .msk extension.

3. Click the Ver Delta and Hor Delta fields and enter boundary values using the pop-up Virtual Keypad.

4. Click Make from Trace.

Load Mask
Do this instead of Make Mask if you have a pre-defined mask file.

1. Open the Load Mask subdialog.

2. To use a saved .msk file, click File and select the mask.

To use an industry standard mask, click Standard and select the mask from the pop-up.

3. Check View Mask to display the mask over the trace.

Remove a Mask from the Display
Click the Delete All Masks button on the Load Mask subdialog. Alternatively, open the Qn dialog where a
particular mask is set, and on the Load Mask subdialog, click Delete.

Set Gates
To limit the section of the waveform that is compared to the mask.

1. Open the Gate subdialog.

2. Enter the Start and Stop horizontal divisions that mark the section of the waveform to be tested.
These can be a whole division or a fraction of a division. Divisions are numbered 1-n left to right.

Tip: You can also drag the gate posts from the extreme left and right of the grid to the
desired position.

Define "True"

1. Open the Test subdialog.

2. Select one of the conditions that, when true (yes), results in a pass or fail.

3. Optionally, turn On markers to show where on the waveform mask violations have occurred.
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Param(eter) Compare
PASS/FAIL queries (Qn) can be configured to compare different parameter measurements (Pn) to each
other, or to a user-defined limit or statistical range. The Summary field shows the logic represented by the
query. Check it to ensure your selections are producing the test you want.

Comparing a Measurement to a Limit
This method compares the result of a selected parameter to a user-defined limit or statistical range.

1. Choose Analysis > Pass/Fail to display the Pass/Fail dialog.

2. Click the Qn button where you want to set up a query.

3. From the pop-up menu, choose Param compare.

4. On the Qn dialog, click Source1 and choose the parameter.

5. On the ParamCompare subdialog, click Compare Values and select All (every value must be within
limit to be "true") or Any (any value can be within limit to be "true").

6. Click Condition and select a Boolean operator, then click Limit and enter the value that completes
the condition. The value entered acquires properties corresponding to the parameters being tested.
For example, if you are testing a time parameter, the unit is seconds.

7. If you chose to set a Delta limit, also enter the Absolute or % Delta value. You may choose instead
to set Limit and Delta using one of the buttons at the bottom of the dialog.

Comparing Parameter Measurements
This method compares one parameter to another, rather than a limit.

1. Choose Analysis > Pass/Fail to display the Pass/Fail dialog.

2. Click the Qn button where you want to set up a query.

3. From the Pass/Fail Condition menu, choose Dual Param Compare.

4. On the left-hand Qn dialog, select the parameters to compare in Source1 and Source2.

5. On the ParamCompare subdialog, choose to Compare All (every value must meet condition to be
"true") or Any (any value can meet condition to be "true").

6. Click Condition and select the Boolean operator that expresses the relationship between
parameters (e.g., All P1 values must be less than P2).
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Define PASS/FAIL Tests
The queries define the conditions that, if met, would result in "true" but don't in themselves determine the
test result. You must separately define what constitutes a "PASS" or a "FAIL" on the Actions dialog. A
PASS or FAIL result can be made to produce various additional actions.

1. After setting up the PASS/FAIL test qualifiers, open the Actions tab.

2. Optionally, check Summary View to see a running summary of results over the total number of
sweeps.

3. Select the test Pass criteria in Pass If.

4. To apply additional actions to the test result:
l Check Enable Actions to turn on actions.

l Under If, choose to apply actions if the result is a Pass or a Fail.

l Under Then, choose all the actions to apply:
l Save a waveform file

l Stop the test

l Sound an Alarm

l Capture the screen and process it according to your Hardcopy (Print) selection

Use the Clear All button to clear all the action checkboxes, or Force Actions Once to take action
once regardless of the test results.

Delay Test
You can delay the start of a test by entering the number of sweeps to wait in Start Testing After.

Click Clear Sweeps at any time to reset the test counter.

Stop Test
To stop the test following a specified number of sweeps, rather than a PASS or FAIL result, check the Stop
Test box, then enter the desired number of sweeps in After.
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Using Signal Integrity Studio
With Signal Integrity Studio (SI Studio), you can analyze the complete signal integrity characteristics of a
channel, including eye diagram and jitter analysis. The channel is described by its S-parameters, either
measured by an attached WavePulser or imported from a VNA or other S-parameter modeling software.

When SI Studio is activated within the Wavepulser application, the SI Studio menu is activated on the
menu bar. The menu contains options for:

l A Signal Generator for producing a simulated source signal that may be input to Eye Doctor and SDA
for "what if" modeling.

l (Eye Doctor II) Channel Emulation/Equalization, which lets you apply pre-/de-emphasis, channel
emulation/de-embedding, and equalization to an input signal to model the effects of a channel and
on a raw or conditioned signal.

l (SDA II) Serial Data Analysis toolkit for performing eye diagram and jitter analysis. Signal output from
Eye Doctor can be input to SDA for complete characterization of a channel.

See Signal Integrity Studio Quick Configuration for an example of integrating all three applications.
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Activating SI Studio

For Use With WavePulser
The option key for SI Studio is added to your WavePulser at the factory. You should see the SI Studio
selections on the WavePulser menu bar after you initialize.

You can confirm that the option has been added to your WavePulser by choosing Help > About from the
menu bar and looking for SI Studio in the list of installed options. If you do not see it, contact Teledyne
LeCroy Customer Service.

For Standalone Use
With each license purchased, a USB hasp key is delivered that allows you to run the WavePulser
application with the SI Studio functionally even when the host PC is not connected to a WavePulser.

Just launch the WavePulser application with the USB key inserted into one of the host ports. Once the
application is running, you can confirm that the software is enabled by choosing Help > About from the
menu bar and looking for SI Studio in the list of installed options.
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SI Studio Quick Configuration
Follow these steps to quickly configure Signal Integrity Studio for a measurement on a 4-port device
corresponding to a single differential lane.

A. Measure the S-parameters of your DUT with WavePulser
After completing a measurement with your WavePulser, follow procedures to save the S-parameters to a
Touchstone file on the Result Actions tab.

Note: Be sure to know whether the Touchstone file contains single-ended or mixed-mode
S-parameters. It may help to add a key to the file name. This example configures a differential
input, therefore the file should be mixed-mode.

Tip: You can skip this step in the future by enabling the Save Result Action and On Seq Complete
or Recalc.To save newly acquired measurements to the same file name you have already
configured in Eye Doctor, be sure to deselect Append Timestamp.

B. Configure the Simulator
1. From the SI Studio menu, select Signal Generator to display the Generator dialog.

2. Open the SimC1 Setup dialogs.

3. Optionally, to display the base signal as configured in the simulator (prior to Eye Doctor
processing), check View (+) and/or View (-).

4. Select Signal Type NRZ and enter the signal bit rate in Freq. or Bit Rate. Make any other signal
settings desired.

5. On the Generator dialog, click Run ModeSingle to generate a single waveform acquisition.

The waveforms generated are named SimC1P and SimC1M.
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C. Configure Eye Doctor
1. From the SI Studio menu, choose Channel Emulator/Equalizer to open Eye Doctor II dialog. Each

block in the processing flow is a button to open that group of setup dialogs.

2. Click the Signal Input block to configure the signal:

l Select Input1-Input2, then select SimC1P and SimC1M as the Input1 and Input2 signals.

l Set the Nominal Bit Rate to match the setting made in the Signal Generator.

3. Close and return to the Eye Doctor II dialog, then click the Emulate/De-embed block. On the
Emulate/De-embed dialog, click Emulate Channel to get to the Channel dialog:

4. Uncheck Use Ideal Channel (if checked).

5. Click Browse and select the Touchstone file you saved following the measurement.
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6. Set the S-parameter Format to match the format of the selected Touchstone file. For a differential
signal, this should be Mixed-Mode.

7. Click View Response to do a quick check that the S-parameters in the selected Touchstone file are
as expected.

8. If necessary, change the port configuration to match the configuration of the Touchstone file.

9. Close and return to the Emulate/De-embed dialog.

10. Check Enable, and if the "LED" indicator next to the Apply button is red, click Apply. The indicator
will turn green when Eye Doctor has successfully included the Touchstone file in the processing
chain. Close the dialog.

11. Optionally, on the Eye Doctor II dialog, check the Show boxes next to Signal Input and Emulate/De-
embed to see how the emulated channel affects the input signal.

D. Configure SDA
1. From the SI Studio menu, choose Serial Data... to open the Serial Data Analysis II dialog.

2. Select the Enable SDA, Enable Eye Meas. and Enable Jitter Meas. checkboxes.

3. Click the Setup Signal Input block to configure the signal.

4. Choose 1 Input (or Diff Probe), and set Input 1 to use the Eye Doctor output, EDrOut.

129



WavePulser 40iX High-speed Interconnect Analyzer User Manual

5. Go to the Clock Recovery tab and enter the bit rate of the simulated signal, or click Find Rate.

6. Follow the procedures to conduct Eye Analysis or Jitter Analysis .

Signal Generator
The SI Studio Signal Generator allows you to configure up-to-four simulated signals, SimC1 through
SimC4, that may be input to Eye Doctor II or SDA for "what if" analysis of your channel. Base signals may
be Clock, Sine, or NRZ type and configured with custom noise, asymmetry, jitter or data features.

Select SI Studio > Signal Generator from the menu bar to open the configuration dialogs.

Generator Dialog
The left side of the Generator dialog contains global settings used for all four SimCn channels.

1. Select the Run Mode used to generate waveforms:

l Continuous generates waveforms at the frequency of an internal clock.

l Single generates a single acquisition (10 Horizontal divisions) of the simulated waveform.
The trigger mode will change to Stopped following the acquisition.

l Stopped, the Simulator is off; new waveforms are not being generated.

2. In Sample Rate, enter the number of samples/sec in the simulated waveform.

3. In Record Length, enter the total number samples in one acquisition of the simulated waveform.

4. Each simulated "channel" has a set of subdialogs used to configure the characteristics of that
signal. First, select the SimCn Setup button to open the corresponding dialogs. Configure at least
the Signal tab for each channel you are using.
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Signal
Use the Signal subdialog to define the base signal characteristics.

1. Optionally, select to View (+) or View (-) polarity of the channel. Both can be displayed at once.

2. Choose the Signal Type:

l Clock

l Sine wave

l NRZ data signal with user-definable jjitter or data characteristics

l PAM4 signal

3. In Freq or Bit Rate, enter the frequency of periodic signal types or bit rate of data signals.

4. Enter the desired:

l Amplitude, one half the Peak-Peak voltage

l Positive or negative Vertical Offset from level zero

5. Optionally, enter a 10-90% Risetime, Rise:Fall ratio and Overshoot-/Overshoot+. These settings are
valid for Clock, NRZ or PAM4 signal types and are an alternative way of limiting the bandwidth.

6. Check Auto Scale to automatically rescale the signal on screen when amplitude changes so that
the trace is not clipped.

7. To apply a low pass Butterworth filter to the signal, check BWL On and enter the frequency CutOff
and filter Order.

Zoom
Optionally, use the zoom factor controls to adjust the scale of the simulated signal on the display.
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Noise
Noise can be added to the base signal. Enter the desired Vertical Noise and Vertical Shape Attributes.

You can also generate a channel of just noise by checking Just Noise, in which case the SimCn Signal
settings are overridden.

+/- Asymm
To introduce asymmetry between the + and - signals, enter the (time) Skew and/or Amplitude Offset.
These values are applied to the - signal.
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Jitter
You can add either broadband or sinusoidal jitter to the base signal.

Broadband Jitter
Check On beneath Simulated Broadband Jitter and enter the Rj, BUj, and BUj Shape characteristics.

Sinusoidal Jitter

1. Clear the On box under Broadband jitter if it is checked.

2. Enter the Jitter Freq(uencies) being modulated and the amount of modulation in Pk-Pk.

3. Choose a Mod(ulation) Shape.

4. To turn on Spread System Clocking, check SSC On and enter the SSC Freq(uency) for each of the
three jitter frequencies.
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Data
If the signal is NRZ:

1. Select the Data Type and any Data Pattern or sequence relevant to that type.

2. To also define frames, check Frame on and enter the Frame Pattern and Frame Length.

3. Optionally, check Pattern Lock to generate the same pattern at the start of every "trigger." This will
stabililze the pattern on the screen. Otherwise, the pattern is randomized.

4. Optionally, check Invert Pattern to invert the signal.

5. To introduce bit rate errors, enter the Error Rate and the first Error Bit.

Random Gen
To modify the pattern used to randomize the jitter, change the Seed sequence, or check one of the
randomizing slections.
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Eye Doctor II
Eye Doctor II is a complete set of signal integrity tools performing the full-range of de-embedding,
emulation and equalization on full acquisitions, with little impact on waveform processing time. Results
are fully integrated with the other SI Studio tools, making Signal Generator signals available to Eye Doctor
processing, and Eye Doctor outputs available for further analysis using the deep SDA toolbox.

Eye Doctor II utilizes industry-standard S-parameter measurements and Touchstone 1.1 files.

Eye Doctor II features:

l Transmitter Emphasis Emulation for adding or removing emphasis from signals. Using the Auto Add
or Auto Remove function, enter the amount of emphasis to add or remove. Custom mode allows for
specifying the specific tap values for the linear tapped delay line filter creating the emphasis. Both
Pre-emphasis and De-emphasis are supported in Eye Doctor II.

l Fixture De-embedding for moving the measurement reference to a point before the fixture (such as,
directly to the transmitter output) or for removing the effects of the fixture. A Touchstone format S-
parameter file describing the fixture is required to de-embed.

l Channel Emulation / De-embedding to see the effect a channel is having on measurements. This
works in both directions. You can emulate channel effects to see what the signal would look like
were the measurement taken after the serial data channel. Conversely, you can de-embed the effects
of a physical channel to see what the signal would look like were the measurement taken before the
serial data channel. It is very similar to Fixture De-embedding. For both emulation and de-embedding
of serial data channels, a Touchstone format S-parameter file describing the channel is required.

l Receiver Equalization Emulation to emulate the effects of a Continuous Time Linear Equalizer, Feed
Forward Equalizer, and/or Decision Feedback Equalizer on a serial data signal. This is critical step for
some serial data signals that could have a completely closed eye at the receiver input.

Eye Doctor II Workflow
The Eye Doctor II dialog shows the flow of the data from the transmitter to the receiver.

Each block in the flow diagram is a button that opens its corresponding configuration dialog:

l Signal Input is used to define the signal input sources and nominal bit rate.

l Emphasis is used to add or remove pre-emphasis/de-emphasis from the input signal.
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l Emulate / De-embed allows you to emulate channels or de-embed fixtures by modeling their
properties using S-parameter Touchstone files.

l Equalizer allows you to configure values for Continuous Time Linear Equalization (CTLE),
Feed Forward Equalization (FFE), and Decision Feedback Equalization (DFE).

Visit the dialog for each process you wish to apply to the circuit model, working from left to right. Only
Signal Input is required.

The Show checkbox following each block allows you to display the waveform that results from that
process. Turn Off Views clears the checkboxes and closes all Eye Dr. II waveform displays.

Save/Recall lets you save your current Eye Doctor II configuration to a setup file (.LSS) or recall a previous
setup.

Signal Input Dialog
Click the Signal Input button on the Eye Doctor II dialog to access the Signal Input dialog.

Inputs
If you are using a differential probe, click the 1 Input (or Diff. Probe) button. Then click Input1 and select an
the signal source from the Select Source pop-up window.

If you are using two single-ended probes to calculate the differential signal, click the Input1-Input2 button.
Then click Input1 and Input2 to select the signal source for each. The Input2 waveform is subtracted from
the Input1 waveform to calculate the differential; you do not need to first create a separate Math function
to do this.

Nominal Bit Rate
Enter the Nominal Bit Rate of the data stream in order for the Eye Doctor Emphasis and Equalizer
processes in to function properly.

Note: While the bit rate does not have to be exact, it should be within ±3% for these blocks to
function correctly.
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Emphasis
Emphasis is added to a signal as a way to pre-compensate for expected channel losses. Since high
frequency components are attenuated more by serial data fixtures and channels than low frequency
components, the addition or pre or de-emphasis can regularize the amplitude through the channel.

Eye Doctor II's Emphasis feature is implemented as a tapped delay line filter, with 2 taps for auto-add and
8-taps for auto-remove. It incorporates algorithms to automatically determine the tap values used. The
filter is equivalent to Feed Forward Equalization (FFE) without user-selectable precursor taps, and is
mathematically described as follows:

Where:

n yin(t) is the initial waveform

n yout(t) is the transformed waveform

n N is the number of taps, which is either 2 or 8

n k is the tap index, ranging from 0 to N

n Ck are the coefficients, or tap values

n T is the time delay for each of the delay elements (nominally 1/bitrate)

Take care to have the nominal bit rate set correctly. The bit rate is configured on the Signal Input dialog.

Click the Emphasis button on the Eye Doctor II dialog to access the Emphasis dialog. Check Enable to
apply the Emphasis settings to the input signal.

Use Auto Add Pre-/De-Emphasis to add pre-emphasis or de-emphasis to a signal that is not emphasized
in order to emulate the behavior of a transmitter that nominally includes emphasis. The feature
implements a 2-tap FFE filter that boosts the amplitude of transitional bits in your input signal by the
amount of Gain specified.
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Auto Remove Pre-/De-Emphasis implements an 8-tap FFE filter that either attenuates or boosts the
amplitude of transitional bits in your input signal input signal by the Gain amount specified. Use this
feature when seeking to make jitter and noise measurements on emphasized signals that have not been
"naturally" de-emphasized by passing through a channel.

Custom emphasis allows you to enter up-to-8 tap values for a custom FFE tapped delay line filter.

Emulate / De-embed
With the Emulate / De-embedding feature, you can use Touchstone files to model fixtures and channels in
the circuit for the purpose of seeing what effect they (or their removal) have on the signal.

Channel Emulation / De-embedding allows you to to move the reference for your measurement to a
different point in your system—either after a serial data channel by emulating the channel effects or
before a serial data channel by de-embedding the channel (similar to fixture de-embedding).

Fixture De-embedding allows you to move the reference for your measurement to a point before the
fixture (such as directly to the transmitter output) by removing the effects of the fixture.

Emulate / De-embed Dialog
Use the Emulate / De-embed dialog to choose a configuration, which represents the type and order of
emulation and de-embedding processes to apply to the signal. The combination of the configuration plus
the actual settings on each of the process blocks determines the effect on the signal.

Also use this dialog to apply your Emulate / De-embed configuration. Apply builds the system description
for the circuit and compiles it. The "LED" indicator next to the Apply button shows the compilation status.
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Set Up Emulation/De-embedding

1. Click the Emulate / De-embed block on the Eye Doctor II dialog.

2. Select Enable to turn on the Emulate / De-embed function.

3. Choose a Configuration. See below.

4. Specify a Bandwidth Limit (see below) or select the Auto BW feature to allow the software to
determine the limit. Bandwidth Limit is only required if the configuration includes de-embedding.

Note: If you choose to Emulate Channel / De-embed Fixture, but leave the De-embed
Fixture block set to "Ideal" (pass through), the bandwidth limit has no effect on the signal.

5. Click the Fixture and Channel blocks that appear in the flow to define their properties. See Fixture
and Channel Dialog.

6. When you have completed the setup for each block in the configuration, click Apply. 

After applying, the indicator next to the Apply button turns:

l Green if everything is properly setup.

l Red if something is wrong with either the S-parameter file or port assignment. Use the View
Response functionality to help debug your issue.

l Yellow if the settings have changed and recompiling is needed.

Note: Any time you change Emulate / De-embed settings, click Apply again. This is required to
recompile the new process.
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Configurations

Emulate Channel / De-embed Fixture
Emulate Channel / De-embed Fixture de-embeds a fixture and emulates a serial data channel at the same
time. This is used when you are using a fixture to measure at the transmitter side of the serial data
channel. It first moves the measurement reference to the output of the transmitter, and then moves the
reference to the far side of a serial data channel. This allows for emulating the effects of the serial data
channel on your signal with the fixture effects removed.

De-embed Channel / De-embed Fixture
De-embed Channel / De-embed Fixture de-embeds a fixture and de-embeds a serial data channel at the
same time. This is used when using a fixture to measure at the receiver side of the serial data channel. It
moves the measurement reference back to the output of the transmitter. You then see what the serial
data signal looked like at the transmitters output with the effects of the channel and fixture removed.

De-embed Fixture Only
De-embed Fixture Only removes the fixture effects from you measurements. You can then see what the
serial data signal looked like at the transmitters output with the effects of the fixture removed.

Bandwidth Limit
When de-embedding a fixture or channel, a bandwidth limit is required and must be set.

Bandwidth Limit imposes a reasonably sharp low pass filter in addition to the S-parameter system
response. This is useful when de-embedding a lossy channel, to limit the amount of boost applied. When a
channel is de-embedded, high frequency response must be boosted to compensate for the high
frequency attenuation in the channel. However, if the signal has been attenuated into the noise floor,
boosting the signal on the oscilloscope makes it impossible to distinguish between the signal and the
noise. The system boosts the noise along with the signal. The Bandwidth Limit setting can limit the overall
response to the lower frequencies where signal components are detectable above the noise. If this value
is set to zero (the default) then no bandwidth limit is applied.
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Auto BW and Max Boost have the same effect as Bandwidth Limit, but instead of setting the bandwidth,
you set the maximum boost allowed. Eye Doctor II looks at the S-parameter responses and sets up the
low pass filter at the frequency where one of the outputs has more boost than the specified Max Boost.
Max Boost can be set between 3 dB and 20 dB. The bandwidth in use is reported back to the user.

Note: When emulating a passive fixture or channel, the S-parameter system does not have any
boost, and the bandwidth in use is the highest bandwidth possible.

Fixture and Channel Dialogs
Use the Fixture and Channel dialogs to emulate the properties of the fixture or channel by uploading and
mapping S-parameter Touchstone files. These dialogs have identical functionality and differ only in name,
depending on whether you are setting up a fixture or a channel block in the Emulate/ De-embed
configuration. You will see the single-ended or differential version of the dialog based on how the inputs
were defined on the Signal Input dialog.

Differential input version of the Channel dialog. The Fixture dialog differs only in name.

Note: S-parameter files should cover a frequency range up to (at least) 1/2 the acquisition sample
rate. For example, if the S-parameter file only covers up to 10 GHz, then the acquisition sample
rate should be 20 GS/s. When the fixture or channel is being emulated, there is little effect.
However, if the fixture or channel is being de-embedded, then the S-parameter matrix must be
inverted, which can be problematic if there is insufficient sample rate. This requirement is
particularly important when de-embedding. For more information about file preparation and
interpretation, see Touchstone File Format.

Configure Fixture/Channel

1. To configure a perfect fixture or channel with no loss, check Use Ideal Fixture/Channel. This
eliminates the fixture or channel from the process (it has no effect on the signal), even if it appears
in the configuration flow. No further configuration is necessary.

To configure a fixture or channel with specific properties, click Browse and navigate to the
Touchstone file representing the fixture or channel.

2. Choose the S-parameter Format of either Single-Ended or Mixed Mode.
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3. Assign to each Port a data column from the selected Touchstone file. (This is useful for re-
mapping from the same S-parameters.)

4. Click Apply to build the configuration. Check the status of the file mapping. The indicator next to
the Apply button should be green.

5. Use View Response to plot the characteristics of the S-parameters.

View Response
The View Response button on the Fixture and Channel dialogs enables you to generate a magnitude or
phase plot for a single S-parameter once you have imported and mapped the file.

1. For 4 port S-parameter files, choose to view either the Single-Ended or Mixed Mode (differential) S-
parameters by selecting from the View Mode control.

2. Choose which S-parameter from the original file to view.

3. Choose to view the Magnitude or Phase of that S-parameter.

Tip: To zoom the S-parameter plot currently displayed, create a Zoom math function using the
EDrResp waveform as the source. This enables you to view the S-parameter plot on the full grid
and set cursors on the trace.
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Equalizer
Eye Doctor II includes Continuous Time Linear Equalizer (CTLE), Feed Forward Equalizer (FFE) and
Decision Feedback Equalizer (DFE) capabilities in addition to its Emphasis feature (referred to as
transmitter equalization.)

Equalizers can be specified by tap delay, number of taps and tap coefficients, or they can be automatically
trained to optimize settings utilizing blind adaptation.

Each equalizer can be independently enabled or disabled, however, the data signal path is fixed. The signal
can pass through:

l Only the DFE (which may be off, in which case the signal is unchanged)

l First through the CTLE, then the DFE

l First through the CTLE, then the FFE, and finally the DFE

Equalizer Dialog
To apply equalization techniques to the input signal, click the Equalizer block on the Eye Doctor II dialog.

The Equalizer dialog shows the order in which equalization processes are applied to the input signal,
based on your data path selection.

The flow diagram shows the data signal path (red) and the recovered clock path (blue) utilized by the equalizers.

First, choose the Data Path to DFE. This setting determines which of the three possible paths the data
signal takes through the equalization process:

l From Eq Input: skips right to the DFE; only DFE is applied to data, although CTLE and FFE may be
applied to the clock

l From CTLE: passes through CTLE, then from CTLE to the DFE

l From FFE: passes through CTLE to FFE, then from FFE to the DFE

Note: Even if included in the data path, the equalizer must also be enabled on the respective setup
dialog to be applied to the signal.

Open the respective CTLE, FFE, Clock Recovery and DFE dialogs that are in the selected Data Path.
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For FFE and DFE, you may choose to allow the software to train FFE & DFE, rather than configure these
equalizers manually. First, complete the FFE and DFE training algorithm settings on the respective setup
dialogs. Then, when you click the Train FFE & DFE button, the training algorithm is run on the input signal
and finds the optimal tap settings and bit rate for clock recovery.

After processing, the EyeDrOut waveform shows the results of equalization on the input signal. EyeDrClk
shows the recovered clock waveform.

Continuous Time Linear Equalization (CTLE)
A first order Continuous Time Linear Equalizer (CTLE) is implemented in your Eye Doctor II software. The
reference equalization algorithm for PCI-Express 3.0 and for SuperSpeed USB is a first order CTLE. 

CTLE is defined by DC Gain and the placement of two or three Poles and one Zero. The default settings for
DC Gain and Boost used in the Eye Doctor II implementation are the settings for SuperSpeed USB.

Enabling CTLE

1. Access the CTLE Setup dialog by clicking the CTLE block on the Eye Doctor II Equalizer dialog.

2. Check Enable.

3. Choose to use the Auto CTLE setup, which automatically sets the DC Gain and Boost to the
specification for the selected Standard, or a Custom CTLE setup.

4. For Custom CTLE, click the Edit / View CTLE Setup button to make the CTLE settings.

CTLE Details
Auto CTLE users can modify the DC Gain.

Custom CTLE users can also define the Number of Poles, Pole # Frequency and Zero Frequency.
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CTLE Response
This graph shows the response of the CTLE response for SuperSpeed USB. Eye Doctor II uses these
setting as the default for the CTLE.
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Feed Forward Equalization (FFE)
The Feed Forward Equalizer (FFE) is implemented as a tapped delay line filter, with 1 tap per unit interval.
An FFE can compensate for Inter-Symbol Interference (ISI) due to preceding and following bits. For details
on the algorithm for the FFE filter, see FFE Filter Algorithm.

Both the FFE and the DFE can automatically train, or find their own tap values. The Train FFE & DFE button
on the main Equalizer dialog first trains the FFE, finds the bit rate (shown on the Clock Recovery dialog),
and then trains the DFE, including clock phase adjustment.

Enabling FFE
Access the FFE Setup dialog by clicking the FFE block on either the Eye Doctor II Equalizer dialog.

To apply the FFE to the signal, check Enable in the in the Feed Forward Equalizer (FFE) section of the FFE
Setup dialog.

Training FFE
Eye Doctor II includes a training algorithm that determines the optimal tap values to use in the FFE filter.
The method used is the Levenberg–Marquardt algorithm. The variable that is minimized is the range of
the high and low voltages near the center of the eye. Minimizing this quantity maximizes the eye opening.

1. Enter a Number of Taps to span the number of UIs the signal takes when settling to a final value
after a transition. The training algorithm will create a filter with the number of taps entered.

2. Specify how many of those taps should be precursor taps in # Precursor Taps.

Note: The number of precursor taps is often around half of the total number of taps.

3. Enter the Upper Level and Lower Level voltage at which to place the equalized eye.

You may alternatively Auto find levels. When selected, the algorithm will find the upper and lower
levels of the equalized eye as well as the decision level to use. The voltage levels of the minimized
locations of high and low states will tend to match the outmost voltage levels of the unequalized
eye.

4. Check Include In Training to include the FFE in the training whenever the Train FFE & DFE button on
the Equalizer or Linear EQ dialog is pressed. The Train FFE button on this dialog handles only FFE.
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The ability to exclude the FFE from training is particularly useful when custom FFE tap values have
been entered (as retraining would undo these settings), but you wish to continue training DFE.

5. Click the Train FFE button to begin the FFE (only) training process.

6. Click Edit/View DFE Setup following the training to view and modify the FFE tap values that were
set on the FFE Details dialog.

FFE Details
While the best way to use the FFE is to train it, you can also enter the exact tap weights (if known) on the
FFE Details dialog. Click the Edit/View FFE Setup button to display it.

Specify the # Taps Usedin the FFE filter and the # Precursor Taps. If you began your setup by training the
FFE, these controls show the values set on the FFE Setup dialog. Changing values in either place updates
them everywhere. Enter the tap coefficients on each row.

The Clear Taps button sets all the taps to 0 except for the first tap which is set to 1. This is the pass-
through state for the FFE.

FFE Filter Algorithm
Feed-forward equalization is implemented as a tapped delay-line filter, with the 1 tap per unit interval. The
filter is mathematically described as follows:

Where:

n yin(t) is the initial waveform

n yout(t) is the transformed waveform

n N is the number of taps

n P is the number of precursor taps

n k is the tap index, ranging from 0 to N

n Ck are the coefficients, or tap values

n T is the time delay for each of the delay elements (nominally 1/bitrate)
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Depending on whether you have chosen to include precursor taps, the FFE filter can introduce a delay in
your output waveform. The training algorithm seeks to find a solution for the tap values that retains the
edge position, but note that when manually creating tap values, the output waveform can be advanced by
adding precursor taps.

FFE processing diagram.

The following illustration shows how FFE is calculated. The training algorithm was used to generate an
FFE with 4 taps and 1 precursor tap . The illustration shows how FFE can be understood as the
summation of waveforms. Since there are 4 taps in this example, 4 waveforms will be summed. Each
waveform is shifted by a multiple of T, which is equal to the nominal unit interval time. Since 1 precursor
tap was used, waveforms are created with shifts of -T, 0, T and 2T. Each waveform is then multiplied by
the corresponding tap value, and the waveforms are summed. The illustration shows the calculation for
one point (red circle).
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Illustration of an FFE filter with 4 taps, including 1 precursor tap
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Decision Feedback Equalization (DFE)

Enabling DFE
Access the DFE Setup dialog by clicking the DFE block on the Eye Doctor II Equalizer dialog.

To apply the DFE to the input signal, check Enable in the in the Decision Forward Equalizer (DFE) section
of the DFE Setup dialog.

DFE requires a clock, which Eye Doctor II recovers from the data after CTLE and/or FFE. If DFE is enabled,
you may have to enable one or both of CTLE and FFE to make sure Clock Recovery can accurately recover
a clock.

Training DFE
Eye Doctor II includes a training algorithm that determines the optimal tap values to use in the DFE filter.
The method used is the Levenberg–Marquardt algorithm. It functions exactly like the FFE training
described above.

Result on eye diagram of training FFE and DFE .

The variable that is minimized is the range of the high and low voltages near the center of the eye, as
shown in the following figure. Minimizing this quantity maximizes the eye opening.
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DFE Details
While the best way to use the DFE is to train it, you can also manually enter the exact tap weights (if
known) on the DFE Details dialog. click the Edit/View DFE Setup button to display it.

Specify the # Taps Used in the DFE filter. If you began your setup by training the DFE, this shows the value
set on the DFE Setup dialog. Changing the value in either place updates it everywhere. Enter the tap
coefficients on each row.

The Clear Taps button sets all the taps to 0. This is the pass-through state for the DFE.

The Deskew control can be adjusted manually or left at the optimized setting when the DFE is trained.
The Deskew time plus 1/2 of a unit interval is the point at which the decision is made for the decision
feedback equalizer. This is the same setting as the Deskew control on the Clock Recovery dialog.

DFEs are prone to burst errors (meaning, once errors are created, they run for a long time). The DFE's
propensity to create burst errors is based on the effectiveness of the DFE to aid in the accurate decoding
of bits, which depends on its ability to accurately decode bits - a case of circular logic. Depending on the
strength of DFE applied, a single bit error may lead to a long run of errors. Erasure DFE is used for this
problem and improves the situation. Erasure DFE effectively sets a band around the threshold value.
When the signal falls inside the band at the time of slicing, it indicates an uncertainty in the bit decoding.
The receiver, although obliged to decode the bit, can then decide not to apply this bit to the decision
feedback, since the decoding was not certain enough. In operation, if erasure DFE is utilized and the signal
is within the voltage delta about the threshold specified, a voltage value that is the average of the ideal +1
and -1 values is applied to the DFE delay taps, thus causing the bit to have no effect on decision feedback.

The Erasure DFE feature excludes certain bits within the specified Erasure Delta from the decision
feedback. Use the Erasure Delta control to set the indecision band around the DFE threshold.

151



WavePulser 40iX High-speed Interconnect Analyzer User Manual

Clock Recovery
Clock Recovery is provided within the equalizer section of Eye Doctor II, where it is used for DFE
calculations.

Clock Recovery dialog when working in Eye Doctor II.

Data or Bit Rate
When entering the Clock Recovery dialog, the Data or Bit Rate is the nominal bit rate set on either
Equalizer dialog or the Signal Input dialog. DFE requires a more precise bit rate than the Emphasis or FFE
algorithms. The Find Rate button calculates the bit rate from the input signal.

Check Include In Training to include the bit rate calculation whenever the FFE and DFE training algorithm
is run. It may be useful to exclude it if you have modified the Nominal Bit Rate as part of the FFE or DFE
Detail configuration and wish to retain that value.

PLL Setup
This section contains the controls for setting the type and bandwidth of the digital PLL used to produce
the recovered clock (EyeDrClk) for DFE. The PLL has a low pass filter response; it tracks variations in the
data rate that occur below a certain frequency, determined by the PLL bandwidth setting. For example, a
PLL bandwidth of 5 MHz allows the recovered clock to track frequency variations below approximately
half this frequency, thereby removing their effect from jitter and eye pattern measurements.

A PLL is applied to the data stream when PLL On is checked.

A variety of industry-standard software PLL Types are available for selection. Configure any additional
settings that appear on the PLL subdialog to the right of the display.

Deskew
The Deskew value becomes enabled when either a reference clock is in use or when DFE is enabled. In
either of these circumstances, eye diagrams can become shifted with respect to the recovered clock such
that the eye crossings will not be positioned at divisions 2 and 8. This can result in masks not being in the
optimal position horizontally. Use the Deskew setting to shift the eye as desired within the grid.

The Deskew value can be adjusted manually here or left to the optimized setting whenever the DFE is
trained. The Deskew time plus 1/2 of a unit interval is the point at which the decision is made for the
Decision Feedback Equalizer.

Select the Show checkbox to display the EyeDrClk waveform.
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Eye Doctor Outputs
The processed waveforms output by Eye Doctor may be used as inputs to SDA processes, or as the
source for WavePulser standard toolkit math and measurements. Output waveforms appear in the
Eye Doctor II submenu of the Select Source dialog.

Note: While all Eye Doctor outputs are available as inputs to standard math and measurements,
only EDrOut and EDrClock are available as inputs to SDA II processes.

Waveform Shows

EDrInP The selected positive input signal (Input1)

EDrInN The selected negative input signal (Input2)

EDrIn The calculated (Input1-Input2) or probed differential input signal.

EDrEmpP The positive input signal after the addition of Emphasis.

EDrEmpN The negative input signal after the addition of Emphasis.

EDrEmp The calculated or probed differential signal after the addition of Emphasis.

EDrChP The positive input signal after emulation/de-embedding.

EDrChN The negative input signal after emulation/de-embedding.

EDrCh The calculated or probed differential input signal after emulation/de-embedding.

EDrCTLE The calculated or probed differential signal after CTLE equalization.

EDrFFE The calculated or probed differential signal after FFE equalization.

EDrOut The differential signal following all processing performed by Eye Doctor II.

EDrClock The recovered clock signal.

EDrResp The last S-parameter file viewed (View Response) during emulation/de-embedding.
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Save / Recall
The Eye Doctor II Save/Recall function allows you to save all your current Eye Doctor settings to an .LSS
file, which can be easily recalled in the future.

To open the Save/Recall dialog, click the Save/Recall button on the Eye Doctor II dialog.

To save the current setup, click Setup File Name and use the popup keyboard to enter a new filename,
then click Save Setup. Files are saved in C:\WavePulser\Applications\EyeDr.

To reload a previously saved setup, Browse to and select the file, then click Load Setup.

The default setup is EyeDr.lss. Choose Recall Default to reload this file.
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SDA II Software
The Serial Data Analysis (SDA) software provides comprehensive measurement capabilities for evaluating
high-speed serial data signals. Signal Integrity Studio includes the full suite of SDA II single-lane eye and
jitter analysis capabilities.

SDA II software operates by rapidly processing a long signal acquisition or simulated signal. All eye, jitter
and noise views are based on comparisons of the arrival times of the signals edges to that of the
underlying clock, which is determined either via a software clock recovery algorithm or by measurement
of a provided clock signal.

For best results, acquisitions should be long enough to include at least 100,000 UI of the signal under test
(500,000 UI or more is optimal). By using long acquisitions, users can calculate the best statistics and be
able to measure low-frequency periodic jitter components.

Accessing SDA Software
Access SDA by choosing Analysis>Serial Data from the menu bar.

The Serial Data Analysis II dialog that appears at the bottom of the screen shows the overall flow for
viewing and analyzing serial data. Each block in the flow diagram is a button that, when touched, displays
its corresponding dialog.

SDA II Workflow
Each block in the Serial Data Analysis II dialog flowchart is a button that, when clicked, displays the
corresponding configuration dialog.

SDA framework shows software workflow

Enable SDA is checked by default. Deselecting it will disable analysis and turn off all views.

Quick View button opens the Quick View to configure inputs.

Caution: Using Quick View will clear the current configuration and apply the configuration made
within the Quick view window.

Input Signal
Signal Input button opens the Signal Input dialog, which is used to configure the data source(s), crossing
level and signal type, and to enable the display of signal that "flows" to the Emphasis block of the SDA
flowchart.
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Signal Conditioning
Emphasis button opens the Emphasis dialog, which is used to configure pre-emphasis/de-emphasis
settings for the signal that flows from the Signal Input(s) block.

De-embed/Emulate button opens the Emulate/De-embed dialog, which is used to configure fixture and
channel de-embedding/emulation using either the Eye Doctor II or the Virtual Probe capabilities.

Linear EQ button opens the Linear EQ dialog, where you can apply Continuous Time Linear Equalization
(CTLE) or Feed Forward Equalization (FFE).

DFE button opens the Decision Feedback Equalizer (DFE) configuration window.

Clock
Clock Recovery Source switch is an unlabeled button located immediately to the left of the Clock
Recovery button. When using an explicit reference clock, set the Clock Recovery Source switch to the
"Blue" position to enable the Ref Clock Input button. In this position, the clock recovery algorithm uses
transitions of the reference clock input. When set to the "Red" position, SDA will perform a software clock
recovery using edges from the signal flowing out of the Linear EQ block. In either position, the settings
configured on the Clock dialog are utilized.

Clock Recovery button opens the Clock dialog.

Ref Clock button opens the Ref. Clock dialog for configuring the source and other attributes of an explicit
reference clock signal.

Views and Measurements
These capabilities allow you to visualize the signal after all prior processing has been applied.

Eye Meas. button opens the dialog for configuring Eye diagrams.

Jitter Meas. button opens the dialog for configuring Jitter measurements.
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Quick View
With only minimal configuration, the Quick View shows the eye diagram, TIE track, bathtub curve, jitter
histogram, NQ-scale, and jitter spectrum (with peaks annotated) in a single, summarized view.

You need only specify the input signal for analysis to generate the Quick View. You can optionally also
specify the crossing level. click the Quick View button on the Serial Data Analysis II dialog to start.

Quick View display.

Use the Signal Input dialog and the Clock Recovery dialog to refine the Quick View inputs.
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Signal Input
On the Serial Data Analysis II dialog, click the Setup Signal Input button to access the Signal Input dialog.

Serial Data Inputs
If you are using a differential probe or if your signal is connected by one coaxial cable, use the 1 Input (or
Diff. Probe) button and select the input source.

If you have a differential signal transmitted on two two coaxial cables or two single-ended probes, use the
Input1-Input2 button and select the input channels used.

Note: There is no need to configure a math function to calculate the difference between to inputs.
Doing so adds computational steps and unnecessarily uses RAM.

Any Math function or Memory trace can be used as an input, as well as any channel. When in Input1-
Input2 mode, or when using traces that are the result of other processing steps (such as a Math function),
be sure that both traces have the same record length and sample rate.

You can choose to Upsample by a factor of two in order to provide a higher sample density for analysis. In
the past, this was typically done to facilitate formation of eye diagrams without gaps for bit rates integrally
related to the sampling rate (for example, 20 GS/s is exactly eight times 2.5 Gb/s), and especially for
relatively short acquisitions. However, this is now unnecessary to remove gaps in the eye. Instead, use the
Upsample control on the Eye Diagram dialog.

Select Show SDA Input Signal at the far right of the dialog to display a waveform trace (versus eye
diagram) of the "raw" input signal (without any of the SDA signal processing).

Note: The input trace will be affected by any math or channel pre-processing applied.

Crossing Levels
Choose a Level Type of either Absolute volts (or watts for an optical signal) or Percent amplitude.

l If Percent, click Pct Level and enter the percent of amplitude between base and top that marks the
crossing threshold.

l If Absolute, click Abs Level and enter the voltage level that marks the crossing threshold.

Alternatively, click the Find Level button to allow the software to determine the crossing level. The level is
found by locating the midpoint between the highest and lowest signal levels in the current acquisition.
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To minimize the effects of noise, enter a Hysteresis value. The default hysteresis band is 500 mDiv (half a
division), centered on the crossing threshold. Edges that fail to transit the entire hysteresis band are not
detected.

Signal Type
In Signal Type, choose the signal encoding scheme. This selection automatically sets the Nominal Rate
specified by the standard and populates the Mask Type selector in the Eye dialog.

When using a Custom Signal Type, always enter the bit rate in Nominal Rate. Using an incorrect Nominal
Rate can lead to incorrect equalizer results, since this value is used by several of the equalizers that are
available the oscilloscope.

Also enter the Nominal Rate when setting up a Clock signal. Click Slope (under Signal Type) and select the
edge used for clocking.

Clock
Eye, jitter and vertical noise analysis all require a clock that defines the boundaries of each unit interval.
Additionally, the clock is used to determine the difference between actual and expected arrival times of
data edges (i.e., the Time Interval Error, or TIE measurement).

In many of today's high-speed serial standards, the clock is not a physical signal but is instead recovered
from the data signal via hardware or software. The software includes an algorithm that recovers the clock
from the data signal without the need for an external trigger or clock recovery hardware.

You may use a PLL as part of the clock recovery algorithm in order to best emulate the PLL in a receiver.
The recovered clock is defined by a list of times that correspond to expected edge arrival times.

To access the Clock dialog, select the Clock Recovery block on the Serial Data Analysis dialog.

Clock Set Up
The recovered clock is defined by the times at which the specified signal (either data or reference clock)
crosses the specified threshold. Starting with zero, the clock edges are computed at specific time
intervals relative to each other. A 2.5 GHz clock, for example, will have edges separated in time by 400 ps.

Bit Rate
Enter the expected Data or Bit Rate, or click the Find Rate Now button to automatically find the bit rate
from the signal. If you do neither, this field remains set to the standard's nominal bit rate.

Reference Clock
Rather than used the software recovered clock, you can choose to input an external reference clock
signal. Check Use Explicit Clock Ref to define a reference clock signal. This checkbox serves the same
function as the multiplexer switch on the Serial Data Analysis dialog and activates the Ref. Clock dialog.
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The Deskew value becomes enabled when either a reference clock is in use or when DFE is enabled. In
either of these circumstances, eye diagrams can become shifted with respect to the recovered clock such
that the eye crossings will not be positioned at divisions 2 and 8. This can result in masks not being in the
optimal position horizontally. Use the Deskew setting to shift the eye as desired within the grid.

The Deskew value can be adjusted manually here or left to the optimized setting whenever the DFE is
trained. The Deskew time plus 1/2 of a unit interval is the point at which the decision is made for the
Decision Feedback Equalizer.

To use the Eye Doctor II recovered clock within SDA II:

1. On the Clock Recovery dialog, select Use Explicit Clock Reference.

2. Turn off the PLL by clearing the PLL On checkbox. (A PLL has already been used to recover the
clock during the Eye Doctor II Clock Recovery process).

3. On the Ref. Clock dialog, set the mode to Clock + Only.

4. Set the Clock Ref + value to EDrClock.

Note: We strongly recommend that you use the Eye Doctor II output waveform, EyeDrClk, as the
explicit clock reference waveform in SDA II in order to properly analyze an unequalized signal. SDA
II cannot recover a clock from a severely degraded signal; Eye Doctor II must recover the clock
after equalizing the signal, and SDA II must use EyeDrClk to show the nearly closed eye.

PLL Setup
The PLL Setup controls set the type and bandwidth of the digital phase-locked loop used in
measurements. The PLL bandwidth limits the response of the recovered clock to high rate variations in
the data rate. For example, depending on the type of PLL, a PLL bandwidth of 5 MHz will allow the
recovered clock to track frequency variations below approximately half this rate, thereby removing their
effect from jitter and eye pattern measurements. Configure this section to match the behavior of the
receiver's PLL.

To utilize a PLL, select PLL On and choose a PLL Type. Go on to configure the PLL settings on the
subdialog that appears.

When BW Indep of Data is selected, the PLL algorithm will keep track of the "local" transition density by
tracking the number of UI between edges, and use this information in addition to the last edge's phase
difference in determining the amount of error to feedback into the control loop. This allows the clock
recovery algorithm to track the underlying clock when in the presence of varying transition densities. The
result is that the PLL will implement the configured PLL bandwidth, even if the local transition density
varies significantly from its average value. Use this setting when you want the clock recovery to model a
receiver that uses a PLL which compensates for varying transition density.

Clock Recovery Implementation Using a PLL
Clock recovery implementation when using a PLL is shown in the following figure. This algorithm
generates time values corresponding to a clock at the data rate. The computation follows variations in the
data stream being tested through the use of a feedback control loop correcting each period of the clock
by adding a portion of the error between the recovered clock edge and the nearest data edge.
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Clock Recovery Using a PLL

The first step in creating a clock signal that is tracked by a PLL is to create a digital phase detector. This is
simply a software component that measures the location in time when a signal crosses a given threshold
value. Even given the maximum sampling rate available, interpolation is necessary in order to accurately
determine crossing times. Interpolation is automatically performed by software. Interpolation is not
performed on the entire waveform; rather, only the points surrounding the crossing level are interpolated.
A cubic interpolation is used, followed by a linear fit to the interpolated data to find the precise time that a
data signal edge traverses the crossing level (see figure below).

Edge Time Determination

As shown in the first image, the initial output and the output of the digital phase detector are set to zero.
The next time value output is equal to the nominal data rate. This value is fed back to the comparator on
the far left which compares this time value to the measured time of the next data edge from the digital
phase detector. The difference is the error between the data rate and the recovered clock, and can also
incorporate the measurement of the number of UI's since the last edge (that is, the local transition
density).This difference is filtered and added to the initial base period to then generate the corrected clock
period. The filter controls the rate of this correction by scaling the amount of error fed back to the clock
period computation. The choice of filter includes a single-pole infinite impulse response (IIR) low-pass
filter (the Golden PLL, as defined by FiberChannel), a 1-pole 1-zero filter, and a 2-pole 1-zero filter. The
equation of the golden PLL 1 pole filter is:
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The value of yk is the correction value for the kth iteration of the computation and xk is the error between
the kth data edge and the corresponding clock edge. Notice that the current correction factor is equal to
the weighted sum of the current error and all previous correction values. The multiplier value is set to one
in the SDA, and the value of n is the PLL cutoff divisor set from the Golden PLL dialog. The cutoff
frequency is Fd/n, where Fd is the data rate. This filter is related to its analog counterpart through a design
process known as impulse invariance and is only valid for cutoff frequencies much less than the data rate.
For this reason, the minimum PLL cutoff divisor setting is 20 in the SDA.

The factor n determines the number of previous values of the correction value y used in the computation
of the current correction value. This is theoretically infinite; however, there is a practical limit to the
number of past values included.

PLL Types
FC Golden
FC Golden is the default selection and implements the golden PLL as defined in the FiberChannel
specification. By default, the golden PLL is set to a cutoff frequency of 1/1667 times the bit rate of the
signal under test. This ratio can be adjusted from 1/10 to 1/1e6.

Cutoff Divisor is the value by which the bit rate is divided to compute the cutoff frequency for the loop
bandwidth of the clock recovery operation for sequential eye pattern, jitter, and bit error rate functions.
This control is variable from 10 to 1,000. A low PLL cutoff divisor means the PLL tracks and, therefore,
attenuates jitter at higher frequencies.The default value of 1667 causes the clock recovery to operate as a
golden PLL, as defined in the Fibrechannel specification. The default value of 1667 is the industry
standard for a Golden PLL and equals the ratio of the Bit Rate to the PLL Cutoff frequency.

PLL Cutoff reads the frequency corresponding to the Cutoff Divisor. Alternatively, you may enter a PLL
Cutoff frequency and the nearest cutoff divisor is then computed from the entry.

DVI PLL
The DVI PLL selection follows the requirements of the DVI (Digital Video Interactive) and HDMI (High
Definition Multimedia Interface) specifications. These specifications call out a clock recovery function
having a single-pole PLL loop response with a cutoff of 4 MHz.
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FB-DIMM PLL
The FB-DIMM PLL selection applies a filter that replicates Fully-buffered DIMM.

Custom PLL
In Poles, choose either a first- or second-order loop response. The first-order response allows you to enter
a Pole Frequency that sets the PLL cutoff and a Zero Frequency that must be higher than the pole
frequency that limits the stop-band attenuation.

A second-order PLL allows you to enter the Natural Frequency and Damping Factor.
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The damping factor determines the transient behavior of the phase locked loop and is variable from 2 to
0.5.

l A damping factor above 0.707 results in an under-damped response and the PLL is over-corrected to
a sudden change in frequency; however, reacts quicker to the change.

l A damping factor below 0.707 provides an under-damped response that reacts more slowly to
sudden changes in frequency; however, does not over-correct.

The default value of 0.707 represents a critically damped response that provides the fastest reaction time
without over-correcting.

The second-order PLL with a damping factor of 0.707 is specified in the serial ATA generation II
document. This type of PLL is also very useful for measuring signals with spread-spectrum clocking
because it can accurately track and remove the low-frequency clock spreading while allowing the signal
jitter to be measured. The natural frequency is somewhat lower than the actual 3 dB cutoff frequency
given by the equation:

The quantity is the damping factor, and is the natural frequency. For a damping factor of 0.707,
this relationship is fc = 2.06 fn.

Reference Clock Dialog
When an explicit reference clock is used, the clock is defined from the location of the reference clock
signal's crossing points at the specified edge. Starting with zero, the clock edges are computed at specific
time intervals relative to each other.

Select Ref. Clock Input block on the Serial Data Analysis dialog to display the Ref. Clock Input dialog.
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Tip: If Ref. Clock is disabled, click the multiplex button next to the Clock Recovery block to enable
it.

Clock Inputs
If using a single source or a differential probe, click the 1 Input button, then click the Input1 field and
choose the source.

If using two sources, click the Input1-Input2 button, then click the Input1 field and from the Select Source
window choose the source for the first input. Repeat for the Input2 field.

To increase the sampling rate of the signal, click the Upsample by field and enter the upsample factor.
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Crossing Level and Slope
Choose a Level Type of either Absolute volts or Percent base-top amplitude, then enter the Level to use.
The crossing time used by both the jitter and eye pattern measurements is determined as the time at
which the clock level crosses the specified threshold.

Alternatively, touch the Find Level button to allow the software to determine the crossing level. The level is
found by locating the midpoint between the highest and lowest signal levels in the current acquisition.

To specify the signal edge used for clocking, click Clock Slope and choose Positive, Negative, or Both.

To fine-tune the skew between the clock signal and the data signal, click Deskew and adjust the value.

To upsample the reference clock signal, click Clock Multiplier and adjust the value.

Example: A 2.5 GHz clock has edges separated in time by 400 ps. Making a 2.5 GHz clock from a
100 MHz reference clock requires setting the Multiplier to 25.
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Eye Analysis
Open the Eye tab or click the Eye Meas. block on the SDA dialog to access the Eye dialog.

Be sure to select Enable Eye Meas. to turn on the eye diagram functionality.

Note: If you deselect this checkbox, the eye diagrams are turned off, although your eye
configuration remains in place.

Eye Mode
Choose an Eye (creation) Mode:

Single Eye overlays all the UIs from all acquisitions.

Dual Eye Transition/Non-Transition divides the signal's UIs into two separate eyes: one comprised of UIs
starting with a transition and one comprised of UIs without. The PCIe standard refers to these as
Transition and Non-Transition eyes. This display mode is useful for those serial data standards using
mask testing for both types of eyes (e.g., PCI Express and FB-DIMM Point-to-Point).

DualEyeGated (Qualified) mode uses a separate gating signal to create dual eye diagrams based on the
polarity of the gate.

DualEye FSB (Front Side Bus) operates similar to Sequence mode acquisition, but divides the results into
two separate eyes based on which pair of signals occurred first.With this option, also make an Edge
Selection and specify which is the FSB Write signal.

Show Eye displays the eye diagram(s). When deselected, the eye plot is turned off.

Using all the available vertical scale increases measurement accuracy. Use the Vertical Auto Fit checkbox
to fit the eye diagrams to the height of the grid.

Eye Diagram Subdialog
Show Eye displays the eye diagram(s). When deselected, the eye plot is turned off.

Show IsoBER superimposes the IsoBER plot over the eye diagram. Mask testing is not always the best
way to determine whether a signal is going to meet Bit Error Rate requirements. It often lacks quantitative
analysis of vertical noise and jitter. IsoBER analysis provides this quantitative analysis by extrapolating the
eye diagram data and displaying the lines of BER directly on the eye. This helps to quickly determine the
minimum eye opening and detect cross-talk by analyzing vertical eye closure. In from/to/step, enter the
range of BER values for which you would like to show contours in the ISOBer plot.

Note: The IsoBER is calculated using the same algorithm used for the Crosstalk Eye.
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Eye diagam with ISOBer superimposed

The Eye Style may utilize color-graded or analog persistence:

l

With color-graded persistence , pixels are given a color based on the pixel's relative population
and the selected Eye Saturation. The color palette ranges from violet to red.

l

With analog persistence , the color used mimicks the relative intensity that would be seen on an
analog oscilloscope.

Use the Eye Saturation slider to adjust the color grading or intensity. Slide to the left to reduce the
threshold required to reach saturation.

The Upsample factor increases the number of sample points used to compose the eye diagram. Increase
from 1 to a higher number (e.g. 5) to fill in gaps. Gaps can occur when the bitrate is extremely close to a
submultiple of the sampling rate, such that the sampling of the waveform does not move throughout the
entire unit interval. Gaps can also occur when using a record length that does not sample a sufficiently
large number of unit intervals. (Using record lengths of >= 1 million points is recommended in order to
acquire tens of thousands, if not hundreds of thousands, of unit intervals.)

If you are testing the eye diagram against a mask, select Show Mask to turn on the mask overlay. Select
Show Failures to mark the points on the eye diagram that fail the mask test. See Mask Testing.
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Eye Descriptor Box

The descriptor box for an Eye diagram includes following information:

l Top line: volts/division of the eye

l Second line: time/division of the eye

l Third line: the number of unit intervals (UI) in the eye

If vertical cursors are enabled, cursor values appear in subsequent lines.

Eye Mask Testing
SDA can be used to test eye diagrams against either absolute or normalized masks. You can determine
where the signal has violated the mask, how many failures have occurred, and which particular UI is in
violation.

Note: These controls are disabled for Custom or Clock signals.

On the Eye dialog, select the Mask Type to apply. Each standard has a set of required mask tests. Masks
are either "absolute" or "normalized". Absolute masks specify specific voltage and time values. When
using absolute masks, the position of mask features will depend on the volts/div setting of the mask.
Normalized masks reference grid locations rather than absolute voltages.

You can optionally alter the Mask Margin, the buffer area surrounding the mask, as a percentage of the
total area:

l click the X field and enter a value from 0 to 100%.

l click the Y field and enter a value from 0 to 100%. Check Margin only center area to add the full value
of the margin to the top and bottom of the mask. For example, a Margin of 10% adds 5% to the top
and 5% to the bottom of the mask area; if you Margin only center area, 10% is added to the top and
10% is added to the bottom for a full vertical margin of 20%.

Note: As you enlarge the mask's margin, you increase the dimensions, bringing the mask closer to
your waveform. Consequently, you may have more failures.

On the Eye Diagram subdialog, select Show Mask to turn on the mask display. Select Show Failures to
place an indicator over the parts of the eye diagram that fail the mask test. Mask failures are identified by
contrasting color spots which appear anywhere the data intersects the mask template.
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Eye Measurement Parameters 
Several important measurements are made on eye diagram patterns, mainly dealing with amplitude and
timing. Many standards specify them as part of required tests. Select all the measurements you wish to
display in the table.

Eye Height
The eye height is a measure of the signal-to-noise ratio of a signal. The mean of the 0 level is subtracted
from the mean of the 1 level as in the eye amplitude measurement. This number is modified by
subtracting three times the standard deviation of both the 1 and 0 levels. The measurement provides an
indication of the eye opening and is made on the central region (normally 20%, user changeable) of the UI
(bit period). This measurement algorithm is best suited to eye diagrams that are rendered from optical
rather than electrical signals. In the presence of inter-symbol interference and/or equalization,it may not
give reasonable results.

One Level
Simple mean of the 1 or high state of the eye within the selected slice width.

Zero Level
Simple mean of the 0 or low state of the eye within the selected slice width.

Eye Amplitude
Eye amplitude is a measure of the amplitude of the data signal. The measurement is made using the
distribution of amplitude values in a region near the center of the eye (the "slice width") selected by the
user(normally 20% of the distance between the zero crossing times). The simple mean of the distribution
around the 0 level is subtracted from the mean of the distribution around the 1 level. This difference is
expressed in units of the signal amplitude (normally voltage). This measurement algorithm is best suited
to eye diagrams that are rendered from optical rather than electrical signals. In the presence of inter-
symbol interference and/or equalization, it may not give reasonable results.

Eye Width
This measurement gives an indication of the total jitter in the signal. The time between the crossing points
is computed by measuring the mean of the histograms at the two 0 crossings in the signal. Three times
the standard deviation of each distribution is subtracted from the difference between these two means.
This measurement algorithm is best suited to eye diagrams that are rendered from optical rather than
electrical signals. In the presence of inter-symbol interference and/or equalization, it may not give
reasonable results.
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Eye Crossing
Eye crossing is the point where the transitions from 0 to 1 and from 1 to 0 reach the same amplitude. This
is the point on the eye diagram where the rising and falling edges intersect. The eye crossing is expressed
as a percentage of the total eye amplitude. The eye crossing level is measured by finding the minimum
histogram width of a slice taken across the eye diagram in the horizontal direction (as the vertical
displacement of this slice is varied).

Average Power
The average power is a measure of the mean value of the signal, derived from all levels contained within
the eye diagram. It can be viewed as the mean of a histogram of a vertical slice through the waveform
covering an entire bit interval. Unlike the eye amplitude measurement where the 1 and 0 histograms are
separated, the average power is the mean of both histograms combined. Depending on the data coding
used, the average power can be affected by the data pattern. A higher density of 1s, for example, results in
a higher average power. Most coding schemes are designed to maintain an even 1s density resulting in an
average power that is 50% of the overall eye amplitude.

Extinction Ratio
This measurement, defined only for optical signals, is the ratio of the optical power when the laser is in the
ON state to that of the laser in the OFF state. Laser transmitters are never completely shut off since a
relatively long period of time is required to turn the laser back on (therefore limiting the rate at which the
laser can operate). The extinction ratio is the ratio of two power levels (one very near zero) and its
accuracy is greatly affected by any offset in the input of the measurement system. Optical signals are
measured using optical-to-electrical converters on the front end of the SDA. Any DC offset in the O/E must
be removed prior to measurement of the extinction ratio. This procedure is known as dark calibration. The
output of the O/E is measured with no signal attached (also referred to as being dark) and this value is
subtracted from all subsequent measurements.

Mask Hits
Number of samples where the signal impedes the mask.

Mask Out
Number of samples where the signal does not impeded the mask.

Eye BER
Eye BER is an estimate of the bit error ratio is made from the eye diagram. It is derived from a
measurement of the Q-factor, as described below.

This measurement algorithm is best suited to eye diagrams that are rendered from optical rather than
electrical signals. In the presence of inter-symbol interference and/or equalization, it may not give
reasonable results.The Q factor is a measure of the overall signal-to-noise ratio of the data signal. It is
computed by taking the eye amplitude (the difference between the mean values of the 1 and 0 levels) and
dividing it by the sum of the noise values (standard deviations of the 1 and 0 levels).

171



WavePulser 40iX High-speed Interconnect Analyzer User Manual

All of these measurements are taken in the center (usually 20%) of the eye. You can measure the Q factor
using the standard oscilloscope Measure feature.

Slice Width
The optional Slice Width is a percentage of the duration of a single bit (the part of the pattern over which
the extinction ratio is measured). Setting a percentage value indicates how much of the central portion of
the bit width to use.

172



Using Signal Integrity Studio

Jitter Analysis
The Jitter dialog is the entry point for performing jitter analysis. To open the Jitter dialog, click the Jitter
tab or the Jitter Meas. block on the SDA dialog.

SDA II Jitter analysis flow.

The Jitter dialog shows the basic flow of jitter analysis through a simple block diagram progressing from
left to right. Each block in the diagram is also a button that opens the corresponding configuration
subdialog. These subdialogs offer multiple "views" (tracks, histograms, and other plots) of the analyzed
input signal.

Check the Enable Jitter Meas.(ure) box to activate jitter analysis, then click each block to open the
corresponding configuration dialogs for Jitter Filter, Pattern Analysis, Jitter Track, Jitter Spectrum, Jitter
Histogram, and Jitter (Measurement) Parameters.

Note: Deselecting Enable Jitter Meas. turns off all jitter measurement views and parameters.
However, your jitter analysis setup remains in effect.

Jitter Filter
You can optionally apply a configurable Lowpass, Highpass, or Bandpass filter to the TIE-vs.-time data
measured on the signal under test. The filter is applied as an FFT.

Filter State turns the Filter On or Off.

Filter Type may be Lowpass, Highpass, or Bandpass as desired.

In dB per Octave to specify the slope of the transition from the pass band to the stop band.

Enter the rising edge Cutoff Freq (shown when any filter type is selected).

If using a Bandpass filter, also enter the falling edge Cutoff Freq.
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Jitter Pattern Analysis
In addition to the DDj calculations, the Pattern Analysis algorithm is a key part of the determine Tj, Rj and
Dj. The algorithm to determine Tj, Rj and Dj includes "stripping" the data-dependent jitter via pattern
analysis. For best results, acquire at least 100 iterations of the data pattern. Note that you do not need to
acquire the selected number of reps of the pattern in each acquisition: the oscilloscope will accumulate
iterations over multiple acquisitions, and keeps track of partial iterations as well.

DDj may be calculated using two methods:

l Repeating Pattern - DDj is measured by finding the average crossing time for each edge in the data
pattern and comparing it to the nominal crossing time, based on the expected bit rate of the signal
under test. Repeating Pattern mode can be used for patterns up to 2^23-1 in length (meaning,
PRBS23). To apply this method, check the Repeating Pattern box.

l Non-Repeating Pattern- The average TIE value is calculated for edges with similar patterns of
preceding N bits. To use this method, clear the Repeating Pattern checkbox.

Note: If the number of iterations specified in the Min Reps selector are not in the data record when
using the Repeating Pattern method, Tj, Rj, Dj, and DDj all return with --- values showing on the
jitter measure table, and DDj, DCD, and ISI (if enabled for display) show 0 values despite the jitter
type actually being present.

Jitter Pattern Analysis Subdialog
Use the Pattern Analysis subdialog to configure how SDA measures and extracts data-dependent jitter
(DDj), which includes Duty Cycle Distortion (DCD) and Inter Symbol Interference (ISI), and to select
different views of the DDj to display.

DDj Views
Select each view to display:

Show DDjPlot draws the DDj Plot. This view shows the position error of the average crossing point for
each edge in the pattern.

Show DigPatt displays the digital pattern.

Tip: Simultaneously displaying Digital Pattern and DDjPlot shows where in the pattern DDj is
found.
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Show DDj Histogram displays a histogram of data-dependent jitter meausrements.

Show ISIPlot displays an eye pattern consisting of the averaged waveform trace from each pattern in the
data stream of a specified length. The length can be adjusted from 3 to 12 bits and the averaging removes
the effects of random jitter in the signal. What is left is an eye diagram with all noise and random jitter
removed. All that remains is the Intersymbol Interference (ISI) and the Duty Cycle Distortion (DCD). A
specific pattern may be selected for highlighting on the ISI Plot.

Jitter Pattern Selection
Check Repeating Pattern to use repeating pattern mode (default).

l For repeating pattern mode, the Min Patt. Reps. control is available for setting the minimum number
of repetitions of the data pattern before the pattern analysis is complete. When fewer than the
minimum number of repetitions have been acquired, the oscilloscope will display "---" for Tj, Rj and Dj,
and the progress bar below the Pattern Analysis button in the main Jitter dialog will be partially filled.

l For non-repeating pattern mode, enter the Num(ber of) Bits to use in the creation of the ISI Plot.

Check Auto Find Pattern to allow the software to determine the pattern (default).

Touch Find Pattern to search for a repeating pattern. The length of any pattern found will appear in
Length. These controls are disabled when using non-repeating pattern mode.

When an xNvalue is entered, identified patterns are multiplied N times to form the pattern used for the
Repeating Pattern method. For example, if the signal is a PRBS7 pattern (127 UI), then with xN set to 10,
the pattern to be used makes 10 iterations of PRBS7 (1270 UI). If Min Reps is also set to 10, then 10
repetitions of the 1270UI pattern is required for the DDj analysis.

Select to use Both, High, or Low DDj Histo(gram) Edges when plotting the DDj Histogram.

Touch Clear Sweeps to reset the counter.

Mark Auto Clear to automatically clear sweeps after each trigger.

Jitter Pattern Subdialog

The Pattern subdialog is used to configure the appearance of the ISI Plot view.

In repeating pattern mode, you can optionally enter the multiples of UI To Shift Pattern By, then select the
Left or Right arrow key to shift in that direction. When using the non-repeating pattern mode, both the Shift
Pattern By and Find Pattern controls are disabled.
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To highlight where the digital pattern is found on the ISI Plot, enter the Num(ber of) Bits in the pattern and
touch Find Pattern. From the list of n-bit patterns found, select the one you wish to highlight.

The Length and xN controls work as they do on the Pattern Analysis subdialog.

Jitter Track
This dialog is used to display any of the three available jitter track views. All three jitter tracks plot jitter
versus time.

Show RjBUjTrack plots the RjBUjTrack. This waveform is the TIETrack with the DDj removed, and with
values for "virtual edges".

Show PLLTrack plots the jitter that the PLL is tracking out. This is relative to a ideal clock at the found bit
rate. PLLTrack waveform shows the behavior of the PLL to track out low frequency jitter in your signal. It
shows a waveform that includes, for each edge (real or virtual) in your signal, a measurement of the
difference between (1) the expected arrival time of the edge, as determined by the PLL, and (2) the
expected arrival time of the edge if the PLL was not turned on.

Show TIETrack plots the TIETrack.

Tip: To zoom these plots, touch or click on the trace descriptor box to display the Zoom controls
next to the Jitter Track subdialog.
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Jitter Spectrum
Touch the Jitter Spectrum block on the Jitter dialog to display the Jitter Spectrum subdialog.

Select each jitter spectrum view you wish to display.

Show RjBUjSpectrum displays the frequency spectrum of the RjBUjTrack with the DDj removed.

Select Show Peaks to annotate the points of the RjBUjSpectrum above the threshold on the spectrum
trace. Annotations are the blue circles placed over the peaks.

Show Peak Threshold displays the threshold for the RjBUjSpectrum. Peaks higher than this threshold are
considered Pj and the remaining signal under the threshold is integrated to form the Rj of the spectral
method of jitter composition. Peak Threshold view enables you to know what peaks are viewed as Pj for
downstream analysis.
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Show PjInv.FFT turns a complex frequency view of the peak information into a simple time domain view
of the users Pj (Periodic Jitter). It is the inverse FFT of only the points of the RjBUjSpectrum above the
threshold. This allows you to view the peaks in the time domain and is very useful for viewing time domain
Pj effects.

Find Scale for Spectrum automatically finds the optimal scale for viewing the RjBUjSpectrum.

In Spect. Scale, choose whether to view the RjBUjSpectrum on a linear or logarithmic scale.
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Jitter Histogram Analysis
Two jitter histograms can be viewed in SDA software: the TIE histogram, which contains all sources of
jitter, and the Rj+BUj histogram, which has the DDj removed.

You can also view the integrated histogram, or CDF (cumulative distribution function). The CDF can be
displayed in the more standard representation of a bathtub curve.

Show Rj+BUj Histogram draws the Rj+BUj Histogram. Vertical axis is in number of edges in a particular
jitter bin. Horizontal axis is the RjBUj jitter value. Scale is linear. Sometimes it's useful to use the log10
math function to get a log vertical scale to make it easier to view the tails.

Show Q-Fit for RjBUjplots the Rj+BUj histogram in the Q-Scale representation. In the Q-Scale
representation, Gaussian tails result in straight lines whose slope is equal to 1/Rj. Teledyne LeCroy uses a
special Q-scale which we call nQ-Scale or normalized Q-Scale. This allows for Gaussian distributions with
variable populations or normalizations. Shown with the Q-scale transform is the best straight line fit ( the
thin white line).

Show TIE Histogram draws the TIE Histogram. Vertical axis is in number of edges in a particular jitter bin.
Horizontal axis is the TIE jitter value. Scale is linear. Sometimes it's useful to use the log10 math function
to get a log vertical scale to make it easier to view the tails.

Show CDF plots the Cumulative Distribution Function for the extrapolated RjBUj histogram convolved with
the DDj histogram.

Show Bathtub plots the bathtub curve (same information as CDF, shown in bathtub format).

Tip: To zoom any of the plots, touch the trace descriptor box to display the Zoom controls next to
the Jitter Histogram dialog.
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Jitter Parameters
Touch the Jitter Parameters button on the Jitter Measurement dialog to display the Jitter
Parametersdialog.

Extrapolation Model
Select the model to use in jitter computations.

Dual-Dirac Spectral applies the industry standard dual-Dirac model, with the σ (sigma) value of the
Gaussians being derived from a spectral analysis of the jitter. The tails of the jitter distribution are
extrapolated using σ, but the final value for Rj is set to be equal to σ. Tj is the width of the final cumulative
distribution function (CDF) at the user-specified BER level. This technique gives the fastest convergence
and is the right one to use except in cases where crosstalk or other kinds of deterministic jitter exist that
can masquerade as random jitter. In such cases, NQ-Scale should be used. In general, if the two
techniques yield close results, use Spectral RJ Direct to take advantage of it's rapid convergence; if they
differ by more than a little, then the assumptions of the spectral model are probably being stretched, and it
would be better to use NQ-Scale.

Dual-Dirac NQ-Scale stands for "Normalized Q-Scale," a variant of the dual-Dirac model that includes six
degrees of freedom: the Gaussians can have different σ (sigma) values, populations and means. The NQ-
Scale method is performed by transforming to the “Q-scale”, in which a Gaussian has a linear slope. Tj is
the width of the final cumulative distribution function (CDF) at the user’s selected BER level, and Rj and Dj
are determined by fitting to equation (1) in the vicinity of the selected BER value. Since the NQ-Scale
method does not use spectral methods to determine σ, and since it includes additional degrees of
freedom, the estimates of jitter in the presence of high crosstalk or other bounded, uncorrelated jitter may
be more realistic than returned by the spectral methods. Use this technique in cases where deterministic
jitter can masquerade as random jitter, such as when non-repetitive crosstalk is present.

You can choose to Show Jitter in Time or UI (Unit Intervals).

Jitter Calculation
In the Log10 BER control, enter the BER at which the Tj is reported, 10-12 by default.

To use a fixed random jitter rate in this calculation, check Specify Fixed Rj and enter the Fixed Rj value.

Jitter Parameters
Select the jitter parameters to display in the SDA Jitter measurements table. Touch Turn Off All to turn off
the display of jitter measurements.
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Pj
The p-p value of all the Periodic Jitter obtained from the IFFT of the spectral Pj peaks.

DDj
The range (max-min) of the Data Dependent Jitter distribution for both rising and falling edges (and
includes the DCD effect).

DCD
Duty Cycle Distortion, the difference in the means of the histograms for the rising and falling edges.

ISI
Inter-Symbol Interference, the larger of the range (max-min) of the two subsets of the DDj histogram for
rising edges or falling edges.

Rate
The calculated bit rate.

EW(BER)
Eye Width at the selected BER, calculated as the unit interval width -Tj.

Jitter Measurement Calculation
SDA software measures jitter by determining the timing error between the edge crossings of the data
signal under test and a reference clock, which can be derived either from the data or an external clock.
The measurement can also be performed directly relative to the edges of the external clock.

Total jitter is derived from the histogram of timing error measurements. The histogram of measurements
is accumulated and the tails of the distribution are extrapolated to form an estimate of the histogram for a
population of 1016 measurements. The extrapolated histogram is then integrated to determine the
cumulative distribution function which forms the sides of the bathtub curve. The bathtub curve gives the
eye opening (or 1UI - Tj(UI)) for all bit error rates down to 10-16. The total jitter for a given bit error rate is
found by measuring the width of the bathtub curve at the y-axis value corresponding to the desired bit
error rate. The periodic jitter and data dependent jitter are measured directly on the sequence of timing
error measurements, and the random jitter is found by measuring the difference between the total jitter
and the components of deterministic jitter.

Tj - Total jitter at a specific BER. The value is determined by the width of the curve expressing the
confidence limits of the extrapolated TIE histogram. The value represents the expected range of values
observed for a number of observed measurements equal to 1/BER. The Tj parameter is accumulated over
all acquisitions since the start of the measurement or the last clear sweeps operation. The total
population of the TIE histogram is indicated in the waveform descriptor box for the bathtub curve and Htie
(the TIE histogram).

Rj - Random jitter is obtained indirectly by first determining deterministic jitter through various direct
analyses of the TIE trend. Once all of Dj is found, the Rj value is deduced from the equation Rj = (Tj(BER) -
Dj)/ Tj(1-sigma)(BER), where the value for BER is typically 10e-12 (i.e., Rj is not a function, but a single
value). The bit error rate is selected in the @BER (pow 10) control in the jitter menu. Rj is expressed in
terms of an rms value, whereas Tj and Dj are expressed as peak-to-peak values.
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Dj - Deterministic jitter is the peak-to-peak non-random part of the total jitter. This parameter is the sum of
the measured peak-to-peak values of periodic jitter (Pj) and data dependent jitter (DDj). The DDj includes
the effects of both inter symbol interference and duty cycle distortion.

Pj - Peak-to-peak magnitude of the periodic components of the TIE trend. It is measured by analyzing
peaks in the Fourier transform of the trend of the time interval error. It is necessary to specify the pattern
repetition length (if there is one) so that spectral lines harmonically related to this pattern rate do not
contribute to the estimate of Pj, since the spectral energy associated with data pattern-related spectral
components is included in the DDj measurement. The total periodic jitter is the complex sum of the
spectral components listed in the table under the Pj breakdown tab.

DCD - Duty Cycle Distortion is the mean difference between the width of positive going pulses (low to high
to low) and negative going pulses (high to low to high) measured over all pulses in the acquired waveform.
The widths are measured at the same amplitude as specified for TIE (i.e., not necessarily at 50% of the
signal amplitude). This measurement is a component of DDJ and included in the DDj value.

DDj - The peak-to-peak jitter caused by systematic effects related to the sequence of data transitions.
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Jitter Analysis Algorithms

TIE Trend
First, the TIE trend is calculated, which is the deviation of each edge from the ideal provided by the
recovered clock.

Note: There is no block for TIE Trend on the Jitter dialog. However, the TIE trend is calculated in
the background as an input to the other jitter algorithms.

Jitter Filter

1. The TIE trend, which only has a sample for each edge in the input waveform, is converted to what
we call a track or TIETrack, which is uniformly sampled at every UI, by inserting interpolated
samples for each UI where there was no edge (virtual edge). The track is also given a time axis. The
TIE can now be filtered.

2. If selected, a Low Pass Cutoff, High Pass Cutoff, or Transition Width bandpass filter is applied to
the TIETrack.

3. Any Jitter filtered from the Jitter Track at this point is not passed on to any of the downstream
analysis.

Pattern Analysis

1. First the data pattern is found.

2. Then, a DDj analysis is performed on the TIE trend. The average TIE is calculated for each DDj
class. The DDj classes can be defined either by where the edge occurs in a repetitive pattern or by
the N-bit sequence occurring prior to the edge.

3. From this analysis, a list of DDj values and populations is created for each classification made
from step 1.

4. From this analysis, the following are calculated:

l DDj histogram

l DDj plot

l DDj parameter

l DCD (Duty Cycle Distortion ) parameter

l ISI parameters

5. The DDj is removed from each edge in the TIE Trend (according to their classification from step 1)
to create an RjBUj TIE Trend (RjBUjTrend), a TIE sequence (in which the DDj is removed, but still
contains all the (Rj) Random jitter, and the (BUj) Bounded-Uncorrelated jitter). The most common
case of BUj is periodic jitter, where the period is unrelated to the data rate.
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Jitter Track

1. In this step, the RjBUjTrend is converted to a track (RjBUjTrack) by inserting interpolated samples
into the RjBUj Trend for each UI where there was no edge, thereby yielding a uniformly sampled TIE
waveform with a sample for every UI and a time axis.

2. The user may select to show/hide the RjBUjTrack, the TIETrack, and the PLLTrack.

The PLLTrack shows the jitter tracked out by the PLL compared to an ideal clock of frequency
(found by the Find Bit Rate function).

Jitter Spectrum

1. The spectral analysis step takes the FFT of the RjBUjTrack (DDj removed). Notice how the Jitter
Spectrum is showing magnitude. Therefore, to get peak-to-peak jitter you must multiply by 2.

2. The background of the spectrum is estimated and integrated to get a spectrally derived Random
jitter, Rj(sp). If the jitter model selected in the Jitter Params dialog is dual-Dirac Spectral, then this is
the Rj used in the jitter breakdown.

3. The peaks in the spectrum are identified and used for further periodic jitter analysis.

4. A version of the spectrum is created which only keeps the peaks above the threshold.

5. The inverse FFT (PjInvFFT) of the peaks only spectrum is created. The peak-to-peak Pj is measured
from this waveform.

Jitter Histogram
Update the TIE histogram and the Rj+BUj histogram with the values in the TIETrend and the RjBUjTrend,
respectively.

Jitter Parameters
The fit extrapolation for the NQ-scale model can be shown on the histogram for the NQ-scale model.

The Rj+BUj jitter distribution with the analytical tail extrapolations is then convolved with the DDj
distribution (found during the Pattern Analysis Step) to create the total jitter distribution. This is integrated
to give the jitter CDF. The jitter time at which the CDF crosses the point corresponding to the Bit error rate
of interest (usually 10-12) is calculated for each side of the distribution. The difference of those 2 values is
Tj(BER).

The dual-Dirac model is fit to the extrapolated CDF to yield the final Dj(d-d) and Rj in the case of the NQ-
Scale and Rj+Dj CDF Fit techniques. For the Spectral Rj Direct technique, Rj is forced to Rj(sp) and Dj(d-d)
is determined from the dual-Dirac constraint.

The jitter parameters explained here are independent of the jitter model selected because they are
determined before the final histogram analysis:

l ISI is the larger of the range (max-min) of the 2 subsets of the DDJ histogram for negative edges or
positive edges.

l DCD is the difference in the means of the histograms for the positive and negative edges.
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l DDj is the range (max-min) of the DDj distribution for both positive and negative edges (and includes
the DCD effect).

l Pj is the peak-to-peak value of all the periodic jitter obtained from the IFFT of the peaks.
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WavePulser Reference

Returning a Product for Service
Contact your local Teledyne LeCroy service center for calibration or other service. If the product cannot be
serviced on location, the service center will give you a Return Material Authorization (RMA) code and
instruct you where to ship the product. All products returned to the factory must have an RMA.

Return shipments must be prepaid. Teledyne LeCroy cannot accept COD or Collect shipments. We
recommend air-freighting. Insure the item you’re returning for at least the replacement cost.

1. Remove all accessories from the instrument.

2. Label the unit with:
l The RMA
l Name and address of the owner
l Description of failure or requisite service

3. Pack the unit in its original shipping box, or an equivalent carton with adequate padding to avoid
damage in transit. Do not include the manual.

4. Mark the outside of the box with the shipping address given to you by Teledyne LeCroy; be sure to
add the following:

l ATTN: <RMA code assigned by Teledyne LeCroy>
l FRAGILE

5. If returning a product to a different country: contact Teledyne LeCroy Service for instructions on
completing your import/export documents.

Extended warranty, calibration, and upgrade plans are available for purchase. Contact your Teledyne
LeCroy sales representative to purchase a service plan.

For a complete list of Teledyne LeCroy offices by country, including our sales and distribution partners,
visit: teledynelecroy.com/support/contact

Teledyne LeCroy
700 Chestnut Ridge Road
Chestnut Ridge, NY, 10977, USA

Sales and Service:

Ph: 800-553-2769 / 845-425-2000
FAX: 845-578-5985
contact.corp@teledynelecroy.com

Support:

Ph: 800-553-2769
customersupport@teledynelecroy.com
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WavePulser Automation
The WavePulser application is a COM Automation server that shares most of its Automation architecture
with our MAUI oscilloscopes. The primary difference is that, in this case, the root Automation object is:
LeCroy.WavePulserApp.

Use the WavePulserBrowser installed with the WavePulser application to view the Automation hierarchy
of the WavePulser application. It functions the same as XStreamBrowser.

If you wish to use this feature, also install Teledyne LeCroy's ActiveDSO or VICP Passport plug-in on the
WavePulser host and any remote machines. They are available free from
teledynelecroy.com/support/softwaredownload under Oscilloscope Downloads > Software Utilities.

See the MAUI Oscilloscopes Remote Control and Automation Manual for instructions on making the
remote connection and sending Automation strings to the WavePulser application using the VBS
command.

188

http://teledynelecroy.com/support/softwaredownload
http://teledynelecroy.com/doc/docview.aspx?id=9905


WavePulser Reference

S-parameters for Second Tier Calibration
The WavePulser software includes capabilities for users to perform a second tier calibration like that done
at the factory. When a second tier calibration is selected, error terms from a secondary manual calibration
are applied “on top” of the automatic SOLT calibrations.

Unless you are using the Rosenberger Cal Kit provided with the WavePulser Si Kit option, or a similar cal
kit that utilizes a .CSTD file, calibration structures should be modeled/measured as individual S-parameter
files with the following naming convention, and the files should be saved in the subfolder created for
manual calibration. There are three choices for the definitions of the calibration structure:

l Provide an S-parameter file for a single set (i.e., for the SOLT to be used) with the following
filenames: Short.s1p, Open.s1p, Load.s1p, Thru.s1p

l Provide S-parameters for individual SOLT standards used on each port. Employ this approach when
using multiple SOLT structures with different S-parameter models or measurements)

Short[x].s1p, where [x]=1,2… up to the # of ports used for the calibration
Open[x].s1p, where [x]=1,2… up to the # of ports used for the calibration
Load[x].s1p, where [x]=1,2… up to the # of ports used for the calibration
Thru[x].s1p, where [x]=1,2… up to the # of ports used for the calibration

l Provide no S-parameter files for the standards, in which case the WavePulser will model the
standards as ideal, with the Thru being zero-length.
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Touchstone File Format
Touchstone is a standard file format used for specifying S-parameters that is commonly adopted by
vector network analyzers (VNAs), time-domain network analyzers (TDNA) and EDA tools such as
microwave simulators.

Conventions
S-parameter files saved by the WavePulser are in Touchstone 1.1 format. If you wish to use other S-
parameter files within the WavePulser or SI Studio software, they must follow these conventions:

l The file extension must be in the form .SNP where N corresponds to the number of ports in the
device. For example, a 2-port S-parameter file has the extension ".S2P".

l Lines cannot be longer than 2000 characters.

l Lines beginning with ! are comment lines. Comments must be at the front of the file. No comments
are allowed once the frequencies and S-parameter values start.

l There should be at least one line that begins with the # character. This is a line that contains tokens
that help the software interpret the S-parameter frequency unit and form.

l Valid frequency tokens are: Hz, MHz and GHz

l Valid form tokens are: MA (magnitude/angle), RI (real/imaginary) and DB (magnitude in
decibels/angle in degrees)

If the above tokens are not found, the frequencies are assumed to be in MHz, and the S-parameters
are assumed to be in magnitude/angle form.

Note: On the line beginning with #, there is usually a token pair R Z0, where Z0 is the
characteristic impedance. We assume Z0 is 50 ohm and ignore these tokens.

l All S-parameters are assumed to be 50 ohm impedance.

l All frequencies are assumed to go from the first frequency listed to the last frequency listed with
constant frequency spacing.

l Except for two-port S-parameters, the S-parameters for each frequency are to be listed as:

[frequency] (S11) (S12) …(S1N)(S21) (S22) … (S2N) … (SN1) (SN2) … (SNN)

where N is the number of ports dictated by the file extension.

2-port S-parameters are to be listed according to the standard as:

[frequency] (S11) (S21) (S12) (S22)
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Certifications
Teledyne LeCroy certifies compliance to the following standards as of the time of publication. See the EC
Declaration of Conformity document shipped with your product for the current certifications.

EMC Compliance
EC Declaration of Conformity- EMC
The instrument meets the intent of EC Directive 2014/30/EU for Electromagnetic Compatibility.
Compliance was demonstrated to the following specifications listed in the Official Journal of the
European Communities:

EN 61326-1:2013, EN 61326-2-1:2013 EMC requirements for electrical equipment for measurement,
control, and laboratory use. 1

Electromagnetic Emissions:
EN 55011:2010, Radiated and Conducted Emissions Group 1, Class A 2 3

EN 61000-3-2/A2:2009 Harmonic Current Emissions, Class A

EN 61000-3-3:2008 Voltage Fluctuations and Flickers, Pst = 1

Electromagnetic Immunity:
EN 61000-4-2:2009 Electrostatic Discharge, 4 kV contact, 8 kV air, 4 kV vertical/horizontal coupling planes
4

EN 61000-4-3/A2:2010 RF Radiated Electromagnetic Field, 3 V/m, 80-1000 MHz; 3 V/m, 1400 MHz - 2
GHz; 1 V/m, 2 GHz - 2.7 GHz

EN 61000-4-4/A1:2010 Electrical Fast Transient/Burst, 1 kV on power supply lines, 0.5 kV on I/O signal
data and control lines 4

EN 61000-4-5:2006 Power Line Surge, 1 kV AC Mains, L-N, L-PE, N-PE 4

EN 61000-4-6:2009 RF Conducted Electromagnetic Field, 3 Vrms, 0.15 MHz - 80 MHz

EN 61000-4-11:2004 Mains Dips and Interruptions, 0%/1 cycle, 70%/25 cycles, 0%/250 cycles 4 5

1. To ensure compliance with all applicable EMC standards, use high quality shielded interface cables.
2. Emissions which exceed the levels required by this standard may occur when the instrument is connected to a test object.
3. This product is intended for use in nonresidential areas only. Use in residential areas may cause electromagnetic

interference.
4. Meets Performance Criteria “B” limits of the respective standard: during the disturbance, product undergoes a temporary

degradation or loss of function or performance which is self-recoverable.
5. Performance Criteria “C” applied for 70%/25 cycle voltage dips and 0%/250 cycle voltage interruption test levels per

EN61000-4-11.

European Contact:*
Teledyne LeCroy Europe GmbH
Im Breitspiel 11c
D-69126 Heidelberg
Germany
Tel: + 49 6221 82700
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Australia & New Zealand Declaration of Conformity– EMC
The instrument complies with the EMC provision of the Radio Communications Act per the following
standards, in accordance with requirements imposed by Australian Communication and Media Authority:

AS/NZSCISPR11:2011RadiatedandConductedEmissions,Group1,ClassA.

AUSTRALIA / NEW ZEALAND CONTACTS:*
RS Components Pty Ltd.
Suite 326 The Parade West
Kent Town, South Australia 5067

RS Components Ltd.
Unit 30 & 31 Warehouse World
761 Great South Road
Penrose, Auckland, New Zealand

*Visit teledynelecroy.com/support/contact for the latest contact information.

Safety Compliance
EC Declaration of Conformity– Low Voltage
The instrument meets intent of EC Directive 2014/35/EU for Product Safety. Compliance was
demonstrated to the following specifications as listed in the Official Journal of the European
Communities:

EN 61010-1:2010 Safety requirements for electrical equipment for measurement, control, and laboratory
use – Part 1: General requirements

EN 61010-2:030:2010 Safety requirements for electrical equipment for measurement, control, and
laboratory use – Part 2-030: Particular requirements for testing and measuring circuits

The design has been verified to conform to the following limits put forth by these standards:

l Mains Power Supply Circuits: Overvoltage Category II, instrument intended to be supplied from the
building wiring at utilization points (socket outlets and similar).

l Measuring Circuit Terminals: No rated measurement category. Terminals not intended to be directly
connected to the mains supply.

l Unit: Pollution Degree 2, operating environment where normally only dry, non-conductive pollution
occurs. Temporary conductivity caused by condensation should be expected.

Environmental Compliance
End-of-Life Handling

The instrument is marked with this symbol to indicate that it complies with the applicable
European Union requirements to Directives 2012/19/EU and 2013/56/EU on Waste
Electrical and Electronic Equipment (WEEE) and Batteries.

The product is subject to disposal and recycling regulations that vary by country and region.
Many countries prohibit the disposal of waste electronic equipment in standard waste
receptacles. For more information about proper disposal and recycling of your Teledyne
LeCroy product, please visit teledynelecroy.com/recycle.
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Restriction of Hazardous Substances (RoHS)
This instrument and its accessories conform to the 2011/65/EU RoHS2 Directive, inclusive of any further
amendments to said Directive.

ISO Certification
Manufactured under an ISO 9000 Registered Quality Management System.

193



WavePulser 40iX High-speed Interconnect Analyzer User Manual

194



Index

Index
A
ac power source 6

accuracy 32

acquisition

accuracy 32

initiating 33

set up 30

activating traces 78

adapters 4

de-embedding 38, 51

altitude 5

asymmetry 132

at level measurements 96

auto save 67, 73

averages 32, 45

B
backup 67, 73

BER 171

bit rate 136, 152

broadband jitter 133
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cables 3-4, 7

connecting 14, 36

de-embedding 15
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factory 8, 50

files 13

manual 45

second tier 4, 16, 44

SOLR 48

SOLT 2, 4, 29

causality 33

channel emulation 138, 141
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clock recovery 152, 156, 160

color 24, 27

cooling 8

copy

display 23

CTLE 143-144

cursors 90
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D
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date and time 25
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descriptor box 18, 77-78, 169

DFE 143, 150
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grid 19

documentation iv
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DUT

connecting to 16

dynamic range 1, 32

E
email 24, 27, 55, 75

EMC 191

emphasis 135, 137

emulation 135, 138

channel 138

equalization 135, 143

error terms 48

ESD 7, 14

eye diagram

analysis 155, 167

mask testing 169

parameters 170

Eye Doctor II 135

outputs 153

setups 154

workflow 135

F
FFE 143, 146

filtering

measurements 100

firmware

version 21

fixtures

de-embedding 38, 51, 135, 138

emulating 141

foreground trace 78

frequency 1, 30

viewing 57

G
gating

trace measurements 100

grid

intensity 20

style 19

grounding 7

H
histograms 111

host system 9

humidity 5

I
impedance

reference 31

impedance peeling 52

impedance profiles 58

import

.trc files 70

S-parameters 60

setup panels 72

impulse response 30, 65

limiting 33

viewing 58

inputs 3, 136, 155

differential 34

installing

WavePulser software 10
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intensity

grid 20

IP address 22

J
jitter 133

analysis 155, 173, 181, 183

filter 183

histogram 184

parameters 184

pattern 183

spectrum 184

track 184

L
labelling traces 83

logs

remote control event 22

second tier calibration conversion 49

M
markers 95

mask testing 120, 169

math 117, 119

graphing 118

on parameters 106

operators 117

measurements 93

cursors 90

custom 96

eye diagram 170

filtering 100

gating 51, 100

graphing 111, 114-115

level 96

markers 95

pass/fail testing 120, 122

processing web 107

S-parameter 29-30

saving 67, 73

statistics 94

status 93

memory 88-89

mixed-mode S-parameters 34-35

multi-zoom 85-86

N
noise 132

O
operating environment 5

options 26

outputs 3

Eye Doctor II 153

P
parameter compare 120, 122

parameter math 106

pass/fail testing 120, 122-123, 169

passivity 33

persistence 168

physicality settings 33

PLL 152, 160, 162

port extension 51

ports

ordering 31, 34, 51, 61, 141
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position

trace 85

power 6

preferences 21, 26

printing 23, 75

processing web editor 107

pulser-samplers 2, 7, 14

Q
qualified measurements 100

R
random number generator 134

recall

measurement 67

setup panels 72

waveforms 70

reciprocity 33

reference clock 156, 164

reference impedance 31

reference plane gating 51

relay parking 7, 14

remote control 22

rescaling 101

Result traces 77

restore

measurement 67

waveforms 89

Result traces 2, 29, 57

rescaling 77

returns 187

RH 5

Rho 58

RoHS 193

S
S-parameters

calculation methods 2

files 15, 37, 52

importing 60, 141

measuring 30

mixed-mode 34, 61

saving 33, 55-56, 67

viewing 57, 60, 141-142

safety 5, 192

save

data 73

S-parameters 33, 55-56, 67

setup panels 71, 154

waveforms 67, 89

screen capture 23, 75

SDA II 155

Quick View 157

workflow 155

second tier calibration

user 189

SelfTest 12

sequencer 29, 32

service iv, 21, 187

setup panels 71-72, 154

SI Kit 4, 38, 45, 126
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SI Studio 1, 4, 57, 125

4-port configuration 127

Signal Generator 130

simulator 130

sinusoidal jitter 133

Smith Chart 64

software

automating 188

installing 10

software options 26

SOLR calibration 48

SOLT calibration 4, 29, 45

sound 26

step response 58, 65

support iv, 187

switch matrix 2, 14

system

hibernate 13

initializing 11

set up 9

status 21

timestamp 25

T
TDR/TDT waveforms 2, 65

technical approach 2

technical support iv, 187

temperature 5

TIE 183

Touchstone files 56, 67, 138, 190

reordering 34, 141

traces 18

color 27

copy 89

label 83, 95

line style 20

recall 70

save 67, 88

track 115-116

training equalizers 144, 146, 150

TRC files 67, 70

trend 114, 116

U
units 101

user interface 17

user second tier calibration 16, 45, 47, 189

utilities 21

V
viewing

impedance profiles 58

impulse response 58, 65

S-parameters 57, 60, 142

step response 58, 65

TDR/TDT waveforms 65

W
waveform files 67, 70

WavePulser software

Automation 188

connection to PC 13
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installed folders 12

installing 9

user interface 17

WEEE 192

Windows

power settings 13

wrist strap 7

Z
zoom 84

controls 85

multi-zoom 85
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